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CHAPTER I 

INTRODUCTION 

1.1. BACKGROUND OF THE RESEARCH 

Bridges are one of the important elements in transportation infrastructure that have a 

strategic role in supporting the smooth mobility of goods and people and improving connectivity 

between regions. In Indonesia, with the increasing need for infrastructure that can support 

economic growth, the construction of bridges with longer spans and larger load capacity is 

becoming increasingly important. One of the solutions widely applied for bridges with medium to 

long spans is the use of prestressed concrete, which is known to have higher strength and durability 

than reinforcement concrete. One of the important elements in this system is the PCI (Prestressed 

Concrete I-Girder) beam. Characterized by high strength, material efficiency, and the ability to 

cover long spans, PCI beams are frequently used in modern bridge design. (Naaman, 2004). 

The design of prestressed concrete bridges using PCI girders offers a variety of significant 

advantages, both from a technical and economic perspective. One of the main advantages is the 

ability of the structure to withstand larger loads with smaller dimensions. The process of 

prestressing the concrete makes the structure more resistant to tensile forces and able to withstand 

heavier loads, which is very important in the design of bridges that are in areas with high traffic 

volumes or less-than-ideal geotechnical conditions. In addition, the use of PCI girders as factory-

manufactured precast elements allows for better quality control and reduces the risk of errors 

during construction, speeds up project execution time, and reduces construction costs. 

However, despite having many advantages, the planning of prestressed concrete bridges 

with PCI girders also faces some technical challenges that need to be considered. The proper 

planning process requires a deep understanding of the behavior of prestressed concrete structures, 

load distribution, and other factors such as varying soil conditions and traffic loads. In addition, 

the process of transporting and installing PCI girders requires special attention so that structural 

elements are not damaged during delivery and installation at the construction site. Therefore, 

proper design and analysis are essential to ensure that the bridge structure can function optimally 

and safely in the long term. T.Y. Lin, a pioneer in prestressed concrete engineering, also underlined 

the importance of innovative approaches in bridge design to ensure structural efficiency and long-

term sustainability. 
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Along with the development of technology in the field of construction, the concept of 

Building Information Modeling (BIM) has begun to be applied in the planning and construction 

of bridges. BIM allows designers, engineers, and contractors to collaborate more effectively in a 

single digital platform that contains all project-related information, from design, and structural 

calculations, to construction management. In the context of planning prestressed concrete bridges 

using PCI girders, BIM allows for more efficient integration between structural calculations, 

material selection, and scheduling and budget coordination. By using BIM, design changes can be 

implemented more quickly and coordinated, reducing the risk of errors and improving planning 

accuracy. According to Eastman et al. (2011), BIM enables the integration of all aspects of design 

and construction, including in prestressed concrete bridge projects. 

As part of efforts to improve the quality of infrastructure in Indonesia, this research aims 

to explore and analyze the planning of prestressed concrete bridges using PCI girders, especially 

for medium to long bridge spans. This research will examine various aspects of planning, such as 

the calculation of load capacity, the selection of optimal girder dimensions, as well as the analysis 

of stress distribution and safety factors. In addition, this research will also integrate the concept of 

BIM in the planning process to improve efficiency and accuracy. The application of the BIM 

concept in bridge planning is expected to be a step forward in realizing more modern, efficient, 

and sustainable infrastructure development. 

1.2. OBJECTIVE AND BENEFITS OF THE RESEARCH 

The objectives to be achieved from this research can be described as follows: 

1. Planning and designing a prestressed concrete bridge capable of withstanding the loads 

that may work; 

2. Implementing the concept of Building Information Modeling (BIM) to assist 

calculations and modeling in the planning and design of prestressed concrete bridges; 

3. Producing Detailed Engineering Design (DED) from the Planning and design of the 

Prestressed Concrete Bridge; and 

4. Identify and analyze the advantages and disadvantages that can be taken from the 

application of the Building Information Modeling (BIM) concept in the planning and 

design of prestressed concrete bridges. 
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The benefits obtained from this research can be described as follows: 

1. This research provides in-depth insight into the use of prestressed concrete in 

increasing the strength and stability of bridges. 

2. Through this Undergraduate thesis, it is hoped that new guidelines and standards can 

be created in the design of prestressed concrete bridges, which can be used by 

professionals in the field of civil engineering. 

3. By using the Building Information Modeling (BIM) Concept, it is hoped that it can 

reduce calculation errors from the design of prestressed concrete bridges 

4. This Undergraduate Thesis will make a significant contribution to academic and 

practical knowledge about bridge planning and the application of Building Information 

Modeling (BIM) in the construction industry, The results of the research can be an 

important reference for academics, practitioners, and students who are interested in the 

development of modern construction technology. 

1.3. SCOPE AND LIMITATION 

Scope and limitation of this research by the following: 

1. The bridge that will be designed on the Superstructure uses the main girder in the form 

of a PCI-Girder with a span of 40 meters; 

2. The substructure of the bridge uses 2 abutments without pillars using piles foundations. 

3. The BIM-based software used in this research is Midas Civil 2022 and Autodesk Revit 

2023; 

4. In this study, Building Information Modeling (BIM) is only used as an assistant for 

calculation and 3D modeling; 

5. The BIM-based software used to help analyze the superstructure, substructure, and 

foundation of the bridge is Midas Civil 2022 with the help of data processing using 

Excel; 

6. The soil data used in analyzing the substructure is fictitious; 

7. The 3D modeling that will be made is a prestressed concrete bridge with BIM-based 

software used, namely Autodesk Revit 2023; and 

8. The components modeled are only structural and architectural, while MEP 

(Mechanical, Electrical, and Plumbing) is not modeled 
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CHAPTER II 

REVIEW OF LITERATURE 

2.1. PRESTRESSED CONCRETE 

2.1.1. Definition of Prestressed Concrete 

According to SNI-2847-2019, the definition of concrete is a mixture of Portland cement or 

other hydraulic cement, fine aggregate, coarse aggregate, and water with or without additional 

admixture. Concrete is known in the construction world as a mixture of gravel, sand, cement, and 

water that is resistant to compression, but not resistant to tension. Generally, the value of the tensile 

strength is approximately (8-14) % of the compressive strength. While steel is a material that is 

very resistant to tension. By combining concrete and steel where the concrete withstands 

Compression while the tension is held by the steel will become a material that is resistant to tension 

and compression known as reinforced concrete. Reinforced concrete is a combination of concrete 

and steel passively while the combination of high-quality concrete with high-grade steel actively 

is called prestressed concrete. This active way can be achieved by pulling the steel by holding it 

to the concrete so it is stressed. 

According to ACI (American Concrete Institute), prestressed concrete is structural concrete 

in which internal stresses have been introduced to reduce potential tensile stresses in concrete 

caused by loads. Prestressed concrete can be defined as reinforced concrete where internal stress 

is applied to reduce the potential tensile stress in the concrete resulting from the load, and for two-

way slabs using at least minimum prestressed reinforcement (SNI 2847 – 2019). Prestressed 

concrete is reinforced concrete that has been stressed to reduce the potential tensile stress in 

concrete due to the application of a working load (Draft Konsensus Pedoman Beton 1998). It can 

be added that prestressed concrete in the broadest sense, including the state (case) in which the 

stresses caused by internal strains are compensated to a certain extent, such as in curved 

constructions (arcs). However, in this research, the discussion is limited to prestressed concrete 

that uses drawn steel reinforcement and is known as tendons. 

2.1.2. General Principles of Prestressed Concrete 

According to T.Y. Lin & H. Bruns (1981), three different concepts may be applied to 

explain and analyze the basic behavior of this form of prestressed concrete, 
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1. First Concept - prestressed to transform brittle concrete into an elastic material.  

Eugene Freyssinet Explained that by giving precompression to the concrete 

material which is brittle, it will become an elastic material. Concrete that is weak in 

tension and strong in compression is compressed (generally by steel under high 

tension) so that the brittle concrete would be able to withstand tensile stress. This can 

be explained by the image below: 

 

Figure 2.1 Stress Distribution across a Concentrically Prestressed Concrete Section 

(Source: T.Y Lin & N.H. Burns, 1981) 

 

As a result of being given a compressive force (prestressed force) F acting on the 

center of gravity of the concrete section, an even compressive stress will arise as 

follows:  

 = 
𝐹

𝐴
........................................................................................................................ (1.1) 

If M is the external moment at the cross-section due to the load and the self-weight 

of the beam, then the stress at each point along the cross-section due to M is:  

 = 
𝑀 𝑐

𝐼
..................................................................................................................... (1.2)  

where c is the distance of the neutral line to the outermost fiber of the cross-section 

and I is the moment of inertia of the cross-section.  
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If the two stresses due to the pretension force and the tension due to the bending 

moment are summed, then the maximum stress at the outermost fiber of the cross-

section is : 

• For the top fiber 

 = 
𝐹

𝐴
  +  

𝑀 𝑐

𝐼
  (must not exceed the crushing tension of concrete)........................ (1.3)  

• For the bottom fiber 

 = 
𝐹

𝐴
  -  

𝑀 𝑐

𝐼
  (must not be less than zero).......................................................... (1.4)  

So, with this internal compressive force, the concrete will be able to bear the tensile load. 

2. Second Concept - Prestressed for a combination of high-strength steel with high-quality 

concrete.  

High-quality concrete is the main component of all prestressed concrete elements, while 

high-quality steel is a commonly used material to generate prestressed forces and supply 

tensile forces to prestressed concrete. The combination of this system is almost the same 

as the concept of ordinary reinforced concrete, namely prestressed concrete is a 

combination of cooperation between prestressed steel and concrete, where concrete 

resists pressure and prestressed steel resists tensile loads. This can be explained as 

follows: 

 

Figure 2.2 Difference Between Prestressed Concrete and Reinforced Concrete 

(Source: T.Y Lin & N.H. Burns, 1981) 

 

In prestressed concrete, the prestressed steel is drawn with a prestressed force T 

which forms a moment coupling with a compressive force on concrete C to counteract 

the moment due to external loads. Meanwhile, in ordinary reinforced concrete, the 

repeating iron resists the tensile force T due to external loads, which also forms a moment 

coupling with compressive force on concrete C to resist the external moment due to 

external loads. The combination of cooperation between high-quality steel and high-
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quality concrete in prestressed concrete forms a safer and more economical use than in 

reinforced concrete where the steel is simply planted because the two combine to create 

a retaining coupling against external forces. 

 

 

3. Third Concept – Prestressing to Archive Load Balancing 

This system uses pretension as an attempt to balance the forces on a beam. In the 

design of prestressed concrete structures, the influence of pretension is seen as the balance 

of Self-weight, so that rods that experience deflection such as plates, beams and girders 

will not experience bending stress in the loading conditions that occur. This can be 

explained as follows: 

 

Figure 2.3 Prestressed Beam with Parabolic Tendon  

(Source: T.Y Lin & N.H. Burns, 1981) 

 

A concrete beam on two pedestals (simple beam) that is given a prestressed force 

F through a prestressed cable with a parabolic trajectory. The load due to the prestressed 

force that is evenly distributed upwards is stated:  

Wb = 
8.𝐹.ℎ

𝐿2    

Where :  Wb : The load is evenly distributed upwards, due to the prestressed force F  

F : Prestressing stress 

h : Sag of parabola  

L : Length of span  
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The even load due to the downward load will be offset by the evenness force due 

to the upward stress. The load balancing system can be applied to indeterminate static 

structures such as in continuous span flat plate construction. This is because the principles 

of balancing the load on the flat plate are carried out in two directions of tensioning so 

that in each direction it has an even stress distribution and does not slack due to loading.  

The three systems of prestressed concrete mentioned above, are used to analyze the design 

principles of a prestressed concrete structure. 

2.1.3. Types of Prestressed Concrete 

There are 2 types of methods of applying prestressed force to concrete, i.e. 

1. Pre-Tension Method  

This method of  , therefore it is called the pretension method. The principles 

of this method are as follows: 

 

Figure 2.4 Working Principle on Pre-Tension Method 

(Source: Kontruksi Beton Pratekan, Ir.Soetoyo ) 

 

Stage 1: The prestressed cable (Tendon) is pulled or given a prestressed force and 

then anchored on a fixed abutment (Figure 2.4 A). 

Stage 2:  Concrete is cast on the formwork and the base that has been prepared so 

that it covers the tendon that has been prestressed and allowed to dry 

(Figure 2.4 B). 
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Stage 3: After the concrete has dried and aged well enough to receive the 

prestressed force, the tendon is cut and removed, so that the prestressed 

force is transferred to the concrete (Figure 2.4 C). 

Once the prestressed force is transferred to the concrete, the concrete block will 

curve upwards before receiving the workload. After the workload works, the concrete 

block will be flattened 

2. Post-Tension Method  

In the Post-Drawing method, the concrete is cast first, which has previously been 

prepared with a cable channel or tendon called a duct. Briefly, this method can be 

explained below, 

 

Figure 2.5 Working Principle on Post-Tension Method 

(Sumber: Kontruksi Beton Pratekan, Ir.Soetoyo) 

 

Stage 1: Concrete is cast with a mold (formwork) that has been provided complete 

with a prestressed cable channel/sleeve (tendon duct) that is installed 

curved according to the beam moment plane (Figure 2.5 A).  

Stage 2: After the concrete is old enough and strong enough to bear the prestressed 

force, the tendon or prestressed cable is inserted in the sleeve (tendon 

duct), and then pulled to get the prestressed force. In this method of 

applying pretension force, one end of the cable is anchored, then the other 

end is pulled (pulled from one side). Some are pulled on both sides and 



 

10 

 

anchored at the same time. After being anchored, the channel is grouted 

through the hole that has been provided. (Figure 2.5 B). 

Stage 3: After being anchored, the concrete beam becomes compressed, so the 

prestressed force has been transferred to the concrete. Because the tendon 

is installed curved, the tendon tension force gives an even load to the beam 

in the upward direction, as a result of which the beam curves upwards 

(Figure 2.5 C).  

Therefore, the construction of prestressed concrete must be designed in such a way 

that it has sufficient strength and the ability to serve according to needs. In addition, the 

construction must be durable, resistant to fire, resistant to fatigue (for repetitive and 

variable loads), and meet other requirements related to its use. 

2.1.4. Advantages and Disadvantages of Prestressed Concrete 

The advantages and disadvantages obtained in the use of prestressed concrete are explained 

below : 

1. Advantages of Prestressed Concrete 

• The crack-free state prevents corrosion of the steel rebar.  

• Reduce the tendency of inclined cracks.  

• The structural components have a stiffer rigidity, so the structural elements can be 

made slimmer.  

• The use of curved tendons gives rise to vertical force components that help bear the 

shear. 

• The maintenance cost of prestressed concrete is smaller because there are no cracks 

in the working load condition (avoiding the danger of corrosion).  

• Smaller deflection. 

2. Disadvantages of Prestressed Concrete 

• The use of high-quality materials results in high unit prices for work.  

• The work of prestressed concrete structures demands higher work precision and 

stricter supervision. 

• Additional charges are required for transportation. 
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2.2. CONSTRUCTION OF CONCRETE BRIDGE 

2.2.1. Definition and History of Concrete Bridge 

A bridge is a construction whose purpose is to continue the road through a lower obstacle 

which is usually in the form of another road such as a waterway or ordinary traffic (Struyk dan 

Veen, 1984). A bridge is a construction that functions to connect two road sections that are cut off 

by an obstacle with a lower surface. These obstacles can be in the form of deep valleys, river 

channels, lakes, irrigation canals, rivers, railways, uneven horizontal highways, and others. 

Bridges are the highest investment of all elements that can be found in the highway system. Any 

damage to the construction of the bridge can cause disturbances in the smooth rotation of the 

economic wheels and can cause accidents for humans. Types of bridges based on function, 

location, construction materials, and types of structures today have undergone rapid development 

by the advances of the times and technology, ranging from simple to advanced construction. 

The history of the bridge dates back to ancient times with simple structures such as stone 

and wood, which aimed to facilitate trade and mobility. In the Middle Ages, the development of 

construction techniques with stone and iron bridges became landmarks in various European cities. 

The Renaissance and the Industrial Revolution brought significant innovations with the use of new 

materials such as steel and concrete, resulting in monumental bridges such as the Brooklyn Bridge 

and the Tower Bridge. The 20th century marked an era of modernization with the use of prestressed 

concrete and computerized technology in bridge design, allowing the construction of 

megastructures such as the Golden Gate Bridge and the Akashi Kaikyō Bridge. Today, BIM 

technology is central to bridge planning, enabling accurate simulations and high construction 

efficiency. Bridges are not only vital infrastructure but also a symbol of technological progress 

and global relations. 

2.2.2. Characteristics and Function of Bridge Component 

There are various types of components of the bridge, both structural components and 

architectural components, the following explains the components of the bridge along with the 

characteristics and functions of the bridge components: 

1. Vehicle Floor Slab  

It is a part of the bridge construction that directly accepts a load of traffic running 

on it, which in the planning takes into account the live load/load "T" of the axle 
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pressure of the vehicle and the construction weight it bears (including the weight of 

the floor itself). 

2. Sidewalk  

It is a part of the bridge service used for pedestrian facilities, which is located on 

the left and right edges of the vehicle floor. The floor surface height of the Sidewalk 

is made higher than the surface height of the vehicle floor wearing course. 

3. Barrier 

A bridge barrier is a safety feature installed on the edges or sides of a bridge to 

prevent vehicles or pedestrians from falling off or crashing into obstacles. 

4. Girder Beam  

It is a part of the bridge construction that functions to carry the floor of the vehicle 

which then passes the loads to the construction part below. Typical girder beams of 

various shapes, especially for bridge construction, are generally I-shaped or box-

shaped (inverted trapezoidal shape).  

5. Bridge Pedestal  

As part of the bridge placed over the abutment and pier head as the foundation of 

the main girder. The materials that are often used as this base are cast iron (in the form 

of rolls and hinges), and super elastic rubber plates coated with steel plates (bearing 

pads). 

6. Drainage  

The drainage on the bridge functions to drain the water on the floor of the vehicle 

to the sewer so that it does not flood the floor of the bridge vehicle, which is very 

disruptive to traffic.  

7. Abutment  

The part that carries the two bases of the bridge located at the end of the bridge 

span functions to transfer the entire load of the Superstructure to the 

foundation/supporting soil, this part is built from reinforced concrete materials or river 

stone pairs equipped with wing walls.  

8. Pier 

It is another part of the Substructure located on the bridge span between the base 

of the bridge, acting like an abutment that divides the load and shortens the bridge 

span. It is usually constructed of reinforced concrete or long columns (concrete or steel 

pipes) and on top of it is a pillar head. 
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9. Foundation 

The foundation functions to distribute and even the load from the Abutment to the 

supporting soil. The use of the type of foundation depends on the condition of the 

supporting soil. 

2.2.3. Classification of Concrete Bridge According to Superstructure Type 

Based on the shape or type of bridge structure, bridges are distinguished from the shape of 

the main girder structure which supports all elements of the bridge structure and transfers all 

structural loads that are directly related to the substructure. The shape of the bridge structure 

consists of: 

1. Reinforced Concrete Monolith Beam Bridge  

It is a reinforced concrete bridge that between the Main Girder and the floor slab 

is cast together and fused as a "T" Beam. The whole structure consists of Beams and 

floor slabs, which are also often installed between the beam child beams or diaphragm 

beams, as shown in the following picture. 

 

Figure 2.6 Bridge Cross-Section 

(Source: Panduan Praktis Perencaan Teknis Jembatan) 

 

2. Prestressed Concrete Beam Bridge   

The main girder of this bridge is a reinforced concrete beam that is pre-tensioned 

from the cable installed in such a way that the entire live load of the bridge can be 

countered by the pretension obtained from the cable pulling in the tendons placed in 

the beam. This bridge is often used on bridges with relatively long spans, such as 

mono-rail overpasses, and many others. 
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Figure 2.7 Prestressed Concrete I-Girder 

(Source: PT Waskita Beton Precast TBK) 

 

2.2.4. Structure of Concrete Bridge 

 

Figure 2.8 Names of Bridge Structures  

(Sumber : Kamus Bina Marga Dep. PU.) 

 

1.  Superstructures of The Bridge 

The bridge superstructure is the part that receives the direct load which includes 

its own weight, dead load, additional dead load, vehicle traffic load, brake force, 

pedestrian load, etc.  

The Superstructure of a bridge generally includes:  

1) Sidewalk:  

a. Backings or barriers,  

b. Kerb 

c. Sidewalk floor slabs.  
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2) Vehicle floor slabs,  

3) Girder 

4) Diaphragm,  

5) Bearing. 

2. Substructure of The Bridge 

The substructure of the bridge functions to bear all the load of the superstructure 

and other loads caused by soil pressure, water flow, and drift, impact, friction on the 

support, to then be channeled to the foundation. Furthermore, these loads are 

channeled by the foundation to the subsoil.  

The Superstructure of a bridge generally includes:  

1) Abutment, 

a. Back wall, 

b. Breast wall,  

c. Wing wall, 

d. Approach slab, 

e. Corbel,  

f. Bearing. 

2) Pier,  

a. Pier Head,  

b. Pier, which is in the form of walls, columns, or portals,  

c. Corbel,  

d. Bearing.  

3. Foundation 

The bridge foundation functions to transfer the entire load of the bridge to the 

ground. Based on the system, the Abutment foundation or bridge pier can be divided 

into several types, including:  

1) Spread footing, 

2) Caisson, 

3) Pile foundation, 

4) Log Pile,  

5) Steel Pile,  

6)  Reinforced Concrete Pile,  

7) Precast Prestressed Concrete Pile,  
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a. Concrete Cast in Place, 

b. Composite Pile. 

2.3. BUILDING INFORMATION MODELING (BIM) 

2.3.1. Definition Building Information Modeling (BIM) 

Building Information Modeling (BIM) is a digital representation that contains data, objects, 

and facilities that can produce 3D shapes and data that can be processed by users to be extracted 

and analyzed against information that will be used to improve work efficiency (Associated General 

Contractors of America/AGC, 2005). Building Information Modeling (BIM) is a technological 

development in the field of AEC (Architecture, Engineering, and Construction). The resulting 

modeling is in the form of precise geometry and accurate data to support construction activities 

(Eastman, 2008). BIM or Building Information Modeling is a system or technology that includes 

some important information in the Design, Construction, and Maintenance process that is 

integrated into 3D modeling (Sacks et al., 2018) (Eastman et al., 2011). 

According to the PUPR team and the BIM Institute in Indonesia, Building Information 

Modeling (BIM) is one of the developments in the construction industry that digitally presents the 

physical and functional characteristics of a building (Indraprastha, 2018). Therefore, each element 

of the building contains all the information in the development project in the form of a database 

(working drawings, scheduling, cost estimation, etc.) which is used as a basis for decision-making 

in the life cycle time curve of the building, from the initial concept to demolition. Based on the 

experts' opinions above, it can be concluded that Building Information Modeling (BIM) is a unit 

of technological devices with all processes in it working in an integrated manner on a digital model 

which will later be interpreted as a three-dimensional form. The system then manages and 

generates construction data by using 3D, real-time, and dynamic modeling software to increase 

the productivity of its design and construction. 

2.3.2. History and Development of Building Information Modeling (BIM) 

BIM was introduced in the late 1970s by Prof. Eastman at The Georgia Tech of 

Architecture, in an AIA (American Institute of Architects) journal entitled "Building Description 

System", then Robert Aish published a journal in 1986 with the title "Building Modeling: The Key 

to Integrated Construction CAD". In 1992, the term Building Information Modeling was first 

mentioned in a paper written by G.A. Van Nederveem and F. P. Tolman 1992. After a conference 
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in 2005 that discussed the new term replacing Computer-Aided Design (CAD) technology, Jerry 

Laiserin, an industry analyst, argued that the most appropriate term was Building Information 

Modeling (BIM). 

BIM or Building Information Modeling became popular in 2002 after Autodesk released a 

paper titled Building Information Modeling. The term Building Information Modeling resurfaced 

in mid-2005 when the US General Services Administration (GSA) decided to build a new 

courthouse in Jackson, Mississippi with a total area of 410,000 ft2 (Dinas Pekerjaan Umum, 2020). 

Since then, 2D (two-dimensional) software has been used to design and document all construction 

phases while GSA has asked its staff to switch from 2D to a 3D (three-dimensional) approach. 

Meanwhile, in Indonesia, BIM is quite new in the construction industry with very limited 

use. Companies such as PT. Pembangunan Perumahan and PT. Total Bangun Persada is a 

company that has started to implement the use of BIM. After several years of BIM being 

implemented in Indonesia, the results are not optimal because its use is only limited to how to 

streamline labor needs, costs, and time. What can be done to maximize the use of BIM is to 

straighten out the mindset related to BIM where BIM is not only related to the use of  BIM software 

but also how to manage the use of each  BIM software so that it can achieve the desired goals. 

2.3.3. Building Information Modeling (BIM) Dimension 

BIM is a system, management, method, or sequence of work on a project that is applied 

based on related information from all aspects of the building that is managed and then projected 

into a 3-dimensional model (Tim PUPR dan Institut BIM di Indonesia, 2018). The concept of BIM 

envisions virtual construction before actual physical construction, to reduce uncertainty, improve 

safety, solve problems, and analyze potential impacts (Smith, Deke 2007). By using BIM, 3D, 4D, 

5D, 6D, and even up to 7D information can be obtained, with the explanation as below. 
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Figure 2.9 Building Information Modeling (BIM) Dimension 

(Source: Piranusa.com) 

 

1. BIM 3D (Modeling) 

3D BIM can be said to be 3-dimensional modeling driven from the x, y, and z axes 

and is also referred to as coordinated modeling. The resulting 3d model can be used 

for schematic design, construction documentation, and visualization of objects which 

helps to check for errors in drawings. 

2. BIM 4D (Time/Scheduling) 

In BIM 4D can reveal additional information on the model in the process of 

scheduling for work and is often referred to as the time element. This process usually 

comes in the form of detailed data plus supporting components. So that it will be able 

to produce better planning quality. 

3. BIM 5D (Cost Estimating) 

BIM 5D is a cost estimation that is integrated into the scheduling of 3D object 

designs. With this system, you can predict the flow of costs that will likely be incurred 

from the modeling. You can also modify the cost at a specific time as a result of 

unforeseen circumstances such as design changes and other modifications. 

4. BIM 6D (Sustainability, Collision Detection, and Energy Analysis) 
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6D BIM can be referred to as integrated BIM or energy analysis in buildings. This 

BIM involves adding other relevant information to support the management and 

operation of the facility in the expectation of a better result and is also able to reduce 

the overall energy consumption of the 3D CAD component with all aspects of 

management information. 

5. BIM 7D (Facility Management Application) 

BIM 7D is used in the operation and maintenance of building facilities integrated 

with 7D CAD simulation to optimize asset management from the design process to 

demolition. 

2.3.4. Benefit of Building Information Modeling (BIM) 

Here are some of the benefits of using Building Information Modeling (BIM) in 

Construction Projects, 

1. BIM has a 3-dimensional visual so that it makes it easier to understand the drawing 

plan to be built. The use of BIM will make it easier to calculate the volume of work 

quickly and accurately (Deni Deni et al., 2019).  

2. BIM will provide cost information or Cost Budget Plans for each component of the 

work so that we can predict the estimated cost of one component of the work.  

3. BIM is able to display 3-dimensional drawings on complex works such as ironing 

bridge structures, and other complex construction works. The use of BIM is not only 

to display building animation images but rather to the managerial project information 

quickly and accurately.  

4. The use of BIM at the beginning of the work is used as a clash detection (Smith, 2007). 

We can find out whether this 2D plan drawing if it will be applied in the field will be 

a clash or not, especially between structural, architectural, and MEP (mechanical, 

electrical, plumbing) drawings.  

5. Another benefit of using BIM is the coordination between contractors and owners or 

consultants easily anywhere and anytime. BIM will be uploaded to a cloud computer 

service that can be accessed by the owner. The owner will check the image through a 

cloud computer service and provide Marking if there is a mistake. 
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2.3.5. Building Information Modeling (BIM) Involvement in Project 

One of the main goals of BIM technology is to support all processes starting from the pre-

construction stage to the maintenance stage at the entire building lifecycle. The advantages of 

using BIM from each stage of project development are (Ramadiaprani, 2012):  

1. Pre-Construction Stage: In the pre-construction stage, the owner tries to 

determine/estimate the size of the project according to the available project budget. 

Project estimates at this stage are still very rough. Using BIM, the estimated building 

model can be linked to a database and the project price cost will be calculated directly. 

In the initial stage, only model schemes are used and function to evaluate the function 

of the building. This can define the direction of project development right at the initial 

stage which can improve the overall quality of the building.  

2. Design Stage: The design stage is a collaboration between the construction team and 

engineers, architects, and owners. At this stage, BIM must be implemented 

immediately. If the architect only provides 2D drawings, then the construction 

manager must convert the 2D drawings into 3D drawings. This coordination effort 

aims to reduce design errors and to better understand the work to be done.  

3. Construction and Fabrication Stages: Aim to simulate the construction process, 

visualize how buildings will be built day by day with 4D models, and find potential 

problems faced so that repairs can be made. BIM technology allows you to identify 

clashes before construction takes place, which can speed up the construction process, 

and reduce the risk of project costs rising due to clashes and the need for solutions to 

correct errors. During construction, there may be design changes, thus updating the 

estimated cost and implementation schedule. BIM technology can facilitate the 

fabrication process. The 3D elements of the model can be sent to the production 

process element factories automatically.  

4. Maintenance Stage: BIM models are full of information that can be useful for 

establishing operational processes. This can support the monitoring of the project 

control system. 

. 

2.3.6. Building Information Modeling (BIM) Software 

Software BIM dapat dipakai tergantung pada dimensi apa yang digunakan. Software 

tersebut meliputi dimensi 3D BIM (Modeling), dimensi 4D BIM (Time/Scheduling), dimensi 5D 
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BIM (Cost Estimating), dimensi 6D BIM (Sustainability, Collosion Detection, dan Energy 

Analysis), dan dimensi 7D BIM (Facility Management Application). Beberapa software BIM yang 

dapat digunakan berdasarkan dimensinya dapat dilihat pada Tabel 2.2 berikut. 

Table 2.1 BIM software by dimensions 

Dimensi Fungsi Software 

3D 

 

Modeling Autodesk Revit, Graphisoft® 

ArchiCAD, Bentley® Architecture, 

Tekla® Structures, etc. 

4D Time/Scheduling Autodesk Navisworks, Synchro, 

Navigator, Vico Control, etc. 

5D Cost Estimating Autodesk® Quantity Takeoff, etc. 

6D Sustainability, Collision 

Detection, and Energy 

Analysis 

Autodesk Ecotect Analysis, 

Autodesk Green Building Studio, 

Graphisoft EcoDesigner, etc. 

7D Facility Management 

Application 

Bentley Facilities, Vintocon 

ArchiFM (For ArchiCAD), Onuma 

System, EcoDomus, etc. 

 

In this discussion,  the software that will be used is Autodesk Revit which works at the 

modeling stage. 

2.4. MIDAS CIVIL 2022 

2.4.1. Introduction of Midas Civil 2022 

Midas Civil is one of the most commonly used bridge design and analysis software today 

that combines the power of modeling with exclusive analysis features and makes bridge modeling 

and design efficient for engineers. Midas Civil provides more practical features for simpler and 

more flexible bridges to handle complex geometries. The software includes a variety of design 

guidelines that are very useful for engineers looking for the ideal design. Midas Civil will ease the 

work of engineers and make bridge design more accessible through this software(Midas, 2022) 

MIDAS Civil is a program created for structural analysis and structural design in the field 

of civil engineering. This software is devoted to the introduction of structural planning systems 

which includes analysis and how to optimize a design specifically in bridge planning. MIDAS 
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Civil is a solution to optimize the planning of a bridge structure and other types of structures. This 

software has the ability to analyze types of structures such as prestressed concrete, suspension 

bridges, cable bridges and other conventional bridges This program can be applied to several types 

of areas or projects, such as: 

• Analysis and planning for all types of bridges such as bridges with reinforced concrete 

structures, steel, composite, prestressed, suspension, and cable bridges. 

• Heat analysis of hydration from concrete such as abutments, piers, breakwater, and 

foundations. 

• Underground structures 

• Industrial and factory facilities 

• Public facilities such as ports, airports, railway stations, dams and other transportation 

facilities 

2.4.2. Advantages and Disadvantages of Midas Civil 2022 

The disadvantages and shortcomings in the use of Midas Civil in conducting structural 

analysis are explained below, 

1. Advantages of Midas Civil 2022 

• Friendly User Interface, The User Interface can be directly linked to the User's 

flexibility to model and make changes to it. The Midas Civil GUI  is designed to 

give users complete freedom and convenience when modeling bridges. 

• Intuitive modeling, Midas Civil provides users with unlimited and efficient 

modeling methods for any project. Creating nodes and elements, such as CAD 

programs, as a conventional modeling approach as well as having the Bridge 

Wizards feature can create a complete bridge model for you in the blink of an eye, 

and one can make any modifications to the model, thus giving complete freedom to 

its engineers. Other efficient approaches, such as CAD import, table format 

modeling, and code format modeling are also available. 

• Complete Analysis Options, As one of the best structural design and analysis 

software, Midas Civil performs all the essential analyses required for primary 

bridges, such as Moving Load Analysis, Construction Stage Analysis, EigenValue 

analysis, and Linear and Non-Linear Analysis. But when high-level analysis is 

required for complex bridges such as Bend Analysis, Cable Style Tuning, Rail 
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Structure Interaction, and Completion Analysis, it can also be done easily on Midas 

Civil. 

• Provides accurate results, load combinations based on specified design standards 

and can provide results that are compatible with MS Excel, which allows for easy 

extraction of results, and users can review all analysis and design results 

systematically. 

2. Disadvantages of Midas Civil 2022 

• Limitations in Integration with  Other Software, Although Midas Civil provides 

a wide range of features for structural design and analysis, its integration with other 

software in BIM workflows or for specific analysis may not be as comprehensive 

as more integrated solutions. 

• Requires High Hardware Specifications, To run Midas Civil smoothly, it is often 

necessary to have strong enough hardware specifications. This includes the need 

for fast processors, adequate RAM, and graphics cards capable of handling 

intensive graphics processing. Users who do not have adequate hardware may 

experience slow performance or other issues. 

• Training Cost and Availability, The use of Midas Civil often requires a high 

initial investment in terms of software licensing and also the cost for appropriate 

training. This can be a barrier for small companies or individual users who are new 

to the industry. 
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2.4.3. User Interface of Midas Civil 2022 

 

Figure 2.10 User Interface Midas Civil 2022 

(Source: Manual.Midasuser.com) 

 

The following is an explanation of each part of the Midas Civil 2022 Interface listed in 

Figure 2.6, 

1. Main Menu 

The Main Menu accommodates all the commands and shortcut keys that are required 

for operating Midas Civil. 

2. Tree Menu 

A series of work processes, from modeling to analysis, design, and generation of 

calculation sheets, are listed systematically. The Tree Menu guides the required 

procedure and invokes the relevant dialog box so that even a beginner, as well as an 

expert, can efficiently perform the work without an error. 

3. Tree Menu 2 

Simultaneously used with the Tree menu, Work tree, and Group information can be 

examined more conveniently. In addition, it boosts efficiency by providing an element 

and boundary input dialog box with a Work tree simultaneously. 

4. Stage Step 
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Using this drop-down menu, Construction Stage can be easily chosen for checking a 

structure by stages. 

5. View Navigation 

Useful for displaying modeling from different perspectives 

6. Toolbar 

It contains a menu icon that symbolizes each function, which allows easy access to 

frequently used menus. In addition, similar icon menu types are grouped by tabs 

(Tabbed Toolbar) 

7. Task Pane 

Useful for displaying work procedures for advanced analysis functions and description 

of input items, allowing users to work easily. 

8. Context Menu 

Simply right-click on the top of the model window to run the context menu to use the 

tools we use frequently depending on the work situation, the selected entity, and the 

click location to reduce mouse movement. 

9. Table Window 

Table Window generates various data inputs and analysis results in the form of 

spreadsheet-formatted tables, similar to MS Excel. 

10. Message Window 

Useful for displaying various information and warning or error messages that are 

useful for modeling and analysis. 

11. Command Line 

Useful for Inserting Command Keys to execute Commands. 

12. Status Bar 

It is useful to display the coordinates according to each coordinate system, and unit 

system, select filtering options, control the location of element snaps, etc., which will 

improve the working efficiency. 

2.5. AUTODESK REVIT 2023 

2.5.1. Introduction Autodesk Revit 2023 

Autodesk Revit 2023 is one of the BIM-based software that can be used to design, 

document, schedule, operate, and maintain an infrastructure building (Autodesk, 2020). Autodesk 

Revit 2023 is one of the BIM-based software that is useful in 3D modeling so that it produces a 
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document needed to design a building, both in terms of structure, architecture, and MEP 

(Mechanical, Electrical, and Plumbing). In Revit modeling, each 2D, 3D, and scheduling drawing 

sheet represents information from the same virtual building model. As the user works on a building 

model, Revit gathers information about the modeling of the building and coordinates this 

information across the rest of the modeling representations.  

2.5.2. Advantages and Disadvantages of Autodesk Revit 2023 

The advantages and disadvantages of using Autodesk Revit 2023 are explained below, 

1. Advantages of Autodesk Revit 2023 

• Objects Loaded with Technical Information, no matter how many times we use the 

object in the design, the data will be summarized in the Revit system such as the 

quantity, total weight, total material requirements, and the amount of price. 

• Ease of Forming Objects, architects can experiment with uncommon building 

shapes, Revit will convert these shapes into wall panels, floor panels, and roofs so 

that the effectiveness of the building will be immediately analyzed by the contractor 

without having to go through a time-consuming manual drawing process. 

• Reduced Obstacles in Teamwork, Worksharing that Revit brings to ease of working 

in a team is very useful for medium and large-scale projects. By using this feature 

accompanied by a computer network, all tasks of each discipline can be integrated 

virtually. Changes made by one person will be updated in other work units. 

• Revisions That Don't Take Up Much Time, Cost, & Effort, Revit which stands for 

Revise Instantly means revising instantly. Revisions will have a lot of impact on 

big projects because they will all be interconnected. 

• Rapid & Precise Drawing Production, The sheets that Revit produces are not 

separate sheets, but sheets that are integrated. 

• Connections Between Autodesk Software, Output from Revit can be extracted and 

read well by other Autodesk software. 

• Better Communication with Clients, By using Revit, architects and contractors can 

present quality displays that represent their designs to clients 

2. Disadvantages of Autodesk Revit 2023 

• need for high hardware specifications, Like many modern design software, Revit 

requires adequate hardware specifications to run smoothly, especially when 

working with large or complex models 
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• Expensive license prices, Initial investment in Revit licensing  can be expensive, 

especially for small companies or individuals who are just starting out in the 

industry. 

• In its use, new family materials must be made according to the design and size 

needed 

2.5.3. User Interface of Autodesk Revit 2023 

 

Figure 2.11 User Interface Autodesk Revit 2023 

(Source: www.knowledge.Autodesk.com) 

 

Below is an explanation of each part of Interface Autodesk Revit 2023 according to the 

number listed in Figure 2.11 above, 

1. Revit Home 

Use Revit Home to access and manage information related to your models. 

2. File Tab 

http://www.knowledge.autodesk.com/
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The File tab provides access to common file actions, such as New, Open, and Save. It 

also allows you to manage files using more advanced tools, such as Export and Publish. 

3. Quick Access Toolbar 

The Quick Access toolbar contains a set of default tools. You can customize this 

toolbar to display the tools that you use most often. 

4. InfoCenter 

InfoCenter provides a set of tools that enable you to access many product-related 

information sources. 

5. Options Bar 

The Options Bar is located below the ribbon. It displays conditional tools dependent 

on the current tool or selected element. 

6. Type Selector 

The Type Selector identifies the currently selected family type and provides a drop-

down from which you can select a different type. 

7. Properties Palette 

The Properties palette is a modeless dialog where you can view and modify the 

parameters that define the properties of elements. 

8. Project Browser 

The Project Browser shows a logical hierarchy for all views, schedules, sheets, groups, 

and other parts of the current project. As you expand and collapse each branch, lower-

level items display. 

9. Status Bar 

The status bar provides tips or hints on what to do. When you highlight an element or 

component, the status bar displays the name of the family and type. 

10. View Control Bar 

The View Control Bar provides quick access to functions that affect the current view. 

11. Drawing Area 

The drawing area (canvas) displays views (and sheets and schedules) of the current 

model. Each time you open a view in a model, the view displays in the drawing area. 

12. Ribbon 

The ribbon displays when you create or open a file. It provides all the tools necessary 

to create a project or family. 

13. Tabs on the ribbon 
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Contains what tabs are on the Ribbon and contains tools that are suitable for their 

respective functions. 

14. A contextual tab on the ribbon, providing tools relevant to the selected object or current 

action 

Contains tabs that provide tools relevant to the object in the form of an element or 

component that is currently selected or what is currently being worked on. 

15. Tools on the current tab of the ribbon 

the current tab of the ribbon Contains tools that are useful in working and has been 

grouped by each tab. 

16. Panels on the ribbon 

These are the panels that appear on the Ribbon.
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CHAPTER III 

DESIGN AND PROCEDURE 

3.1. DESIGN OF THE RESEARCH 

The bridge that will be designed and will be made in 3D modeling is a prestressed concrete 

bridge using girder beams in the form of PCI-Girder. The bridge to be designed consists of 3 parts, 

namely, superstructure, substructure, and foundation. The bridge has a length of 40 meters and a 

width of 10 meters with a superstructure bridge configuration as shown in the picture below. 

 

Figure 3.1 Superstructure Bridge Configuration 

 

Then here are some criteria that need to be considered in bridge planning, including the 

following.  

1. Rules and guidelines used;  

2. Materials/materials used;  

3. Methods and assumptions in calculations;  

4. Methods and assumptions in determining the type of superstructure,  

5. Methods and assumptions in determining the type of substructure and foundation  

6. Field data collection;  

7. The computer program used; and  
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8. The method of checking is carried out.  

The guidelines used in the planning of this bridge are by the following standards. 

1. SNI 1725 – 2016 Pembebanan Untuk Jembatan; 

2. SNI 2833 – 2016 Perencanaan Jembatan Terhadap Beban Gempa; 

3. Panduan Praktis Perencaan Teknis jembatan (No. 02/M/BM/2021) 

4. Manual Perencanaan Struktur Beton Bertulang Untuk Jembatan (No. 009/BM/2008) 

5. RSNI T-12-2004 Standar perencanaan struktur beton untuk jembatan; 

6. SNI 2847 – 2019 Persyaratan Beton Struktural Untuk Bangunan Gedung 

7. Permen PUPR No.5 Tahun 2023 tentang Persyaratan Teknis Jalan dan Perencanaan 

Teknis Jalan; 

8. SNI 8460 – 2017 Persyaratan Perancangan Geoteknik; 

9. Permen PUPR No. 10 Tahun 2022 tentang Penyelenggaraan Keamanan Jembatan 

Dan Terowongan Jalan 

10. AASHTO LRFD Bridge Design Specifications 2020 

11. Building Code Requirements for Structural Concrate (ACI 318M-14) And 

Commentary (ACI 318RM-14) 

12. FHWA NHI-05-042 Design and Construction of Drive Pile Foundation 

13. BMS 92 Bridge Design Code vol 1 dan 2; dan 

14. BMS 92 Bridge Manual Design vol 1 dan 2; 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://peraturan.bpk.go.id/Details/257281/permen-pupr-no-10-tahun-2022
https://peraturan.bpk.go.id/Details/257281/permen-pupr-no-10-tahun-2022
https://peraturan.bpk.go.id/Details/257281/permen-pupr-no-10-tahun-2022
https://peraturan.bpk.go.id/Details/257281/permen-pupr-no-10-tahun-2022
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3.2. FLOWCHART OF THE RESEARCH 

The flowchart of this research can be seen as shown in Figure 3.2 below 

Data Collection

START

Data for Bridge Superstructure
Data for Bridge Substruture 

and Foundation

Preliminary Design of Bridge 

Superstructure
Preliminary Design of Bridge 

Substructure and Foundation

Bridge Superstucture Analysis with 

Midas Civil 2022

Bridge Substucture and Foundation 

Analysis with Midas Civil 2022

Approximate Prestressing Force 

and Determination of The Number 

of Tendon

Calculation of Bridge 

Superstructure Reinforcement

Bridge Substucture and Foundation 

Analysis with Midas Civil 2022

s

Prestressed Concrete 

Design Check Using 

Midas Civil 2022

s

Inspection of Abutment 

Stability and Foundation 

Bearing Capacity

3D Modeling Using Autodesk 

Revit 2023

Conclusion

Yes

No

Yes

No

FINISH

Loading for Bridge Superstructure
Loading for Bridge Substructure 

and Foundation

 

Figure 3.2 Flowchart of The Research 
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3.3. IMPLEMENTATION PROCEDURE 

1. Literature Study Stage 

This literature study can be done by searching and studying various information 

related to the Research work related to prestressed concrete bridges and BIM, both 

from journals on the internet and the Help feature provided by Midas and Autodesk to 

help understand the use of the software. 

2. Data Collection Stage 

The data needed for the work of this Research includes Detailed Engineering 

Design (DED) drawings of various existing Prestressed Concrete bridges (all spans 

and widths), soil data needed for the planning of the substructure and foundation, and 

data on bridge planning guidelines according to existing standards. 

3. Preliminary Design Stage 

In planning the components of the concrete structure, it is necessary to carry out 

a preliminary design to determine the initial dimensions of the Superstructure, 

Substructure, and foundation of the Bridge to facilitate its planning.  

4. Structural Analysis Stage of Bridge Structure with Midas Civil 2022 

This stage is useful for getting the Internal force acting on the bridge structure 

based on the load acting on the bridge. The internal force generated is useful for the 

stage of approximating prestressed concrete and determining the number of tendons 

required by the girder beam, the stage of calculating the reinforcement, and the 

reaction force generated by the superstructure of the bridge will be used as a load to 

analyze the substructure of the bridge. To assist in the calculation of the force in the 

analysis of the structure of the Bridge using Midas Civil. 

5. Approximate of Prestressed Force and Determination of the Number of Tendons Stage 

Concrete has excellent strength in resisting pressure, but is weak in resisting 

tension. Therefore, a useful tendon is needed to provide an internal force to the beam 

to counter the external force received by the beam. Calculations in designing the right 

tendons can ensure that the structural elements can withstand the load as designed. 

6. Design Check Stage on Prestressed Concrete 

Stress checks on prestressed concrete have several crucial uses that support 

structures' success, safety, and durability. Stress checks help ensure that the stress 

applied to the tendon is following the design, thus preventing potential structural 

failure due to improper or excessive stress. The things that are checked at this stage 



 

34 

 

are the inspection of prestressed force loss, the inspection of the allowable stress on 

concrete, and the inspection of bending and shear capacity. If the value result at this 

stage is not as allowed, then it is necessary to recalculate the Approximate Prestressed 

Force and Determination of the Number of Tendons 

7. Control Stage of Abutment Stability and Foundation Bearing Capacity 

Control of abutment stability and foundation bearing capacity are two important 

aspects of bridge planning. The abutment stability ensures that the abutment can safely 

withstand external loads and forces without experiencing damage or shifting, whereas 

the foundation bearing capacity is the ability of the soil or base material to support the 

load passed from the structure to the ground without experiencing failure. If the 

abutment stability and the foundation bearing capacity do not meet the allowable 

values, we need to do a preliminary design of the abutment or foundation again. 

8. Calculation Stage of Bridge Reinforcement 

The calculation stage of bridge reinforcement is a critical part of the design 

process to ensure the bridge's safety, stability, and durability. This stage involves 

detailed structural analysis to determine the loads the bridge will be subjected to and 

the amount of reinforcement needed to handle those loads. 

9. 3D Modeling Stage 

The bridge modeling carried out in this Final Project uses Autodesk Revit 2023, 

both structural modeling and architecture of each item on the building. This can be 

done by utilizing the features available in the software used to find out what data and 

processes can be done in the modeling. 

10. Conclusion 

The conclusion from this research is to obtain a Detailed Engineering Design 

(DED) from the design of a prestressed concrete bridge that can withstand the working 

load and make a 3D model of the bridge. 
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CHAPTER IV 

FINDING AND DISCUSSION 

4.1. DATA COLLECTION  

The bridge that will be planned and designed with the implementation of the Building 

Information Modeling (BIM) concept is a prestressed concrete bridge with a span of 40 meters 

divided into three main parts, namely the Superstructure, the Substructure, and the Foundation. 

Planned and designed bridges can be classified based on several categories as follows : 

1. According to their function, bridges are classified as highway bridges;  

2. According to the material, the bridge is classified as a concrete bridge;  

3. According to the classification, bridges are classified as prestressed concrete bridges;  

4. According to the structural support system, bridges are classified as simple pedestal 

bridges; and 

5. According to the cut plane, bridges are classified as straight bridges. 

4.1.1. Data for Bridge Superstructure  

Based on Kriteria Desain Jembatan Standar at point 3.2.1.g about Perencanaan Bangunan 

Atas Jembatan yang isinya “If it is not specifically planned, it can be used for buildings on Bina 

Marga standard bridges (Standard Drawing) according to the economic span and water traffic 

conditions below such as: Prestressed concrete girder type I span 16 to 60 meters" then with a span 

length of 40 meters, the building on the bridge is chosen, namely the Prestressed Concrete Bridge 

using PCI-Girder  

Based on Letter of Bina Marga No.05/SE/Db/2017 concerning “Kriteria Desain Jembatan 

Standar” in point 3.2.1.g concerning “Perencanaan Bangunan Atas Jembatan” which reads "If it 

is not specifically planned, the building on the Bina Marga standard bridge (standard drawing) can 

be used according to the economic span and water traffic conditions below such as Type 

Prestressed Concrete I-Girder (PCI-Girder) span 16 to 60 meters", then with a span length of 40 

meters, the bridge building is chosen, namely the Bridge  Prestressed Concrete 

Prestressed Concrete Bridge will be planned and designed its Superstructure with the 

following general data. 

1. Type Concrete bridge structure, namely type prestressed concrete type PCI-Girder 
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2. The track type under the bridge is a river 

3. The length of the bridge is 40 meters 

4. The bridge to be designed has a width of 10 meters with the division The bridge has 2 

lanes with a width of 3.5 meters and has two barriers and a sidewalk on the left and 

right sides of the bridge with a width of 1.5 meters (0.5 m barrier and 1 meter sidewalk) 

5. The barrier has a height of 1.25 meters with a customized shape made of concrete      

fc'= 30 MPa (Specific gravity = 24 kN/m) 

6. The sidewalk has a thickness of 0.25 meters with a customized shape made of concrete 

fc'= 20 MPa (Specific gravity = 24 kN/m) 

7. The wearing surface on the bridge uses asphalt with a thickness of 50 mm (Specific 

Gravity = 22 kN/m) 

8. The diaphragm has a thickness of 0.20 meters with a customized height and width 

according to PCI-Girder Shape. 

Prestressed concrete bridges will be designed using the following material specifications : 

1. Beam Girder Material Data 

• Compressive Strength of Concrete at 28 Days f`cg = 50 MPa 

• Compressive Strength of Concrete During 

Stressing 

f`cig = 

= 

0.8 f`cg 

40 

MPa 

MPa 

• Modulus of Elasticity of Concrete at 28 Days Ecg = 

= 

4700√f`cg 

33234.02 

MPa 

MPa 

• Modulus of Elasticity of Concrete During 

Stressing 

Ecig = 4700√f`cg 

29725.41 

MPa 

MPa 

• Specific Gravity of Concrete γc = 25 kN/m3 

2. Floor Slab Material Data 

• Compressive Strength of Concrete at 28 Days f`cd = 30 MPa 

• Compressive Strength of Concrete When 

First Loaded 

f`cid = 25 MPa 

• Modulus of Elasticity of Concrete at 28 Days Ecd = 

= 

4700√f`cg 

33234.02 

MPa 

MPa 

• Modulus of Elasticity of Concrete When First 

Loaded 

Ecid = 4700√f`cg 

29725.41 

MPa 

MPa 
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• Specific Gravity of Concrete γc = 24 kN/m3 

 

3. Prestressed Steel Material Data  

• Type of Strand Seven Wire Strand, Low Relaxation 

• Pre-Stressed Steel Grade ASTM 416-250 (Normal) 

• Diameter of Strand Dps = 12.70  mm 

• Cross-Sectional Area of Strand Aps = 98.71 mm2 

• Tensile Strength of  Pre-Stressed Steel fpu = 1860 MPa 

• Yield Strength of  Pre-Stressed Steel Fpy 

 

= 

= 

0.9 fpu 

1674 

 

MPa 

• Modulus of Elasticity of Pre-Stressed Steel Eps = 197000 Mpa 

• Jacking Force  Fbt 

 

= 

= 

0.75 fpu 

1395 

 

MPa 

4. Steel Reinforcement Material Data 

Steel Reinforcement Grade (for D ≥ 13 mm)  : BJTD 42 

• Yield Strength of Reinforcement Steel fy = 420  MPa 

• Yield Strength of Reinforcement Steel fu = 525 MPa 

• Yield Strength of Reinforcement Steel Es = 200000 MPa 

Steel Reinforcement Grade (for D < 13 mm) : BJTD 24 

• Yield Strength of Reinforcement Steel fy = 420  MPa 

• Yield Strength of Reinforcement Steel fu = 525 MPa 

• Yield Strength of Reinforcement Steel Es = 200000 MPa 

 

5. Elastomer Bearing Pad (Support) 

• Length of Elastomer Bearing L = 600 MPa 

• Width of Elastomer Bearing W = 600 MPa 

• Thickness of Elastomer Bearing H = 97 MPa 

• Shape Factor S = 10   

• Compressive Stiffness SDc = 1.56E+06 kN/m 

• Shear Stiffness SDs = 3.85E+03 kN/m 

• Allowable Compressive Strength  Pn = 4220 kN 
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4.1.2. Bridge Substructure Data 

The main function of the building bridge Substructure is to channel all the loads acting on 

the bridge Superstructure to the foundation or ground. The substructure to be planned and designed 

has the following general data. 

1. The river that passes under the bridge has a calm current and does not sink under 

drifting objects so that it does not affect the load on the substructure too much or can 

be considered non-existent. 

2. The soil parameters used to analyze the substructure have the following data. 

• Specific Gravity of Soil γsoil = 22  kN/m3 

• Angle of Internal Friction ϕ = 30°  

• Cohesion of Soil C = 10 kN/m2 

3. The material of the substructure used has the following data. 

• Compressive Strength of Concrete f’c = 30  MPa 

• Steel Reinforcement Grade for D ≥ 13 mm BJTD 42  

• Steel Reinforcement Grade for D < 13 mm BJTP 24  

4.1.3. Foundation Data 

The foundation is the part of the bridge that passes the load directly to the soil or rock. The 

type of foundation used is determined based on soil conditions in the form of NSPT data. The 

NSPT data used in the foundation design are shown in the figure below. 

 

Figure 4.1 Soil Layer and Soil Data 
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Based on the data seen in the image above, the soil surface has soft soil and soil depth with 

sufficient bearing capacity at a depth of 6 meters. According to FHWA NHI-05-042 Design and 

Construction of Driven Pile Foundation, page 7-4, the type of foundation that matches the soil 

conditions is the pile foundation. The data from the pile foundation used is as follows. 

1. The material of the foundation used has the following data. 

• Compressive Strength of Concrete f’c = 30  MPa 

• Steel Reinforcement Grade for D ≥ 13 mm BJTD 42  

• Steel Reinforcement Grade for D < 13 mm BJTP 24  

2. The dimensions of the pile foundation used have the following data. 

• Diameter of Foundation D = 0.8   m  

• Depth of Foundation H = 15 m  

4.2. DESIGN OF BRIDGE SUPERSTRUCTURE 

4.2.1. Preliminary Design of Bridge Superstructure 

Based on Table 4.1 concerning tinggi minimun struktur atas in Panduan Praktis Perencaan 

Teknis Jembatan Volume 2 (2021), the initial height of the deck system for the simple span 

Prestressed Concrete I-Girder Bridge is 0.045L, where L is the length of the bridge, 

• Bridge Length  L = 40.00 m 

• Minimum Height of Deck System hd = 

= 

0.045 . L 

1800 

mm 

mm 

To determine the spacing between girders, the thickness of the plates and the number of 

girders used can refer to table 3.6.2.2.2b-1 in Peraturan Perencanaan Teknik Jembatan Bagian 3 

(2017).  Based on table 3.6.2.2.1-1 in Peraturan Perencanaan Teknik Jembatan Bagian 3 (2017) 

The bridge to be designed is included in type k, so : 

• The spacing between girders (Sg) should not be less than 1100 mm and should not be 

more than 4900 mm (1100 mm ≤ Sg ≤ 4900 mm), then in this case, The spacing between 

girders used is 2000 mm 

• The thickness of the floor slab (ts) used must not be less than 110 mm and must not be 

more than 300 mm (110 mm ≤ Sg ≤ 300 mm), then the thickness of the floor slab used 

is 250 mm 
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The length of the cantilever plate on the outer side of the exterior girder (de) is determined 

based on Table 3.6.2.2.2d-1 i.e. −300 ≤ 𝑑𝑒 ≤ 1700, then the length of the cantilever plate used is 

1000 mm. So, from the above requirements, the initial dimensions of the girder and the dimensions 

of the bridge cross-section are determined as follows: 

• Type of PCI-Girder Used  PCI-Girder 2100 mm 

• Spacing between girders Sg = 2000 mm 

• Length of Cantilever Plate De = 1000 mm 

• Thickness of the floor slab ts = 250 mm 

• Number of Girder used ng = 5  

• Width of Highway Wt = 7000 mm 

• Thickness of diaphragm td = 200 mm 

 

Detailed drawings of the Bridge cross-section and girder dimensions are shown in the 

following figure: 

 

Figure 4.2 Bridge Cross Section 
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Figure 4.3 PCI-Girder Cross-Section Dimensions 

 

4.2.2. Structural Analysis of Superstructure Using Midas Civil 2022 

The stages that can be carried out in the analysis of the Superstructure using Midas Civil 

2022 include the following. 

1. Open Midas Civil 2023 which has been installed on your PC so that the initial display 

appears as shown below, then select New Project to create a new worksheet. 

 

Figure 4.4 Initial view Midas Civil 2022 
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2. Define the material to be used in the modeling of prestressed concrete bridges that 

have been mentioned in the previous superstructure data, for example, fc'50 and fc'30 

concrete, by selecting Properties > Material > Material Structure from the Main Menu 

As shown in the picture below.  

 

Figure 4.5 Material Properties 

 

 

 

3. The compressive strength of concrete will increase as the age of the concrete increases 

since the concrete is poured, therefore we need to define it in all concrete materials 

that are previously defined following ACI 209R-92 by selecting Properties > Time 

Dependent > Comp. Strange from the Main Menu Then input the following data: 

Compressive strength factor of concrete a = 4  

 b = 0.85  
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Figure 4.6 Time-Dependent Material (Comp. Strength) 

4. Because concrete over time will expand and shrink, therefore we need to define the 

Creep and Shrinkage of concrete in Midas Civil 2022 according to the ACI-209.2R-

08 Guideline adjusted according to RSNI T-12-2004 by selecting Properties > Time-

Dependent Material > Creep/Shrinkage from the Main Menu and filling in the data in 

the Creep/Shrinkage Time-Dependent Material (Creep/Shrinkage) dialog box with the 

following data. 

• Relative humidity of ambient environment H = 70 % 

• Volume surface ratio d = 150 mm 

• Slumb s = 75 mm 

• Fine aggregate percentage F = 50 % 

• Air content AC = 6 % 

• Cement content C = 409 Kg/m3 
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Figure 4.7 Time-Dependent Material (Creep/Shrinkage) 

 

5. Then connect the predefined Materials with Comp, Strength, and Creep/Shrinkage 

data by selecting Properties > Time-Dependent Material > Material link from the Main 

Menu, as in the picture below. 

 

Figure 4.8 Time-Dependent Material (Material Link) 

 

6. After the material is defined, the next step is to define the Section Properties by 

selecting Properties > Section > Section Properties from the Main Menu As shown in 

the figure below, then define the cross-section of the PCI-Girder, Diaphragm, and 

Bridge Floor Slab that has been obtained through the previous preliminary design. 
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Figure 4.9 Section Properties 

 

7. Before starting modeling and loading the structure, we must first choose the type of 

structure that is the bridge by selecting Structure > Type> Structure Type from the 

Main Menu. In the Structure Type, select 3-D and then Check Convert Self-Weight 

into Masses, select Convert to X, Y, Z, and leave the other settings as the initial settings 

as shown in the figure below. 

 

Figure 4.10 Structure Type 

 

8. Next, Model and load the bridge with the Wizard feature that has been provided by 

Midas Civil 2022 which is useful for modeling bridges by selecting Structur e> Wizard 

> Prestresses Composite Bridge from the Main Menu as in the figure below. 
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Figure 4.11 Prestresses Composite Bridge 

 

9. After the Pre/Post-Tension Composite Girder Bridge Wizard dialog box appears, on 

the layout page fill in the bridge data such as bridge length, bridge pedestal, and others 

according to the data we obtained earlier as in the figure below. 

 

Figure 4.12 Prestresses Composite Bridge (Layout) 

 

10. Next, for the Section page in the Pre/Post-Tension Composite Girder Bridge Wizard 

dialog box, fill in the next data such as deck thickness, the material used for each cross-

section, diaphragm data, number of girders and spacing between girders used 

according to the data that has been obtained previously as in the figure below. 
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Figure 4.13 Prestresses Composite Bridge (Section) 

 

11. For the tendon page is skipped first because the number of tendons used is calculated 

after the structural analysis is generated and followed by the load page, fill in all the 

loads that may act on the bridge such as dead loads, live loads and traffic loads 

according to the guidelines used as shown in the figure below. 

 

Figure 4.14 Prestresses Composite Bridge (Load and Define Traffic Lines) 
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Figure 4.15 Prestresses Composite Bridge (Load and Define Vehicles) 

 

12. Then for the Construction Stage page, adjust the construction stages as shown in the 

figure below. 

 

Figure 4.16 Prestresses Composite Bridge (Construction Stage) 

 

13. Then the results of the bridge modeling will look like in the figure below. 
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Figure 4.17 Modeling Results of Prestresses Composite Bridge 

 

14. Next, Define a Moving Load Case by selecting Load > Load Type > Moving Load > 

Moving Load Analysis Data > Moving Load Case from the Main Menu, then adjust 

the Moving Load Case as shown in the figure below. 

 

Figure 4.18 Moving Load Case 

 

15. Then make adjustments to the Static Load Cases from the results of the Prestresses 

Composite Bridge that have been made previously and also add Static Load Cases for 

the loads that will be added next such as Pedestrian Load and Wind Load on Structure 

by selecting Load > Load Type > Static Load > Create Load Cases > Static Load Cases 

from Main Menu as in the figure below. 
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Figure 4.19 Static Load Cases 

 

16. Add a pedestrian load of 5 kPa (SNI 1725:2016) by selecting Load > Load Type > 

Static Load > Structure Load / Masses > Nodal Loads from the Main Menu As shown 

in the figure below. Because the pedestrian load is the load area while the input is the 

nodal Load, then convert the pedestrian load as calculated below. 

Pedestrian Load WTP = 5.00 kN/m2 

Width of Sidewalk btr = 1.0 m 

Distance Between Nodes Dn = 2.00 m 

Point Load on the Central Node Pn1 = 

= 

WTP x btr x Dn 

10.00 

 

kN 

Point Load on the Edge Node Pn2 = 

= 

0.5 x Pn1 

5 

 

kN 
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Figure 4.20 Pedestrian Load 

 

17. Then add the wind load to the structure which is a uniform load on the outermost girder 

by selecting Load > Load Type > Static Load > Beam Element > Element from the 

Main Menu as shown in the figure below. The amount of wind load on the structure is 

entered based on the data below. 

Upstream Surface Conditions Open Field  

Wind Friction Speed V0 = 13.2 km/jam 

Length of Friction Upstream of the Bridge Z0  70 mm 

Elevation of Structures Above Ground Z = 9000 mm 

Wind Speed Design of 10000 mm above Ground VB = 90 km/jam 

Wind Speed at an Elevation of 10000 mm above 

Ground 

V10 = 90 km/jam 

Base Wind Pressure PB = 0.0024 MPa 

Wind Speed Design VDZ = 160.264 Km/jam 

Wind Load on Structures EWL = PB (VDZ / VB )2 

  = 7.610 kN/m 
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Figure 4.21 Wind Load on Structure 

 

18. As a static analysis control on a structure, define the Eigenvalue by selecting Analysis 

> Analysis Control > Eigenvalue from the Main Menu as shown in the figure below. 

 

Figure 4.22 Eigenvalue 

 

19. Add the earthquake load Response Spectrum, from which the earthquake data is taken 

from Aplikasi Lini, by selecting Load > Load Type > Dynamic Load > Respon 

Spectrum > RS Load from the Main Menu as shown in the figure below. 
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Figure 4.23 Aplikasi Lini 

 

 

Figure 4.24 Response Spectrum 

 

20. Followed by creating the Load Case Response Spectrum by selecting Load > Load 

Type > Dynamic Load > Response Spectrum > RS Load Cases from the Main Menu 

as shown in the figure below. 
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Figure 4.25 Response Spectrum Load Case 

 

21. Then make a load combination according to SNI 1725:2016 by selecting Result > 

Combination > Load Combination from the Main Menu. In this Load Combination, 

we can create a Load Combination automatically with Auto Generation following the 

guidelines provided by Midas Civil 2022 such as AASHTO-LRFD17 and adjusted 

again with SNI 1725:2016 as shown in the figure below  

 

Figure 4.26 Load Combination 

 

22. Finally, analyze the bridge structure that has been modeled earlier by selecting 

Analysis > Perform > Perform Analysis from the Main Menu or you can press the F5 
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key, then all the results of the analysis can be seen in the Result menu as shown in the 

figure below. 

 

Figure 4.27 Perform Analysis 

 

4.2.3. Approximating Prestressing Force and Determination of The Number of Tendon 

The number of prestressed strands required is usually determined based on the tensile stress 

on the bottom fiber (fbserv) of the girder due to the combination of Service III loading, where the 

amount of tensile stress on the bottom fiber due to the combination of Layan III load based on the 

analysis using Midas Civil 2022 is: 

fbserv = 20.807 MPa 

The limitation of concrete tensile stress immediately after the transfer of prestressed force 

that occurs during the service load (falserv) based on SNI 2847-2019 is:  

falserv = 0.5 √fc′ MPa  = 3.536 MPa 

Thus, the required strand prestressed stress (fpb) at the bottom of the girder is: 

fpb = fbserv - falserv = 17.271 MPa 

The location of the center of the prestressed force is assumed to be about 5-15 percent of 

the height of the girder measured from the bottom side of the girder. And in this case, it was chosen 

by 10 percent. 
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Distance from the Neutral Axis to the 

Bottom Fiber 
yb = 1034.038 mm   

Distance From The Center of the 

Prestress to The Bottom Fiber 
ybs = 0.1 hg = 210.000 mm 

Eccentricity at The Mid-Span ec = yb - ybs = 824.038 mm 

 

The stress at the base of the girder due to the effective prestress force, Pe, can be determined 

by the following equation: 

Pe = 
fpb  Ag  Sb

Sb + ec Ag
 = 5503.332 kN 

To calculate the final prestress force on each strand, estimating the prestress losses that 

occur in the strand is necessary. It is assumed that the prestress losses are 20% and the initial 

prestress tension is 0.75fpu so the effective prestress is 55%. Then the final prestress force per 

strand (Pe_strand) can be determined based on the following equation: 

Pe_strand = Astrand . fpbt . (1 – losses) = 110.160 kN 

Based on the calculation above, the number of strands required (Nstr_req) to bear the load 

acting on the prestressed concrete is: 

Nstr_req = 
pe

pe_strand  
 = 50 strand 

Nstr        = 57 strand 

N       = 3 Tendon 

It should be noted that the determination of the initial number of strands can differ from 

the number of final strands used. For example, in this example, the number of strands required is 

50, but in the final condition, 57 strands are used. This is because the initial strand in this example 

is determined based on the conditions in the middle of the span. However, in segmental prestressed 

girder bridges, planning is often determined by conditions at the point where there should be no 

tensile stress at the girder joint so that the number of final strands is more than the initial estimate. 

Aps = Nstr . Astrand = 5922.600 mm2 
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4.2.4. Position of Tendon 

 

Figure 4.28 Position of Tendon 

 

Table 4.1 Position of Tendon 

Tendon 
Number 

Tendon 
Code 

Number 

of 
Strands 

Tendon Position in the 

end of the pan (mm) 

Tendon position in the 

middle of the Span(mm) 

Distance of end 

position and Mid (mm) 

Yi Zi Yj Zj ΔY ΔZ 

1 T1 19 0 1200 0 250 0 950 

2 T2 19 0 800 150 100 -150 700 

3 T3 19 0 400 -150 100 150 300 

 

4.2.5. Prestressed Concrete Design Check Using Midas Civil 2022 

Design check on prestressed concrete has some very important uses such as guaranteeing 

structural safety by ensuring that the concrete elements can withstand the planned load without 

experiencing failures such as cracking or collapsing. In addition, design checks also ensure 

optimal performance, so that the structure functions according to its intended purpose, including 

rigidity and stability over its lifetime. The design inspections that Midas Civil can accommodate 

are the inspection of prestressed force loss, the inspection of the allowable stress on concrete, 

and the inspection of bending and shear capacity. 

The stages that can be carried out in the check of prestressed concrete design at Midas Civil 

include the following. 
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1. By continuing the modeling from the structural analysis that has been done previously, 

define the tendon data according to the data from the design calculations that have 

been done previously by selecting Load > Load Type > Temp./Prestress > Prestress 

Loads > Tendon Property from the Main Menu as shown in the figure below. 

 

Figure 4.29 Tendon Property 

 

2. Define the tendon profile along the span of the girder beam according to the previously 

calculated data by inputting the coordinates of the tendon at the end of the span and 

the middle of the span for all girder beams by selecting Load > Load Type > 

Temp./Prestress > Prestress Loads > Tendon Profile from the Main Menu as shown in 

the figure below. 

 

Figure 4.30 Tendon Profile 



 

59 

 

 

 

Figure 4.31 Add/Modify Tendon Profil 

 

 

Figure 4.32 Results from Tendon Profile (Side View) 
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3. Define the prestressed load to be applied to the tendon by selecting Load > Load Type 

> Temp./Prestress > Prestress Loads > Tendon Prestress from the Main Menu as shown 

in the figure below. 

 

Figure 4.33 Tendon Prestressed 

 

4. Add the force acting on the tendon in the Construction Stage in Stage 1 i.e. on the 

tendon force transfer by selecting Load > Load Type > Construction Stage > 

Construction Stage  Data > Define C.S from the Main Menu as shown in the figure 

below.  

 

Figure 4.34 Construction Stage 
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5. For checking the flexure capacity and shear capacity of the cross-section, we must 

include longitudinal reinforcement and shear reinforcement which will be used by the 

trial and error method until the value of bending capacity and shear capacity follows 

the allowed value by selecting Properties > Section > Section Manager > 

Reinforcement from the Main Menu as shown in the figure below.  

 

Figure 4.35 Section Manager (Reinforcement) 

 

6. To approximate the stress loss in the tendon we must first define the control analysis 

by selecting Analysis > Analysis Control > Approximate Tendon Losses from the 

Main Menu as shown in the figure below. 

 

Figure 4.36 Approximate Tendon Losses 
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7. Add a force that works on the tendon in the Load Combination by selecting Result > 

Combination > Load Combination from the Main Menu as shown in the figure below. 

 

Figure 4.37 Load Combination 

 

8. To see the force working on the structure after the Tendon is added, perform a Run 

Analysis Again by selecting Analysis > Perform > Perform Analysis from the Main 

Menu as shown in the figure below. 

 

Figure 4.38 Perform Analysis 
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9. Furthermore, for checking prestressed concrete that has been designed beforehand, we 

must choose the guidelines we use and set the parameters first by selecting PSC > 

Design Parameter > Parameter from the Main Menu as shown in the figure below. 

 

Figure 4.39 Design Parameter 

 

10. Next, we need to define the material of the design that we calculated earlier, such as 

the quality of the concrete and the quality of the rebar steel used by selecting PSC > 

PSC Design Data > PSC Design Material from the Main Menu as shown in the figure 

below.  

 

Figure 4.40 PSC Design Material 
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11. Then, Select the position of the prestressed concrete you want to check and export the 

calculation by selecting PSC > PSC Design Data > Design/Output Position from the 

Main Menu as shown in the figure below.  

 

Figure 4.41 Design/Output Position 

 

12. Then select Load Combination of the serving load used for checking the allowable 

stress on concrete by selecting PSC > PSC Design Data > Concrate Allowable Stress 

Load Case from the Main Menu as shown in the figure below.  

 

Figure 4.42 Concrate Allowable Stress Load Case 
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13. To start the inspection on the prestressed concrete design, we perform the design by 

selecting PSC > PSC Design > Perform Design from the Main Menu as shown in the 

figure below.  

 

Figure 4.43 Perform Design 

 

14. See the results of the Check on the prestressed concrete that has been carried out by 

selecting PSC > PSC Design Result > Result from the Main Menu as shown in the 

figure below. 

 

Figure 4.44 Result Table 
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Figure 4.45 Result Table of Checked Stress for Cross Section ar Service Load 

 

15. Export design check results by selecting PSC > PSC Design > Export Report from the 

Main Menu as shown in the figure below. 

 

Figure 4.46 Excel Report 
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Figure 4.47 Result of Excel Report 

 

Based on the Prestressed Concrete Check using Midas Civil that has been carried out in the 

middle of the span, the following results are obtained, 

1. Final Effective Prestressed Force 

• Effective prestressed force fpe = 1061.564 kN 

• Tendon Stress Limit fpe_max = 

= 

0.8 fpy 

1339.20 

 

kN 

• Control fpe ≤ fpe_max (OK) 

 Because the fpe value is smaller than fpe_max, The steel tendon is safe against the 

stress that occurs 

 

2. Stress Check 

Allowable Stressed at Service Load 

• Tensile σt = 

= 

−0.5√f`cg 

-3.545 

 

MPa 

• Compression σc = 

= 

0.6 f`cg 

30000 

 

MPa 

Stressed of Beam Girder at Service Load 

• Stressed at top fiber ft =   -3124.294 MPa ≤ σt (OK) 

• Stressed at Bottom fiber fb = 8981.759 MPa ≤ σc (OK) 
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Because the Stressed of the Beam Girder at the Service Load value Qualify allowable 

stress at the service load, the beam Girder can withstand the Stressed occurred 

   

3. Flexure Strength Check 

Flexure Resistance 

• Maximum factored moment Mu = 2000 kN 

• Nominal Flexure Resistance Mr = 1000 kN 

• Control Mr ≥ Mu (OK) 

Because the Mr value is greater than Mu, the beam girder can withstand the applied 

load. 

Minimum Reinforcement check  

• Maximum factored moment Mu = 2000 kN 

• Cracking moment Mcr =  kN 

• Nominal Flexure Resistance Mr = 1000 kN 

• Control Mr ≥ min(1.33Mu, 1.2 Mcr) (OK) 

 

4. Shear Strength Check 

• Maximum factored Shear Vu = 2000 kN 

• Nominal Shear Resistance Vn = 1000 kN 

• Control Mr ≥ Mu (OK) 

Because the Vn value is greater than VU, the beam girder can withstand the applied 

load. 

 

4.2.6. Reinforcement Calculation of Bridge Superstructure Component 

The superstructure components for which the reinforcement is calculated are Girder 

Beams, Floor Plates, Diaphragms, and Deck slabs which will be attached to the attachment. The 

following is an example of the calculation of superstructure reinforcement from Girder Beams. 

1. Reinforcement of Beam Girder (PCI-Girder) 

Flexure Reinforcement of Beam Girder 

Based on calculations of Midas Civil 2022, all prestressed concrete elements meet 

the minimum flexure reinforcement requirements. Therefore, for bending reinforcement 

used for reinforced concrete based on SNI 2847-2019 is for beams with tendons without 
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adhesion, the minimum area of longitudinal thread reinforcement with adhesion (Asmin) 

must be:  

Asmin = 0.004 Act 

where: Act = cross-sectional area of Girder beam 

• Flexure reinforcement is needed for the Edge Section of PCI-Girder 

 

• Flexure reinforcement is needed for the Middle Section of PCI-Girder 

 

 

Shear Reinforcement of Beam Girder (PCI-Girder) 

Based on trial and error in Midas Civil 2022 to control the shear capacity of the 

girder beam, it is found that the shear reinforcement used is 

 

 

 

 

Diameter of Rebar : Ds = 13 mm

Area of Rebar : As = 132.732 mm
2

Cross-Sectional Area : Ag = 1320300 mm
2

Reinforcement Area Required : As_req = 5281.200 mm
2

Number of Rebar Required : n = 39.788

Number of Rebar Used : 40D13

= [ (1/4) π Ds
2
 ]

= [ Midas Civil Calculation ]

= [ 0.4% Ag ]

= [ As_req / As ]

=  

Diameter of Rebar : Ds = 13 mm

Area of Rebar : As = 132.732 mm
2

Cross-Sectional Area : Ag = 825550 mm
2

Reinforcement Area Required : As_req = 3302.200 mm
2

Number of Rebar Required : N = 24.879

Number of Rebar Used : 26D13

=  

= [ (1/4) π Ds
2
 ]

= [ Midas Civil Calculation ]

= [ 0.4% Ag ]

= [ As_req / As ]

Diameter of Rebar : Dv = 13 mm

Number of Rebar : nv = 2

Area of Shear Reinforcement : Av = [ (1/4) * π * dv2 * nv ] = 265.465 mm
2

Specing of Field Reinforcement :

Specing of Support Reinforcement: D13-100

=  

=  

D13-200
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2. Reinforcement of Floor Slab 

General Data of Floor Slab 

 

 

Flexure Reinforcement of Floor Slab 

 

 

 

Effective Width of Floor Slabs : b = 2000 mm

Thickness of Floor Slab : ts = 250.000 mm

Concrete Grade : fc' = 30.000 MPa

Yield Strength of  Rainforcement Steel : fy = 420 MPa

Concrete Cover : cd = 30 mm

= [ Initial Data  ]

= [ Input ]

= [ Initial Data  ]

= [ Initial Data  ]

= [ Initial Data  ]

Df = 16 mm

ϕf = 0.9

Mu = 138.01 kN.m

de = [ h - dc -0.5D ] = 212 mm

b1       
= 0.85

rb       = 0.0304 kN.m

Rnmax = 7.7695 kN/m
2

Mn = 153.339 mm
2

Rn = 1.706 kN/m
2

Rn < Rnmax = OK!

r = 0.0042

rmin    = 0.0033

r = 0.0042

As = 1784 mm
2

Smax = 225 mm

S = 100 mm

=Longitudinal Flexure Reinforcement Used D16 - 100

= [ min (r , r min) ]

= [ r * b * de]

= [ (1/4) * π * D
2
 * b / As ]

=  

= [ 0.75*rb*fy*(1–½*0.75*rb*fy/(0.85*fc') ]

= [ Mu / f ]

= [ Mn * 10
6
 / ( b * de

2
 ) ]

= [ 0.85*fc'/fy*(1-√[ 1 – 2 * Rn/( 0.85*fc' )) ]

= [ 1.4 / fy ]

=  

= [ Midas Civil Calculation ]

= [ fc'  >  30 MPa ]

= [ b1* 0.85 * fc'/ fy * 600 / ( 600 + fy ) ]

=   [ Input ]
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Transverse Reinforcement of Floor Slab 

 

 

The following is a recapitulation of the reinforcement used in the superstructure of the 

bridge after the calculation, 

 

Table 4.2 Beam Girder Reinforcement 

Reinforcement Type Specification 

Flexure reinforcement of edge PCI-Girder 40D13 

Flexure reinforcement of middle PCI-Girder 26D13 

Field shear reinforcement  D13 - 200 

Support shear reinforcement D13 - 100 

 

Table 4.3 Floor Slab Reinforcement 

Reinforcement Type Specification 

Longitudinal flexure reinforcement D16 - 100 

Transverse flexure reinforcement D13 - 100 

 

Table 4.4 Diaphragm Reinforcement 

Reinforcement Type Specification 

Flexure reinforcement D13 - 200 

Shear reinforcement D10 - 200 

 

Table 4.5 Deck Slab Reinforcement 

Reinforcement Type Specification 

Longitudinal flexure reinforcement D10 - 200 

Transverse flexure reinforcement D10 - 300 

 

 

Dv = 13 mm

Pt =  [ Min (110/√S, 67%] = 67 %

As_req =  [ (As_req * Pt) ] = 1195.24 mm
2

Smax = 222.101 mm

S = 100 mm

Specing of Transverse Reinforcement Used =

=  [  Input  ]

=  [ (b * (1/4) * π * D
2
)/ As_req ]

D13 - 100
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4.2.7. Other Detailing of Bridge Superstructure 

1. Elastomer Bearing Pad 

Elastomer-bearing pads are an important element in bridge construction that 

absorb and distribute loads and movements between the bridge structure and its 

supports such as abutments. Bearing pads help maintain the bridge's stability and 

ensure that the force and movement received by the bridge can be handled effectively 

while reducing damage to the structure of the bridge itself. 

based on the elastomeric bearing data mentioned earlier with dimensions of 600 

cm x 600 cm x 97 cm as shown in the figure below. 

 

Figure 4.48 Elastomer Bearing Pad 

 

The elastomer bearing pad used must withstand the reaction of the bridge 

superstructure so that there is no damage to the pad when receiving the load. The check 

was carried out that there was an allowable load that could be carried by the elastomer 

bearing pad and the reaction of the bridge superstructure as shown in the data below. 

• Allowable Compressive Strength of Elastomer  Fn = 2930.000 kN 

• Compressive Strength of Superstructure Reaction Fz = 2212.008 kN 

• Control   Fz ≤ Fn (OK) 

Based on the above check, the elastomer can withstand the load generated by the 

reaction of the bridge superstructure 

2. Connectors Between Segments (Pin Connector) 

In this research, the bridge designed is a segmental prestressed concrete bridge 

that requires a connection to connect between the segments. The type of connection 

used is Pin Connector with details as shown in the figure below. 
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Figure 4.49 Pin Connector 

 

4.3. DESIGN OF BRIDGE SUBSTRUCTURE AND FOUNDATION  

4.3.1. Preliminary Design of Bridge Substructure and Foundation 

The bridge substructure consists of several parts such as the breast wall, back wall, wing 

wall, and approach slab. The breast wall is the bridge's substructure at the start and end of the 

bridge. This bridge's substructure supports the superstructure and as a transition from oprit to the 

bridge floor. The piles from the oprit and the road body are held by the back wall, while the side 

piles are held by the wing wall. Meanwhile, the approach slab is useful for connecting roads and 

bridges so that there is no too noticeable change in height on both. 

In the planning of the prestressed concrete bridge, the height of the planned abutment is 9 

meters. Based on Panduan Teknik pelaksanaan jembatan (2021), abutments with a height ranging 

from 6-12 meters generally use inverted T-type abutments. So the substructure that will be 

designed has dimensions like the one in the image below. 
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Figure 4.50 Dimension of Bridge Substructure 

 

As previously explained, According to FHWA NHI-05-042 Design and Construction of 

Driven Pile Foundation, page 7-4, the type of foundation that matches the soil conditions is the 

pile foundation with a depth of 15 meters and a pile diameter of 0.8 meters and has 10 piles shown 

in the figure below. 

 

Figure 4.51 Dimension of Pile 

 

 

4.3.2. Structural Analysis of Substructure Using Midas Civil 2022 

The stages that can be carried out in the analysis of the substructure and foundation using 

Midas Civil 2022 include the following. 
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1. Open Midas Civil 2023 that has been installed on your PC so that the initial display 

appears as shown below, then select New Project to create a new worksheet. 

 

Figure 4.52 Initial View of Midas Civil 2022 

 

2. Define the material used in modeling the bridge's substructure to be analyzed, which 

has been mentioned in the previous substructure and foundation data, such as fc'30 

concrete by selecting Properties > Material > Material from the Main Menu as shown 

in the figure below.  

 

Figure 4.53 Material Properties 
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3. Next, Define Section Properties for the pile used by selecting Properties > Section > 

Section Properties from the Main Menu as shown in the figure below. 

 

Figure 4.54 Section Properties 

 

4. Then also define the Thickness of the Pilecap, Breastwall, Backwall, Approach Slab, 

and Wingwall used by selecting Properties > Section > Thickness from the Main Menu 

as shown in the figure below. 

 

Figure 4.55 Thickness 
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5. Create a node for each element of the substructure and foundation that is useful for the 

modeling by selecting Node/Elements > Nodes from the Main Menu. In the creation 

of this node, it can be done by copying, rotating points, etc. according to the 

coordinates of the node to be created as shown in the figure below 

 

Figure 4.56 Create Nodes 

 

6. Then create an element from each substructure and foundation element of the 

previously created node by selecting Node/Elements > Element from the Main Menu 

as shown in the figure below. 

 

Figure 4.57 Create Elements 
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7. Connect each element of the structure whose nodes are not bound to each other by 

selecting Boundary> Link > Elastic Link from the Main Menu and for Elastic Link 

Data select Rigid as shown in the figure below. 

 

Figure 4.58 Elastic Link (Rigid) 

 

8. Then define the support on the pile foundation by selecting Boundary > Support > 

Define Support from the Main Menu as shown in the figure below. 

 

Figure 4.59 Define Support 
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9. Next, check the modeling of the bridge substructure and foundation that has been 

carried out by performing an Analysis and see the Displacement Contour that occurs, 

if the results of the Displacement Contour produced are like the figure below, then we 

can proceed to the loading stage. 

 

Figure 4.60 Checking Substructure Modeling by Viewing Displacement Contour 

 

10. Create a Load Case for each load to be inserted by selecting Load > Load Type > Static 

Load > Create Load Cases > Static Load Cases from the Main Menu as shown in the 

figure below. 

 

Figure 4.61 Load Case 
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11. Next, input load from the superstructure pedestal that has been generated from the 

superstructure analysis previously performed for each load from the superstructure by 

selecting Load > Load Type > Static Load > Structure Load/Masses > Nodal Loads 

from the Main Menu as shown in the figure below, with the following data. 

• Self-weight of the Superstructure FSW = 721.560 kN 

• Barrier and Sidewalk Load FMA1 = 162.978 kN 

• Wearing Surface load FMA = 38.733 kN 

• Pedestrian Load FTP = 48.854 kN 

• Line Load FTD = 337.704 kN 

• Truck Load FTT = 323.491 kN 

 

Figure 4.62 Node Load of Loads from the Superstructure 

 

12. Next, input the load due to active ground pressure on the Backwall, Breast wall, and 

Wingwall by selecting Load > Load Type > Static Load > Pressure Load > Pressure 

Load from the Main Menu as shown in the figure below with the following values. 

• Specific Gravity of Soil γ = 18 kN/m3 

• Angle of Internal Friction φ = 30°  

• Cohesion of Soil Ka = 0.33 kN 

• Active Ground Pressure for Depth 0 m PTA1 = 0.00 kN/m2 

• Active Ground Pressure for Depth 2.4 m PTA2 = 7.20 kN/m2 

• Active Ground Pressure for Depth 5.5 m PTA3 = 16.5 kN/m2 

• Active Ground Pressure for Depth 7.5 m PTA4 = 22.5 kN/m2 
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Figure 4.63 Active Ground Pressure on Back Wall and Breast Wall 

 

 

Figure 4.64 Active Ground Pressure on Wingwall 

 

13. The next step, remove the foundation from the pile that we have made previously and 

input the Boundery from the pile with the NSPT data from the soil according to the 

data that has been presented previously by selecting Boundery > Spring Support > 

Integral Bridge from the Main Menu then on Soil Spring Type select Pile Spring and 

enter soil data according to the available data as shown in the figure below. 



 

82 

 

 

Figure 4.65 Integral Bridge (Pile Spring) 

 

14. Input the Spectral Response earthquake data such as the earthquake data that we have 

entered into the Spectral Response earthquake data on the superstructure and also make 

a Load Case from the Spectral Response by selecting Load > Load Type > Dynamic 

Loads > Response Spectrum Data from the Main Menu as shown in the figure below. 

 

Figure 4.66 Response Spectrum of Padang 

 

 



 

83 

 

 

Figure 4.67 RS Load Cases 

 

15. Then make a combination of loads used following SNI 1725:2016 by selecting Result 

> Combination > Load Combination from the Main Menu as shown in the figure 

below. 

 

Figure 4.68 Load Combination 

 

16. Next, analyze the bridge structure that has been modeled earlier by selecting Analysis 

> Perform > Perform Analysis from the Main Menu or you can press the F5 key, then 

all the results of the analysis can be seen in the Result menu as shown in the figure 

below 
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Figure 4.69 Perform Analysis 

 

4.3.3. Stability of Bridge Abutment 

To ensure that the abutment can work properly and safely, stability calculations must be 

carried out by paying attention to several aspects. Some of the factors that need to be calculated 

and analyzed include: 

1. Abutment Stability Against Tipping (Rolling) 

The stability of the abutment against the tipping is a condition in which the abutment 

can prevent the occurrence of reversal (Rolling) or rotation caused by the moment acting 

on the structure. This reversal can occur when the load received by the abutment produces 

a moment greater than the abutment's ability to hold it. To keep the abutment from tipping 

over, it is important to ensure that the moment acting on the abutment is less than the 

holding moment provided by the structure and the soil that supports it. The following is 

the calculation of the stability of the Abutment Rolling, 

 

 

 

Vertical Moment : Mv = 699.099 kN.m

Horizontal Moment : Mh = 332.053 kN.m

Factor of Safety : SoF = 2

Factor of Safety For Tipping : Soft =  [ Mv/Mh ] = 2.105

Control =  [ SoFt > SoF ] = OK!

= [ Midas Civil Calculation ]

= [ Midas Civil Calculation ]

Vertical Moment : Mv = 699.099 kN.m

Horizontal Moment : Mh = 332.053 kN.m

Factor of Safety : SoF = 2

Factor of Safety For Tipping : Soft =  [ Mv/Mh ] = 2.105

Control =  [ SoFt > SoF ] = OK!

= [ Midas Civil Calculation ]

= [ Midas Civil Calculation ]
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2. Abutment Stability Against Shearing 

The abutment must be stable against horizontal forces so that it does not shift. The 

calculation for friction stability can be done by comparing the shear force received with 

the shear force that can be resisted by friction between the abutment and the foundation. 

 

 

4.3.4. Bearing Capacity of Pile Foundation 

Foundation Bearing Capacity is the maximum capacity that the soil or foundation structure 

can bear without causing failure or excessive subsidence. The bearing capacity of the foundation 

is very important in the design of buildings or other structures because a foundation that does not 

have sufficient bearing capacity can result in damage to existing structures. The bearing capacity 

of a foundation can be calculated based on a variety of factors, including soil type, foundation 

depth, and the physical and mechanical properties of the soil on site.  

 

Angle of Internal Friction : ϕ =  = 30 °

Cohesion of Soil : C =  = 1 kN/m2

Area of Abutment Base : A =  [ P . L ] = 50 m2

Vertical Force : V = 1595.59 kN

Horizontal Force : H = 325.934 kN

Factor of Safety : SoF = 1.5

Factor of Safety For Shear : Sofx =  [ ((C * A) + (V * tan ϕ)) / Hx ]= 2.980

Control =  [ SoFx > SoF ] = OK!

= [ Midas Civil Calculation ]

= [ Midas Civil Calculation ]

N-SPT for Depth 0 - 6 m : N1 = 10

N-SPT for Depth 6 - 15 m : N2 = [ Initial Data ] = 50

Soil Specific Gravity for Depth 0 - 6 m : γ1 = [ Initial Data ] = 18 kN/m
3

Soil Specific Gravity for Depth 6 - 15 m : γ2 = [ Initial Data ] = 22 kN/m
3

Safety of Factor : SoF = [ Initial Data ] = 2.5

Length of Pile : H = [ Preliminary Design ] = 15 m

Pile Length at Depth 0 - 6 m : H1 = [ Preliminary Design ] = 6 m

Pile Length at Depth 6 - 15 m : H2 = [ Preliminary Design ] = 9 m

Diameter of Pile : D = [ Preliminary Design ] = 0.8 m

Lateral Surface Area for Depth 0 - 6 m : AS1 =  [ π * D * H1 ] = 15.080 mm
2

Lateral Surface Area for Depth 6 - 15 m : AS2 =  [ π * D * H2 ] = 22.619 mm
2

Pile Area Tip : At =  [ (1/4) * π * D2  ] = 0.503 mm
2

= [ Initial Data ]
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4.3.5. Reinforcement Calculation of Bridge Substructure and Foundation 

The substructure and foundation components for which the reinforcement is calculated are 

Breast wall, Back wall, Wing wall, approach slab, Pile cap, and Pile which will be attached to the 

attachment. The following is an example of the calculation of superstructure reinforcement from 

Pile Cap. 

1. Reinforcement of Breast Wall 

General Data of Breast Wall 

 

 

Axial – Flexure Reinforcement of Breast Wall 

 

N-SPT for Depth 0 - 6 m : N1 = 10

N-SPT for Depth 6 - 15 m : N2 = [ Initial Data ] = 50

Soil Specific Gravity for Depth 0 - 6 m : γ1 = [ Initial Data ] = 18 kN/m
3

Soil Specific Gravity for Depth 6 - 15 m : γ2 = [ Initial Data ] = 22 kN/m
3

Safety of Factor : SoF = [ Initial Data ] = 2.5

Length of Pile : H = [ Preliminary Design ] = 15 m

Pile Length at Depth 0 - 6 m : H1 = [ Preliminary Design ] = 6 m

Pile Length at Depth 6 - 15 m : H2 = [ Preliminary Design ] = 9 m

Diameter of Pile : D = [ Preliminary Design ] = 0.8 m

Lateral Surface Area for Depth 0 - 6 m : AS1 =  [ π * D * H1 ] = 15.080 mm
2

Lateral Surface Area for Depth 6 - 15 m : AS2 =  [ π * D * H2 ] = 22.619 mm
2

Pile Area Tip : At =  [ (1/4) * π * D2  ] = 0.503 mm
2

= [ Initial Data ]

Height of Breastwall : h = 1200 mm

Longitudinal Width of Breastwall : bx = 10000 mm

Transversal Width of Breastwall : by = 5050 mm

Concrete Grade : fc' = 30 MPa

Yield Strength of  Rainforcement Steel : fy = 420 MPa

Concrete Cover : dc = [ Input ] = 50 mm

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

Db = 25 mm

Mux = 699.099 kN.m

Muy = 332.053 kN.m

Pu = 1595.59 kN

S = 150 mm

n = 67

As = 65777.10 mm
2

Ag = 12000000 mm
2

r   = 0.548 %

rmin    = 0.500 %

rmin > r = OK

=  D 25 - 150Axial-Flexure  Reinforcement Used

= [ Midas Civil Calculation ]

= [ Midas Civil Calculation ]

= [ Input ]

= [ bx / s ]

= [ n * (1/4) * π *Db
2 

]

= [ bx * by
 
]

= [ Input ]

= [ Midas Civil Calculation ]

= [ As / Ag ]
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With the help of SpColumn software, you can get the axial-flexural interaction 

diagram of the Breast wall as shown in the image below, 

 

Figure 4.70 Axial - Flexural Interaction Diagram of the Breast Wall 

 

The combination of Pu and Mu loads in the axial-flexural interaction diagram of 

the Breast wall indicates that the Breast wall section can carry the loads that occur. The 

interaction diagram above is an interaction diagram of the abutment cross section using 

the main reinforcement is D25 - 150 

    

 

 

   

Db = 25 mm

Mux = 699.099 kN.m

Muy = 332.053 kN.m

Pu = 1595.59 kN

S = 150 mm

n = 67

As = 65777.10 mm
2

Ag = 12000000 mm
2

r   = 0.548 %

rmin    = 0.500 %

rmin > r = OK

=  D 25 - 150Axial-Flexure  Reinforcement Used

= [ Midas Civil Calculation ]

= [ Midas Civil Calculation ]

= [ Input ]

= [ bx / s ]

= [ n * (1/4) * π *Db
2 

]

= [ bx * by
 
]

= [ Input ]

= [ Midas Civil Calculation ]

= [ As / Ag ]
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Transverse Reinforcement of Breast Wall 

 

 

Transverse Reinforcement of Breast Wall 

 

D = 16 mm

λ = = 1

β = = 2

ϕv = 0.75

Vu = 316.681 kN.m

b' = = 1000 mm

de = 1142 mm

Vc = [ 0.083 * β * √(f'c Mpa) *b *de ] = 10383.29 kN

= [ 0.5 ϕv Vc ] = 3893.732

Av_mi

n
= [ (0.083*λ*√(f'c Mpa)*b*b') / fy  ] = 10824.04 mm2

S = 150 mm

Av_use = [  (1/4) * π * D
2
 * b / S ] = 13404.13 mm2

= OK!

=

= [ Input ]

D16 - 150Shear Reinforcement Used

Vu < 0.5 ϕv Vc

Shear Reinforcement is Required

Av_use < Av_min

= [ SNI 2847-2019 ]

= [ Midas Civil Calculation ]

= [ h - dc -0.5D ]

D = 16 mm

λ = = 1

β = = 2

ϕv = 0.75

Vu = 316.681 kN.m

b' = = 1000 mm

de = 1142 mm

Vc = [ 0.083 * β * √(f'c Mpa) *b *de ] = 5191.643 mm2

= [ 0.5 * ϕv * Vc ] = 1946.866

Sy = 600 mm

Vs = [ (Vu / ϕv) - Vc ] = -4769.4 kN

Av1 = -99437.1 mm2

Av_min = [ (0.083*λ*√(f'c Mpa)*b*b') / fy  ] = 10824.04 mm2

Av = [  Max ( Av1, Av_min)  ] = 10824.04 mm2

Sx_max = [ (b*s*(1/4)*π*D
2
) / (Av*Sy) ] = 309.5916 mm

Sx = 300 mm

=

= [ Input ]

D16 - 300/600

= [ h - dc -0.5D ]

Vu < 0.5 * ϕv * Vc

Shear Reinforcement is Required

= [ ( Vs * b ) / (  fy * de )  ]

Shear Reinforcement Used

= [ Midas Civil Calculation ]

= [ SNI 2847-2019 ]
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2. Reinforcement of Pile Cap 

General Data of Pile Cap 

 

 

Longitudinal Flexure of Pile Cap 

 

D = 16 mm

λ = = 1

β = = 2

ϕv = 0.75

Vu = 316.681 kN.m

b' = = 1000 mm

de = 1142 mm

Vc = [ 0.083 * β * √(f'c Mpa) *b *de ] = 5191.643 mm2

= [ 0.5 * ϕv * Vc ] = 1946.866

Sy = 600 mm

Vs = [ (Vu / ϕv) - Vc ] = -4769.4 kN

Av1 = -99437.1 mm2

Av_min = [ (0.083*λ*√(f'c Mpa)*b*b') / fy  ] = 10824.04 mm2

Av = [  Max ( Av1, Av_min)  ] = 10824.04 mm2

Sx_max = [ (b*s*(1/4)*π*D
2
) / (Av*Sy) ] = 309.5916 mm

Sx = 300 mm

=

= [ Input ]

D16 - 300/600

= [ h - dc -0.5D ]

Vu < 0.5 * ϕv * Vc

Shear Reinforcement is Required

= [ ( Vs * b ) / (  fy * de )  ]

Shear Reinforcement Used

= [ Midas Civil Calculation ]

= [ SNI 2847-2019 ]

Height of Backwall : h = 700 mm

Longitudinal Width of Backwall : bx = 10000 mm

Transversal Width of Backwall : by = 2400 mm

Concrete Grade : fc' = 30 MPa

Yield Strength of  Rainforcement Steel (D ≥ 13): fy = 420 MPa

Concrete Cover : dc = 50 mm

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Input  ]

D = 25 mm

ϕf = 0.9

Mu = 332.427 kN.m

b' = 1000 mm

de = 1437.5 mm

b1       
= 0.85

rb       = 0.030357

Rnmax = 7.770 kN/m
2

Mn = 369.36 kN.m

Rn = 0.179 kN/m
2

Rn < Rnmax = OK!

r = 0.0004

rmin    = 0.0012

r = 0.0012

As = 1711 mm
2

Smax = 287 mm

S =  = 150 mm

= D25 - 150Longitudinal Flexure Reinforcement Used

= [ 0.85*fc'/fy*(1-√[ 1 – 2 * Rn/( 0.85*fc' )) ]

= [ 0.5 / fy ]

= [ min (r , r min) ]

= [ r * b' * de]

= [ (1/4) * π * D
2
 * b' / As ]

= 

= [ h - dc -0.5D ]

= [ fc'  >  30 MPa ]

= [ b1* 0.85 * fc'/ fy * 600 / ( 600 + fy ) ]

= [ 0.75*rb*fy*(1–½*0.75*rb*fy/(0.85*fc') ]

= [ Mu / f ]

= [ Midas Civil Calculation ]

= [ SNI 2847-2019 ]

= [ Input ]

= [ Mn * 10
6
 / ( b' * de

2
 ) ]
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Transverse Reinforcement of Pile Cap 

 

 

Shear Reinforcement of Pile Cap 

 

D = 25 mm

ϕf = 0.9

Mu = 332.427 kN.m

b' = 1000 mm

de = 1437.5 mm

b1       
= 0.85

rb       = 0.030357

Rnmax = 7.770 kN/m
2

Mn = 369.36 kN.m

Rn = 0.179 kN/m
2

Rn < Rnmax = OK!

r = 0.0004

rmin    = 0.0012

r = 0.0012

As = 1711 mm
2

Smax = 287 mm

S =  = 150 mm

= D25 - 150Longitudinal Flexure Reinforcement Used

= [ 0.85*fc'/fy*(1-√[ 1 – 2 * Rn/( 0.85*fc' )) ]

= [ 0.5 / fy ]

= [ min (r , r min) ]

= [ r * b' * de]

= [ (1/4) * π * D
2
 * b' / As ]

= 

= [ h - dc -0.5D ]

= [ fc'  >  30 MPa ]

= [ b1* 0.85 * fc'/ fy * 600 / ( 600 + fy ) ]

= [ 0.75*rb*fy*(1–½*0.75*rb*fy/(0.85*fc') ]

= [ Mu / f ]

= [ Midas Civil Calculation ]

= [ SNI 2847-2019 ]

= [ Input ]

= [ Mn * 10
6
 / ( b' * de

2
 ) ]

D = 19 mm

As' = 856 mm
2

S'max = 331 mm

S' =  = 150 mm

= D19 - 150Longitudinal Flexure Reinforcement Used

=   [  Input  ]

= [ 50% * As]

= [ (1/4) * π * D
2
 * b / As ]

Dv = 16 mm

λ = 1

ϕv = 0.75

Vu = 110.527 kN

de = 1442 mm

b'' = = 1000 mm

Vc = [ (1/6) √(f'c Mpa) b de ] = 13163.6 kN

= [ 0.5 ϕv Vc ] = 4936.35 kN

Sy =  = 600 mm

Vs =  [ (Vu / ϕv) - Vc ] = -13016.2 kN

Av1 = -214917 mm
2

Av_min = [ (0.083*λ*√(f'c Mpa)*b*b') / fy  ] = 10824.04 mm
2

Av = [  Max ( Av1, Av_min)  ] = 10824.04 mm
2

Sx_max = [ (b*b'*(1/4)*π*D
2
) / (Av*Sy) ] = 309.5916 mm

Sx =  = 300 mm

D16 - 300/600

= [ h - dc - 0.5Dv ]

Vu < 0.5 ϕv Vc

Shear Reinforcement is Required

= [ ( Vs * b ) / (  fy * de )  ]

Shear Reinforcement Used

= [ Input ]

= [ SNI 2847-2019 ]

= [ Midas Civil Calculation ]
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The following is a recapitulation of the reinforcement used in the superstructure of the 

bridge after the calculation, 

Table 4.6 Deck Slab Reinforcement 

Reinforcement Type Specification 

Axial - Flexure Reinforcement D25 - 150 

Transversal Reinforcement D13 - 150 

Shear Reinforcement D16 – 300/600 

 

Table 4.7 Back Wall Reinforcement 

Reinforcement Type Specification 

Longitudinal Flexure Reinforcement D19 - 150 

Transversal Flexure Reinforcement D13 - 150 

Shear Reinforcement D13 – 300/400 

 

Table 4.8 Wing Wall Reinforcement 

Reinforcement Type Specification 

Longitudinal Flexure Reinforcement D16 - 150 

Transversal Flexure Reinforcement D13 - 150 

Shear Reinforcement D13 – 300/400 

 

Table 4.9 Approach Slab Reinforcement 

Reinforcement Type Specification 

Longitudinal Flexure Reinforcement D16 - 200 

Transversal Flexure Reinforcement D13 - 200 

Shear Reinforcement D13 – 300/400 

Dv = 16 mm

λ = 1

ϕv = 0.75

Vu = 110.527 kN

de = 1442 mm

b'' = = 1000 mm

Vc = [ (1/6) √(f'c Mpa) b de ] = 13163.6 kN

= [ 0.5 ϕv Vc ] = 4936.35 kN

Sy =  = 600 mm

Vs =  [ (Vu / ϕv) - Vc ] = -13016.2 kN

Av1 = -214917 mm
2

Av_min = [ (0.083*λ*√(f'c Mpa)*b*b') / fy  ] = 10824.04 mm
2

Av = [  Max ( Av1, Av_min)  ] = 10824.04 mm
2

Sx_max = [ (b*b'*(1/4)*π*D
2
) / (Av*Sy) ] = 309.5916 mm

Sx =  = 300 mm

D16 - 300/600

= [ h - dc - 0.5Dv ]

Vu < 0.5 ϕv Vc

Shear Reinforcement is Required

= [ ( Vs * b ) / (  fy * de )  ]

Shear Reinforcement Used

= [ Input ]

= [ SNI 2847-2019 ]

= [ Midas Civil Calculation ]
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Table 4.10 Pile Cap Reinforcement 

Reinforcement Type Specification 

Longitudinal Flexure Reinforcement D25 - 150 

Transversal Flexure Reinforcement D19 - 150 

Shear Reinforcement D13 – 300/400 

 

Table 4.11 Pile Foundation Reinforcement 

Reinforcement Type Specification 

Axial - Flexure Reinforcement 16D25 

Shear Reinforcement D16 - 100 

 

4.4. 3D MODELING OF PRESTRESSED CONCRATE BRIDGE USING AUTODESK 

REVIT 2023 

After obtaining the results of the analysis of the superstructure, substructure, and 

foundation of the prestressed concrete bridge with output in the form of parameters that can be 

used in modeling the bridge such as the dimensions of the bridge structure components and the 

required number of these components, the next step is to make a 3D model of the bridge. The 

model to be made is only limited to modeling the structure and architecture of the prestressed 

concrete bridge. The software that will be used to create a 3D model of the bridge is Autodesk 

Revit 2023 as previously explained. 

The stages that can be done in performing 3D modeling using Revit Autodex 2023 include 

the following. 

4.4.1. 3D Modeling of Bridge Structural Components 

1. Open Autodesk Revit 2023 installed on your PC. When the initial view of Revit 2023 

appears, in the Model section, click New. Then the New Project dialog box will appear, 

on the File template select Metric-Construction Template, and on Create New select 

Project, and click OK as shown in the figure below. 
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Figure 4.71 New Project 

 

2. After that, the project display will appear according to the template that we have 

chosen previously as shown below, where there are restrictions on work or displays 

such as Level 1, Level 2, East, North, South, and West which we can later adjust as 

needed.  

 

Figure 4.72 Worksheets of Autodesk Revit 2023 
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3. Next, enter one of the Floor plan worksheets to create a Grid that is used to help in 

creating drawings by selecting Datum > Grid on the Ribbon or you can type the 

shortcut "GR" and then arrange the grid according to the dimensions of the bridge that 

we will create as shown in the figure below. 

 

Figure 4.73 Creating a Grid 

 

4. then enter one of the Elevations (Building Elevation) worksheets to create a Level Line 

by selecting Datum > Level on the Ribbon or you can type the Shortcut "LL" and then 

set the Line Level according to the dimensions of the bridge that we will create as 

show5n in the figure below. 

 

Figure 4.74 Creating a Level Line 
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5. Next, create a family of all bridge components to be modeled such as PCI-Girder, 

Tendon, Abutment, Sidewalk, and Barrier by selecting the file > New > Family and 

then after opening the dialog box, select the templates family according to the bridge 

component to be created. Then the bridge component in the family corresponds to the 

dimensions that have been obtained in the previous subchapter, then the result of the 

family of the bridge component will look like in the figure below. 

 

Figure 4.75 Family PCI-Girder 

 

 

Figure 4.76 Family Tendon and Anchor 
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Figure 4.77 Family Abutment 
 

 

Figure 4.78 Family Diaphragm 

 

 

Figure 4.79 Family Sidewalk 
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Figure 4.80 Family Barrier 

 

 

Figure 4.81 Family Pile 

 

 

Figure 4.82 Family Elastomer Bearing Pad 
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6. Then input the family of all bridge components that have been made into the initial 

worksheet and adjust the location and number of bridge components according to the 

design that has been obtained previously, the result will look like in the figure below. 

 

Figure 4.83 3D Modeling of Bridge Structure 

 

7. To place the components of the tendon that has been made on, input the tendon family 

that has been created earlier and then adjust the placement of the tendon at the end and 

middle of the span according to the position of the tendon that has been planned as 

shown in the figure below 

 

Figure 4.84 Tendon Position in End of the Span 
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Figure 4.85 Tendon Position in the Middle of the Span 

 

4.4.2. Modeling Reinforcement of Bridge Components 

1. On the View Tab, click Section, on Properties select Detail View, and create a cut line 

on the object to be made of reinforcement, for example on the abutment as shown in 

the figure below. 

 

Figure 4 86 View – Section – Detail View 

 

2. The next step is to right-click on the Detail View and click Go to View so that a display 

of object pieces will appear as shown in the figure below.  
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Figure 4.87 Detail View 

 

3. To make a concrete blanket arrangement, it can be done by clicking the Structure tab, 

clicking Cover, selecting the desired type of concrete cover, then clicking on the object 

that will be arranged for the concrete cover as shown in the figure below.  

 

Figure 4.88 Structure – Cover 

 

4. Next, make the shape of the reinforcement following the provisions that have been 

made previously by clicking the Structure Tab, and clicking Rebar, then several types 

of pre-existing reinforcement will appear as seen in the figure below.  
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Figure 4.89 Structure – Rebar 

 

5. If the shape of the reinforcement is not available in the existing type of reinforcement, 

then we can make the shape of the reinforcement according to our will by clicking 

Sketch, and then drawing the shape of the reinforcement that has been predetermined. 

If it is finished, then the thing that needs to be regulated is the number of rebars that 

exist with the distance of each of the rebars. This can be done by clicking on the 

previously made reinforcement, on the Layout Tab selecting Maximum Spacing, then 

setting the maximum spacing between the reinforcements as, for example, D19 150 

reinforcement, then the distance between the reinforcements is 150 mm so that it can 

look like in the figure below.  

 

Figure 4 90 PCI-Girder Reinforcement 
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Figure 4.91 Floor Slab Reinforcement 

 

 

Figure 4. 92 Diafragm Reinforcement 

 

 

Figure 4.93 Breast Wall and Back Wall Reinforcement 
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Figure 4.94 Pile Cap Reinforcement 

 

 

Figure 4.95 Approach Slab Reinforcement 
 

 

Figure 4.96 Wing Wall Reinforcement 



 

104 

 

 

 

Figure 4 97 Pile Reinforcement 

 

6. For detailed drawings, it will be displayed in the attachment and the following is a 

complete view of the bridge structure that has been modeled using Autodesk Revit 

2022 with the reinforcement that exists on the bridge component as shown in the 

Figure below.  

 

Figure 4.98 Bridge Reinforcement 
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CHAPTER V 

CONCLUSION AND RECOMMENDATION 

5.1 CONCLUSION 

After researching the planning and design of pre-stressed concrete bridges with the 

application of the Building Information Modeling (BIM) concept to assist in the calculations, 

design process, and modeling, the conclusions that can be taken from this research are, 

1. This research successfully designed a prestressed concrete bridge that can withstand 

various types of loads that may work, both dead loads, live loads, and other environmental 

loads. The planning process is carried out by considering structural and safety factors, 

resulting in a design that can meet the technical standards required to maintain the 

integrity and safety of the bridge during its service life. The right selection of materials 

and the efficient design of structural elements also contribute to the stability and durability 

of the bridge.  

2. The deflection that occurs on the bridge (δmax) based on calculations in Midas Civil 2023 

must be smaller than the allowable deflection (L/360) with the following values, 

   δmax   ≤   L/360 

61.361 mm  ≤ 111.111 mm 

So the bridge structure can withstand all the loads without experiencing too large 

deflection. 

3. The design of prestressed concrete uses a PCI-Girder type 2100 mm with 57 Strands and 

3 Tendons, where each Tendon has 19 Strands 

4. From the results of the planning and design of the prestressed concrete bridge, this 

research succeeded in producing a detailed engineering design (DED) that covers all 

technical and geometric aspects of the bridge structure will be presented in the 

attachment. The resulting DED includes dimensional specifications of structural 

elements, material selection, and clear structural detailing in 2D and 3D form. This design 

is ready to be used as a guide in the implementation of bridge construction in the field. A 

complete and accurate DED will also minimize the potential for errors during execution, 

thereby improving the quality and efficiency of construction.  
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5. The application of the BIM concept in the planning and design of prestressed concrete 

bridges provides convenience in calculating and modeling structures more efficiently and 

accurately. With BIM, any changes to the design can be instantly and automatically 

updated across the entire model, reducing the potential for calculation and modeling 

errors. 

6. The application of BIM in the planning and design of prestressed concrete bridges 

provides some significant advantages, including: 

• BIM allows for more accurate calculations and more efficient modeling, reducing the 

possibility of design errors and structural miscalculations. 

• BIM allows designers to analyze various design scenarios and select the optimal 

solution. For example, in the planning of prestressed concrete bridges, BIM can be 

used to optimize the dimensions of structural elements, material types, and 

prestressed cable configurations, so that material efficiency and structural strength 

can be better achieved. 

• With BIM, load simulation and structural response to dynamic or static loads can be 

done better. This is very important in the planning of a prestressed concrete bridge 

that must be able to withstand the load from vehicles, wind, and other loads.  

• BIM technology provides the ability to view 3D models of the entire bridge, which 

makes it easier to understand and communicate between the design team and other 

stakeholders. 

7. The implementation of BIM also has several challenges and advantages, such as: 

• BIM implementation requires a considerable initial investment, both in terms of 

software, hardware, and training of human resources who will operate the BIM 

system. 

• The use of BIM requires higher technical expertise compared to conventional 

methods. Therefore, it takes a very long time to learn the BIM-based software. 

• If the BIM-based software used comes from a different development, the data transfer 

cannot be done directly. An add-on tool is needed to do just that, or the data transfer 

is done manually. 
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DETAIL STRUCTURE DRAWING 

 

 

 

 

 

 

 

 

 



Length of Bridge : L 40.00 m

Width of Bridge : BL 10.00 m

Width of Bridge Lines : BBL 2 x 3.5 m

Thickness of Wearing Surface : ta 0.05 m

Width of Sidewalk : bs 1.00 m

Thickness of Sidewalk : ts 0.25 m

Width of Berrier : bb 0.50 m

Heigth of Berrier : hb 1.25 m

1. Concrate Girder Material Data

Compressive Strength of Concrete at 28 Days : f`cg 50 MPa

Compressive Strength of Concrete During Stressing : f`cig 40 MPa

Modulus of Elasticity of Concrete at 28 Days : Ecg 33234.02 MPa

Modulus of Elastisity of Concrete During Stressing : Ecig 29725.41 MPa

Specific Gravity of Concrete : γc 25 kN/m3

2. Bridge Floor Slab Data

Compressive Strength of Concrete at 28 Days : f`cd 35 MPa

Compressive Strength of Concrete When First Loaded : f`cid 30 MPa

Modulus of Elasticity of Concrete at 28 Days : Ecd 27805.57 MPa

Modulus of Elasticity of Concrete When First Loaded : Ecid 25742.96 MPa

Specific Gravity of Concrete : γc 25 kN/m3

3. Pre-Stressed Steel Data

Type of Strand :

Pre-Stressed Steel Grade :

Diameter of Strand : Dps 12.70 mm

Cross-Sectional Area of Strand : Aps 98.71 mm2

Tensile Strength of  Pre-Stressed Steel : fpu 1860 MPa

Yield Strength of  Pre-Stressed Steel : fpy 1674 MPa

Modulus of Elasticity of Pre-Stressed Steel : Eps 197000 MPa

Jacking Force : fpbt 1395 MPa

4. Steel Reinforcement Data

Steel Reinforcement Grade (for D ≥ 13 mm) :

Yield Strength of Reinforcement Steel : fy 420 MPa

Tensile Strength of Reinforcement Steel : fu 525 MPa

Modulus of Elasticity of Reinforcement Steel : Es 200000 MPa

Steel Reinforcement Grade (for D < 13 mm) BJTP 24

Yield Strength of Reinforcement Steel : fy 240 MPa

Tensile Strength of Reinforcement Steel : fu 390 MPa

Modulus of Elasticityof Reinforcement Steel : Es 200000 MPa

BJTD 42

Seven Wire Strand, Low Relaxation

ASTM 416

=   [ 0.9 fpu ]

=   

=   [ 0.75 fpu ]

Data for Bridge Structure 

=   [ 4700 √ f'd  ]

=   [ 4700 √ f'id  ]

Bridge General Data
Dimension of Bridge

=   

=   

=   

=   

=   

=   

=   

=   

=   

=   

=   

=   

=   

Data for Bridge Superstructure

=   [ 4700 √ f'cg  ]

=   [ 4700 √ f'cig  ]

=   

=   

=   

=   

=   

=   

=   

=   

=   

=   



4. Elastomeric Bearing Pad Data

Length of Elastomer Bearing : 600 mm

Width of Elastomer Bearing : W 600 mm

Thickness of Elastomer Bearing : H 97 mm

Thickness Upper and Lower Elastromer Bearing : Hc 6 mm

Thickness of One Elastomer Layer : Hri 15 mm

Number of Elastomer Layer : Nri 4

Thickness of One Steel Reinforcement Layer : Hs 5 mm

Number of Steel Reinforcement : Ns 5

Shape Factor : S 10

Compressive Stiffness : SDc 1.56E+06 kN/m

Shear Stiffness : SDs 3.85E+03 kN/m

Allowable Compressive Strength : Pn 2930 kN

1. Soil Data

Specific Gravity of Soil : γsoil 18 kN/m3

Angle of Internal Friction : ϕ 30 °

Cohesion of Soil : C 1 kN/m2

2. Material Data

Compressive Strength of Concrete : f’c 30 MPa

Modulus of Elasticity of Concrete : Es 25742.96 MPa

Specific Gravity of Concrete : γc 24 kN/m3

Steel Reinforcement Grade :

Yield Strength of  Rainforcement Steel : fy 420 MPa

Tensile Strength of  Rainforcement Steel : fu 525 MPa

Modulus of Elasticity of Rainforment Steel : Es 200000 MPa

1. N-SPT Data of Soil

2. Material Data of the Foundation

Compressive Strength of Concrate : f’c 30 MPa

Modulus of Elasticity of Concrate : Es 25742.96 MPa

Specific Grafity of Concrate : γc 24 kN/m3

3. Dimension of the Foundation

Diameter of Foundation : f’c 0.80 m

Depth of Foundation : Es 15.00 m

=   

=   

=   

=   

=   

=   

Data for Bridge Substructure

=   

=   

=   

=   

BJTD 420

=   

=   

=   [ 4700 √ f'c  ]

=   

=   

L

=   

=   

=   

=   

=   

Data for Foundation





1. Preliminary Design 

Birdge Length : L 40 m

Minimum Height of Deck System : Hd 1800 mm

Type of Prestressed Girder : PCI-Girder 2100 mm

Spasi Antar Gelagar : Sg 2000 mm

Thickness of Floor Slab : ts 250 mm

Cantilevered Floor Slab Length : de 1000 mm

Number of Girder : ng 5 buah

Width of Highwey : Wt 7000 mm

Width of Sidewalk : Ws 1000 mm

Width of Berrier : Wb 500 mm

Thickness of Diaphram : td 200 mm

2. Cross-Section of Bridge

3. Non-Composite Cross Section of Girder

=   [ 0.045 L]

=   [ −300 ≤ 𝑑𝑒 ≤ 1700  ]

=   [ 1100 mm ≤ Sg ≤ 4900 mm ]

=   [ 110 mm ≤ Sg ≤ 300 mm ]

Preliminary Design of Bridge Superstructure

=   

=   

=   

=   

=   

=   



1. Dead Load from Self Weight (MS)

Load caused by the weight of the bridge structure itself

2. Additional Dead Load From Berrier and Sidewalk (MA1)

Material of Berrier and Sidewalk : Concrate

Specify Gravity of Material : γc 24 kN/m3

Cross-Sectional Area of Berrier and Sidewalk : ABS 0.65 m2

Load From Berrier and Sidewalk : L1 15.6 kN/m

3. Additional Dead Load From Wearing Surface (MA2)

Material of Wearing Surface : Asphalt

Specify Gravity of Material : γa 22 kN/m3

Thickness of Wearing Surface : ta 0.05 m

Load From Wearing Surface : L2 1.1 kN/m2

4. Line Load (TD)

Length of Bridge : L 40.00 m

Width of One Bridge Lines : BBL =   [ Initial Data  ] 3.50 m

Uniformly Distributed Load : BTR' 7.875 kN/m2

Concentrated Line Load : BGT' 49 kN/m

Dynamic Load Factor for Line Load FBDTD 1.4

Uniformly Distributed Load Inputted : BTR' 38.588 kN

Concentrated Line Load Inputted : BGT' 240.10 kN

=   [ 9 * ( 0.5  + ( 15 / L )) ]

=   [ SNI 1725-2016 ]

=   

= [ Initial Data ]

=   [ Initial Data ]

=   [ γc * ABS ]

Loading of Bridge Superstucture

= [ Approximate calculation ]

=   

=   [ γc * ta ]

=   [ SNI 1725-2016 ]

=   [ BGT * BBL * FBDBGT  ]

=   [ BTR * BBL * FBDBTR  ]



5. Truck Load (TD)

Dynamic Load Factor for Truck Load : FBDTT 1.3

6. Pedestrian Load (TP)

Pedestian Load : WTP 5.00 kN/m2

Width of Sidewalk : bs =   [ Initial Data  ] 1.00 m

Distance Between Nodes : Dn =   [ Midas Modeling  ] 2.00 m

Point Load on the Central Node : P1 =   [ WTP * bs * Dn  ] 10 kN

Point Load on the Edge Node : P2 =   [ 0.5 * P1  ] 5 kN

7. Wind Load on Structure (EWL)

Upstream Surface Conditions : Open Field

Wind Friction Speed : Vo 13.2 km/H

Length of Friction Upstream of the Bridge : Zo 70 mm

Elevation of Structures above Ground : Z 9000 mm

Wind Speed Design of 10000 mm above Ground : VB 90 Km/H

Wind Speed at an Elevation of 10000 mm above Ground : V10 90 Km/H

Base Wind Preasure : PB 0.0024 MPa

Wind Speed Design : VDZ 160.264 Km/H

Wind Load on Structures : EWL 7.610 Km/H

=   [ SNI 1725-2016 ]

=   [ SNI 1725-2016 ]

=   [ Input ]

=   

=   [ SNI 1725-2016 ]

=   [ SNI 1725-2016 ]

=   [ PB * (VDZ / VB)2  ]

=   [ SNI 1725-2016 ]

=   [ 2.5 * Vo *( V10/VB) * ln(Z/Zo)  ]



8. Earthquake Load (From Aplikasi Lini)

Peak Ground Acceleration : GPA 0.476 m/s2

Spectral Response Acceleration at Short Period : SS =   [ Aplikasi Lini ] 1.073 m/s2

Spectral Response Acceleration at 1-Second Period : S1 =   [ Aplikasi Lini ] 0.454 m/s2

1. PCI-Girder Data (Non-Composite Girder)

Cross-Sectional Area : Ag 835250 mm2

Momen of Inertia : Ig 4.40E+11 mm4

Hight of Girder : hg 2100 mm

Distance from the Neutral Axis to the Bottom Fiber : yb 1034.164 mm

Distance from the Neutral Axis to the Top Fiber : ya 1065.836 mm

Section Modulus of the Bottom Fiber : Sb 4.252E+08 mm3

Section Modulus of the Top Fiber : Sa 4.125E+08 mm3

2. Tensile Stress at Bottom Fiber at  Combination of Service III (Calculation Result of Midas CIvil 2022)

Tensile Stress at Bottom Fiber : fbserv 20.752 MPa

3. Calculating the Active Prestressed Force

Allowable Stress Under Service Load Conditions : fallserv 3.536 MPa

Tensile Stress Required at The Bottom Fiber : fpb 17.216 MPa

Distance From The Center of Prestress to 
The Bottom Fiber

: ybs 210 mm

Eccentricity at The Mid-Span : ec 824.164 mm

Active Prestressed Force : Pe 5490.584 kN

4. Counting the Number of Strands

Loss of Pretension Force (T.Y Lin) : losses 20 %

Final Prestressing Force per Strand : Pe_strand 110.160 kN

Number of Strands Required : Nstr_req 50 Strand

Number of Strands Used : Nstr 57 Strand

Number of Tendon Used : N 3 Tendon

≥ [ Nstr_req ]

=   [ (fpb*Ag*Sb) / (Sb + ec *Ag  ]

=   

= [ Calculation Result of Midas CIvil 2022 ]

= [ Calculation Result of Midas CIvil 2022 ]

Approximate Prestressing Force and Determination of The Number of Tendon

Bridge Superstucture Analysis with Midas Civil 2022

=  [ fallserv - fbserv ]

= [ Calculation Result of Midas CIvil 2022 ]

= [ Calculation Result of Midas CIvil 2022 ]

=   [ hg - yb ]

=   [ Ig / yb ]

=   [ Ig / ya ]

=  [ Aps.fpbt (1 - losses]

=   [ Pe / Pe_strand ]

=   [ yb - ybs  ]

=   [ Aplikasi Lini ]

= [ Calculation Result of Midas CIvil 2022 ]

=   [ 0.1 hg  ]

=   [ 0.5 √ fc'  ]



5. Position of Tendon

1. Flexure Reinforcement of Edge PCI-Girder (Just Need Minimum Reinforcement)

Diameter of Rebar : Ds 13 mm

Area of Rebar : As 132.732 mm2

Cross-Sectional Area : Ag 1320300 mm2

Reinforcement Area Required : As_req 5281.200 mm2

Number of Rebar Required : N 39.788

Number of Rebar Used :

1. Flexure Reinforcement of Middle PCI-Girder (Just Need Minimum Reinforcement)

Diameter of Rebar : Ds 13 mm

Area of Rebar : As 132.732 mm2

Cross-Sectional Area : Ag 825550 mm2

Reinforcement Area : As_req 3302.200 mm2

Number of Rebar Required : N 24.879 buah

Number of Rebar Used :

2. Shear Reinforcement of Prestressed Beam (Trial and Error in Midas Civil 2022)

Diameter of Rebar : Dv 13 mm

Number of Rebar : nv 2

Area of Shear Reinforcement : Av = [ (1/4) * π * dv
2 * nv ] 265.465 mm2

Specing of Field Reinforcement :

Specing of Support Reinforcement :

D13-200

Inspection of Prestressed Concrete Designs Using Midas Civil 2022

=  

= [ (1/4) π Ds2 ]

Calculation of Bridge Superstructure Reinforcement

=  

=  

26D13

D13-100

Reinforcement Calculation of Prestressed Girder (PCI-Girder)

= [ Midas Civil Calculation ]

= [ 0.4% Ag ]

= [ As_req / As ]

40D13

= [ Midas Civil Calculation ]

= [ 0.4% Ag ]

= [ As_req / As ]

=  

= [ (1/4) π Ds2 ]



1. General Data of Floor Slabs

Effective Width of Floor Slabs : b 2000 mm

Thickness of Floor Slab : ts 250.000 mm

Concrete Grade : fc' 30.000 MPa

Yield Strength of  Rainforcement Steel (D ≥ 13) : fy 420 MPa

Yield Strength of  Rainforcement Steel (D < 13) : fy 240 MPa

Concrete Cover : cd 30 mm

2. Flexure Reinforcement of Floor Slab

Diameter of Rebar : Df 16 mm

Flexural Reduction Factor : ϕf 0.9

Momen Ultimate : Mu 138.005 kN.m

Effective Thickness of the Floor Slab : de = [ h - dc -0.5D ] 212 mm

Concrete Stress Distribution Shape Factor : b1       0.85

Reinforcement Ratio in Balance Condition : rb       0.03035714 kN.m

Maximum Moment Resistance Factor : Rnmax 7.76953125 kN/m2

Nominal Moment (Planned Moment) : Mn 153.339 mm2

Moment Resistance Factor : Rn 1.706 kN/m2

Rn < Rnmax OK!

Required Reinforcement Ratios : r 0.0042

Minimum Reinforcement Ratio : rmin    0.0033

Reinforcement Ratio Used : r 0.0042

Required Reinforcement Area : As 1784 mm2

Maximum Spacing of Flexure Reinforcement : Smax 225 mm

Spacing of Flexure Reinforcement Used : S 100 mm

Longitudinal Flexure Reinforcement Used : D16 - 100

3. Transverse Reinforcement of Floor Slab

Diameter of Rebar : Dv 13 mm

Reinforcement Percentage : Pt =  [ Min (110/√S, 67%] 67 %

Minimum Area of Transverse Reinforcement : As_req =  [ (As_req * Pt) ] 1195.245 mm2

Maximum Spacing of Transverse Reinforcement : Smax 222.101 mm

Spacing of Flexure Reinforcement Used : S 100 mm

Specing of Transverse Reinforcement Used :

Reinforcement Calculation of Bridge Floor Slab 

=  [  Input  ]

= [ Initial Data  ]

=   [ Input ]

= [ b1* 0.85 * fc'/ fy * 600 / ( 600 + fy ) ]

= [ 0.75*rb*fy*(1–½*0.75*rb*fy/(0.85*fc') ]

= [ Input ]

= [ (1/4) * π * D2 * b / As ]

=  

= [ fc'  >  30 MPa ]

= [ Midas Civil Calculation ]

= [ Initial Data  ]

= [ Initial Data  ]

= [ Initial Data  ]

=  

= [ Mu / f ]

= [ r * b * de]

= [ Initial Data  ]

D13 - 100

=  [ (b * (1/4) * π * D2)/ As_req ]

= [ Mn * 106 / ( b * de2 ) ]

= [ 0.85*fc'/fy*(1-√[ 1 – 2 * Rn/( 0.85*fc' )) ]

= [ 1.4 / fy ]

= [ min (r , r min) ]



1. General Data of Diaphragm

Height of Diaphragm : h 1280 mm

Thickness of Diaphragm : t 200

Concrete Grade : fc' 30 MPa

Yield Strength of  Rainforcement Steel (D ≥ 13) : fy 420 MPa

Yield Strength of  Rainforcement Steel (D < 13) : fy 240 MPa

Concrete Cover : dc 30 mm

2. Flexure Reinforcement of Diaphragm

Diameter of Rebar : Df 13 mm

Flexural Reduction Factor : ϕf 0.90

Ultimate Moment : Mu 4.56 kN.m

Effective Thickness of the Floor Slab : de 163.5 mm

Concrete Stress Distribution Shape Factor : b1       0.85

Reinforcement Ratio in Balance Condition : rb       0.03035714 kN.m

Maximum Moment Resistance Factor : Rnmax 7.76953125 kN/m2

Nominal Moment (Planned Moment) : Mn 5.067 mm2

Moment Resistance Factor : Rn 0.948 kN/m2

Rn < Rnmax OK!

Required Reinforcement Ratios : r 0.0023

Minimum Reinforcement Ratio : rmin    0.0033

Reinforcement Ratio Used : r 0.0033

Required Reinforcement Area : As 698 mm2

Maximum Spacing of Flexure Reinforcement : Smax 244 mm

Spacing of Flexure Reinforcement Used : S 200 mm

Longitudinal Flexure Reinforcement Used : D13 - 200

3. Shear Reinforcement of Diaphragm

Diameter of Rebar : Dv 10 mm

Shear Reduction Factor ϕv 0.75

Ultimate Shear Force : Vu 11.693 kN

Effective Thickness of the Pilecap : de 152 mm

Concrete Shear Strength : Vc = [ (1/6) √(f'c Mpa) de h ] 191.045628 mm2

Smallest Factored Shear Force : = [ 0.5 ϕv Vc ] 71.6421105

Check Concrete Shear Value :

:

Shear Reinforcement Used :

= [ t - dc -0.5Df ]

No need for shear reinforcement, only need 
practical reinforcement

= [ (1/4) * π * D2 * h / As ]

= [ Initial Data  ]

= [  Input  ]

= [ t- dc - Df - 0.5Dv ]

Reinforcement Calculation of Bridge Diaphragm

= [ SNI 2847-2019 ]

= [  Input  ]

D10 - 200

= [ Initial Data  ]

= [ Midas Civil Calculation ]

Vu < 0.5 ϕv Vc

= [ Initial Data  ]

= [  Input  ]

= [ Midas Civil Calculation ]

= [ SNI 2847-2019 ]

= [ fc'  >  30 MPa ]

= [ b1* 0.85 * fc'/ fy * 600 / ( 600 + fy ) ]

= [ 0.75*rb*fy*(1–½*0.75*rb*fy/(0.85*fc') ]

= [ Mu / f ]

= [ Mn * 106 / ( h * de2 ) ]

= [ 0.85*fc'/fy*(1-√[ 1 – 2 * Rn/( 0.85*fc' )) ]

= [ 1.4 / fy ]

= [ min (r , r min) ]

= [ r * h * de]

= [ Initial Data  ]

= [ Initial Data  ]



1. General Data of Deck Slab

Effective Width of Deck Slabs : b 1360 mm

Thickness of Deck Slab : ts 70.000 mm

Concrete Grade : fc' 30.000 MPa

Yield Strength of  Rainforcement Steel (D ≥ 13) : fy 420 MPa

Yield Strength of  Rainforcement Steel (D < 13) : fy 240 MPa

Momen Ultimate : Mu 0.39 kN.m

Flexural Reduction Factor : ϕf 0.9

Concrete Cover : cd 30 mm

2. Flexure Reinforcement of Floor Slab

Diameter of Rebar : Df 10 mm

Effective Thickness of the Deck Slab : de = [ h - dc -0.5D ] 35 mm

Concrete Stress Distribution Shape Factor : b1       0.85

Reinforcement Ratio in Balance Condition : rb       0.06450893 kN.m

Maximum Moment Resistance Factor : Rnmax 8.96789302 kN/m2

Nominal Moment (Planned Moment) : Mn 0.428 mm2

Moment Resistance Factor : Rn 0.257 kN/m2

Rn < Rnmax OK!

Required Reinforcement Ratios : r 0.0011

Minimum Reinforcement Ratio : rmin    0.0058

Reinforcement Ratio Used : r 0.0058

Required Reinforcement Area : As 278 mm2

Maximum Spacing of Flexure Reinforcement : Smax 385 mm

Spacing of Flexure Reinforcement Used : S 200 mm

Longitudinal Flexure Reinforcement Used :

3. Transverse Reinforcement of Floor Slab

Diameter of Rebar : Dv 10 mm

Reinforcement Percentage : Pt =  [ Min (110/√S, 67%] 67 %

Minimum Area of Transverse Reinforcement : As_reqp =  [ (As_req * Pt) ] 186.037 mm2

Maximum Spacing of Transverse Reinforcement : Smax 574.156 mm

Spacing of Flexure Reinforcement Used : S 300 mm

Specing of Transverse Reinforcement Used :

= [ 0.85*fc'/fy*(1-√[ 1 – 2 * Rn/( 0.85*fc' )) ]

D10 - 200

D10 - 300

=   [ Initial Data  ]

= [ Mu / f ]

=   [ Initial Data  ]

=   [  Input  ]

Reinforcement Calculation of Deck Slab

=   [ Initial Data  ]

= [ Midas Civil Calculation ]

= [ Mn * 106 / ( b * de2 ) ]

= [ 1.4 / fy ]

= [ min (r , r min) ]

= [ r * b * de]

= [ (1/4) * π * D2 * b / As ]

=  [  Input  ]

=  [ (b * (1/4) * π * D2)/ As_req ]

= [ b1* 0.85 * fc'/ fy * 600 / ( 600 + fy ) ]

= [ 0.75*rb*fy*(1–½*0.75*rb*fy/(0.85*fc') ]

=   [  Input  ]

= [ fc'  >  30 MPa ]

=   [ Initial Data  ]

=   [ Initial Data  ]



1. General Data of Substructure and Foundation

Hight of Abudment Required : Pu 9 m

Types of Abutments Used : Reverse T-Type Abutment

Types of Foundations Used : Pile Foundation

Diamater of the Foundation : D 0.80 m

Depth of Pile : H 15 m

Number of Pile : n 10 Pieces

2. Dimension of Bridge Substructure 

3. Dimension of Foundation

Preliminary Design of Substructure and Foundation

Side View of Substructure Back View of Substructure



1. Loads from Superstructure Reaction

Self-Weight of the Superstructure : MS 721.560 kN

Berrier and Sidewalk Load : MA 162.978 kN

Wearing Surface load : MA(uty) 38.733 kN

Pedestrian Load : TP 48.854 kN

Line Load : TD 432.668 kN

Truck Load : TT 393.998 kN

2. Load due to Active Ground Pressure

Specific Gravity of Soil : γsoil 18 kN/m3

Angle of Internal Friction : ϕ 30 MPa

Cohesion of Soil : C 1 kN/m2

Active Earth Pressure Coefficient : Ka 0.333

Active Ground Pressure for Depth 0 m : PA1 0.000 kN

Active Ground Pressure for Depth 2.45 m : PA2 7.350 kN

Active Ground Pressure for Depth 6 m : PA3 18.000 kN

Active Ground Pressure for Depth 7.5 m : PA4 22.500 kN

3. Vertical Springs for the Soils Adjacent to Piles

For Depths 0 - 6 m

Soil Type :

Diameter of Pile : D 0.80 m

Unit Weight of Soil : γsoil 18.00 kN/m3

Internal Friction Angle : ϕ 32 °

Coeff. of Subgrade Reaction : Ko 0.47

Coeff. of Subgrade Reaction : Kh =  [ Table 3.12 (Terzaghi).] 1.086 kN/m3

For Depths 6 - 30 m

Soil Type :

Diameter of Pile : D 0.80 m

Unit Weight of Soil : γsoil 22.00 kN/m3

Internal Friction Angle : ϕ 40 °

Coeff. of Subgrade Reaction : Ko 0.36

Coeff. of Subgrade Reaction : Kh =  [ Table 3.12 (Terzaghi).] 10.857 kN/m3

=  [ 1- Sin(ϕ) ]

=  [ 1- Sin(ϕ) ]

Bridge Substucture and Foundation Analysis with Midas Civil 2022

Dense Sand

= [ Midas Civil Calculation ]

= [ Midas Civil Calculation ]

= [ Midas Civil Calculation ]

=  [ (1/2) D * γsoil  * Ka ]

Loose Sand

=  [ Tan2(45° - (ϕ/2)) ]

=  [ (1/2) D * γsoil  * Ka ]

=  [ (1/2) D * γsoil  * Ka ]

=  [ (1/2) D * γsoil  * Ka ]

Loading of Bridge Substucture and Foundation

= [ Midas Civil Calculation ]

= [ Midas Civil Calculation ]

= [ Midas Civil Calculation ]



1. Control of Abutment Stability Againts Tipping (Rolling)

Vertical Moment : Mv 699.099 kN.m

Horizontal Moment : Mh 332.053 kN.m

Factor of Safety : SoF 2

Factor of Safety For Tipping : Soft =  [ Mv/Mh ] 2.105

Control =  [ SoFt > SoF ] OK!

2. Control of Abutment Stability Againts Shearing

Angle of Internal Friction : ϕ =  30 °

Cohesion of Soil : C =  1 kN/m2

Area of Abutment Base : A =  [ P . L ] 50 m2

Vertical Force : V 1595.589 kN

Horizontal Force : H 325.934 kN

Factor of Safety : SoF 1.5

Factor of Safety For Shear : Sofx =  [ ((C * A) + (V * tan ϕ)) / Hx ] 2.97978652

Control =  [ SoFx > SoF ] OK!

1. Soil Parameters

N-SPT for Depth 0 - 6 m : N1 10

N-SPT for Depth 6 - 15 m : N2 50

Soil Specific Gravity for Depth 0 - 6 m : γ1 18 kN/m3

Soil Specific Gravity for Depth 6 - 15 m : γ2 22 kN/m3

Safety of Factor : SoF 2.5

Length of Pile : H 15 m

Pile Length at Depth 0 - 6 m : H1 6 m

Pile Length at Depth 6 - 15 m : H2 9 m

Diameter of Pile : D 0.8 m

Lateral Surface Area for Depth 0 - 6 m : AS1 =  [ π * D * H1 ] 15.080 mm2

Lateral Surface Area for Depth 6 - 15 m : AS2 =  [ π * D * H2 ] 22.619 mm2

Pile Area Tip : At =  [ (1/4) * π * D2  ] 0.503 mm2

1. Foundation Data

Length of Pile : fS1 =  [ 2 * N1 < 100 kPa  ] 20 kPa

Pile Length at Depth 0 - 6 m : fS2 100 kPa

Pile Length at Depth 6 - 15 m : qt 10000 kPa

Ultimate Skin Friction at Depth 0 - 6 m : RS1 301.593 kN

Ultimate Skin Friction at Depth 6 - 15 m : RS2 2261.947 kN

Ultimate End Bearing : Rt 5026.548 kN

Ultimate Pile Capacity : Qu 7590.088 kN

Allowable Load : Qa 3036.035 kN

Structure Axial Load : Pu 1886.38 kN

Control : Qa > Pu OK

=  [ 2 * N2 < 100 kPa  ]

=  [ (40 * N2 kPA * H) / D  ]

=  [ fS1 *AS1  ]

=  [ fS2 *AS2  ]

=  [ qt * At  ]

=  [ RS1 + RS2 + Rt  ]

=  [ Qu / SoF  ]

Stability of Abutment and Bearing Capacity of Foundation
Stability of Abutment 

= [ Midas Civil Calculation ]

= [ Midas Civil Calculation ]

Bearing Capacity of Foundation

= [ Initial Data ]

=

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Preliminary Design ]

= [ Preliminary Design ]

= [ Preliminary Design ]

= [ Preliminary Design ]

= [ Midas Civil Calculation ]

= [ Midas Civil Calculation ]



1. General Data of Breastwall

Height of Breastwall : h 1200 mm

Longitudinal Width of Breastwall : bx 10000 mm

Transversal Width of Breastwall : by 5050 mm

Concrete Grade : fc' 30 MPa

Yield Strength of  Rainforcement Steel (D ≥ 13) : fy 420 MPa

Yield Strength of  Rainforcement Steel (D < 13) : fy 240 MPa

Concrete Cover : dc 50 mm

2. Axial - Flexure Reinforcement 

Diameter of Flexure Rebar : Db 25 mm

Ultimate Moment Mux 699.099 kN.m

Ultimate Moment Muy 332.053 kN.m

Ultimate Axial Force Pu 1595.589 kN

Spacing of Rebar : S 150 mm

Number of Reinforcement : n 67

Reinforcement Area : As 65777.096 mm2

Cross-Sectional Area : Ag 12000000 mm2

Reinforcement Ratios : r   0.548 %

Minimum Reinforcement Ratio : rmin    0.500 %

Check Minimum Reinforcement Ratio rmin > r OK

Axial-Flexure  Reinforcement Used :  D 25 - 150

D25 - 150

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Midas Civil Calculation ]

= [ Midas Civil Calculation ]

= [ Initial Data ]

Calculation of Bridge Substructure Reinforcement
Reinforcement Calculation of Breastwall

The combination of Pu and Mu loads in the interaction diagram indicates that the Breastwall section can carry the loads that 
occur. The interaction diagram above is an interaction diagram of the abutment cross section using the main reinforcement 

= [ Initial Data ]

= [ Initial Data ]

= [ Input ]

= [ Input ]

= [ Input ]

= [ n * (1/4) * π *Db2 ]

= [ bx * by ]

= [ As / Ag ]

= [ bx / s ]

= [ Midas Civil Calculation ]



3. Transverse Reinforcement

Diameter of Flexure Rebar : D 16 mm

Concrete Density Modification Factors : λ = 1

Indication Factor : β = 2

Reduction Factor : ϕv 0.75

Ultimate Shear Force : Vu 316.681 kN.m

Evaluated Over a 1-Meter Distance : b' = 1000 mm

Effective Thickness of the Breastwall : de 1142 mm

Concrete Shear Strength : Vc = [ 0.083 * β * √(f'c Mpa) *b *de ] 10383.2861 kN

 : = [ 0.5 ϕv Vc ] 3893.73228

Check Concrete Shear Value :

:

Minimum Shear Reinforcement Area : Av_min = [ (0.083*λ*√(f'c Mpa)*b*b') / fy  ] 10824.041 mm2

Attempted Reinforcement Distance : S 150 mm

Reinforcement Area Used : Av_use = [  (1/4) * π * D2 * b / S ] 13404.1287 mm2

Control Reinforcement Area : OK!

Shear Reinforcement Used :

4. Shear Reinforcement

Diameter of Flexure Rebar : D 16 mm

Concrete Density Modification Factors : λ = 1

Indication Factor : β = 2

Reduction Factor : ϕv 0.75

Ultimate Shear Force : Vu 316.681 kN.m

Evaluated Over a 1-Meter Distance : b' = 1000 mm

Effective Thickness of the Breastwall : de 1142 mm

Concrete Shear Strength : Vc = [ 0.083 * β * √(f'c Mpa) *b *de ] 5191.64303 mm2

Smallest Factored Shear Force : = [ 0.5 * ϕv * Vc ] 1946.86614

Check Concrete Shear Value :

:

Spasing of Shear Reinforcement Y Direction Used : Sy 600 mm

Shear Reinforcement Strength : Vs = [ (Vu / ϕv) - Vc ] -4769.4017 kN

Shear Reinforcement Area Required : Av1 -99437.113 mm2

Minimum Shear Reinforcement Area : Av_min = [ (0.083*λ*√(f'c Mpa)*b*b') / fy  ] 10824.041 mm2

Shear Reinforcement Area Used : Av = [  Max ( Av1, Av_min)  ] 10824.041 mm2

Maximum Spacing od Shear Reinforcement : Sx_max = [ (b*s*(1/4)*π*D2) / (Av*Sy) ] 309.591599 mm

Spasing of Shear Reinforcement X Direction Used : Sx 300 mm

Shear Reinforcement Used :

= [ SNI 2847-2019 ]

= [ SNI 2847-2019 ]

= [ Midas Civil Calculation ]

Vu < 0.5 * ϕv * Vc

Use Minimum Shear Reinforcement

= [ ( Vs * b ) / (  fy * de )  ]

= [ Midas Civil Calculation ]

= [ h - dc -0.5D ]

= [ Input ]

= [ Input ]

D16 - 300/600

= [ h - dc -0.5D ]

Vu < 0.5 ϕv Vc

D16 - 150

Use Minimum Shear Reinforcement

Av_use > Av_min



1. General Data of Backwall

Height of Backwall : h 700 mm

Longitudinal Width of Backwall : bx 10000 mm

Transversal Width of Backwall : by 2400 mm

Concrete Grade : fc' 30 MPa

Yield Strength of  Rainforcement Steel (D ≥ 13) : fy 420 MPa

Concrete Cover : dc 50 mm

2. Lingitudinal Flexure Reinforcement

Diameter of Flexure Rebar : D = [ Input  ] 19 mm

Flexure Reduction Factor : ϕf 0.9

Ultmate Moment : Mu 360.989 kN.m

Evaluated Over a 1-Meter Distance : b' = 1000 mm

Effective Thickness of the Backwall : de 640.5 mm

Concrete Stress Distribution Shape Factor : b1       0.85

Reinforcement Ratio in Balance Condition : rb       0.03035714

Maximum Moment Resistance Factor : Rnmax 7.76953125 kN/m2

Nominal Moment (Planned Moment) : Mn 401.099 kN.m

Moment Resistance Factor : Rn 0.978 kN/m2

Rn < Rnmax OK!

Required Reinforcement Ratios : r 0.0024

Minimum Reinforcement Ratio : rmin    0.0012

Reinforcement Ratio Used : r 0.0024

Required Reinforcement Area : As 1521 mm2

Maximum Spacing of Flexure Reinforcement : Smax 186 mm

Spacing of Flexure Reinforcement Used : S v 150 mm

Longitudinal Flexure Reinforcement Used : D19 - 150

3. Transverse Flexure Reinforcement

Diameter of Flexure Rebar : D 13 mm

Required Reinforcement Area : As' 760 mm2

Maximum Spacing of Flexure Reinforcement : S'max 175 mm

Spacing of Flexure Reinforcement Used : S' 150 mm

Longitudinal Flexure Reinforcement Used : D13 - 150

4. Shear Reinforcement

Diameter of Flexure Rebar : Dv 13 mm

Concrete Density Modification Factors : λ 1

Shear Reduction Factor : ϕv 0.75

Ultimate Shear Force : Vu 241.336 kN

Evaluated Over a 1-Meter Distance : b' = 1000 mm

Effective Thickness of the Backwall : de 643.5 mm

Concrete Shear Strength : Vc = [ (1/6) √(f'c Mpa) de b ] 5874.32443 kN

Smallest Factored Shear Force : = [ 0.5 ϕv Vc ] 2202.87166 kN

Check Concrete Shear Value :

:

Spasing of Shear Reinforcement Y Direction Used : Sy =  400 mm

Shear Reinforcement Strength : Vs =  [ (Vu / ϕv) - Vc ] -5552.5431 kN

Shear Reinforcement Area Required : Av1 -205444.3 mm2

Minimum Shear Reinforcement Area : Av_min = [ (0.083*λ*√(f'c Mpa)*b*b') / fy  ] 10824.041 mm2

Shear Reinforcement Area Used : Av = [  Max ( Av1, Av_min)  ] 10824.041 mm2

Maximum Spacing od Shear Reinforcement : Sx_max = [ (b*b'*(1/4)*π*D2) / (Av*Sy) ] 306.568243 mm

Spasing of Shear Reinforcement X Direction Used : Sx =  300 mm

Shear Reinforcement Used :

= [ Initial Data ]

= [ fc'  >  30 MPa ]

=   [  Input  ]

= [ Initial Data ]

= [ b1* 0.85 * fc'/ fy * 600 / ( 600 + fy ) ]

= [ 0.75*rb*fy*(1–½*0.75*rb*fy/(0.85*fc') ]

= [ Mu / f ]

= [ Initial Data ]

= [ Input  ]

= [ h - dc -0.5D ]

= [ Midas Civil Calculation ]

D13 - 300/400

= [ Mn * 106 / ( b' * de2 ) ]

= [ 0.85*fc'/fy*(1-√[ 1 – 2 * Rn/( 0.85*fc' )) ]

= [ 0.5 / fy ]

Reinforcement Calculation of Backwall

= [ r * b' * de]

= [ Midas Civil Calculation ]

= [ min (r , r min) ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ SNI 2847-2019 ]

= [ 50% * As]

= [ (1/4) * π * D2 * b / As ]

= [ h - dc - 0.5Dv ]

Vu < 0.5 ϕv Vc

Use Minimum Shear Reinforcement

= [ ( Vs * b ) / (  fy * de )  ]

= [ (1/4) * π * D2 * b' / As ]

= [ SNI 2847-2019 ]



1. General Data of Wingwall

Height of Wingwall : h 400 mm

Longitudinal Width of Wingwall : bx 7500 mm

Transversal Width of Wingwall : by 4400 mm

Concrete Grade : fc' 30 MPa

Yield Strength of  Rainforcement Steel (D ≥ 13) : fy 420 MPa

Yield Strength of  Rainforcement Steel (D < 13) : fy 240 MPa

Concrete Cover : dc 50 mm

2. Lingitudinal Flexure Reinforcement

Diameter of Flexure Rebar : D 16 mm

Flexure Reduction Factor : ϕf 0.9

Ultmate Moment : Mu 132.427 kN.m

Evaluated Over a 1-Meter Distance : b' 1000 mm

Effective Thickness of the Wingwall : de 342 mm

Concrete Stress Distribution Shape Factor : b1       0.85

Reinforcement Ratio in Balance Condition : rb       0.03035714

Maximum Moment Resistance Factor : Rnmax 7.76953125 kN/m2

Nominal Moment (Planned Moment) : Mn 147.141 kN.m

Moment Resistance Factor : Rn 1.258 kN/m2

Rn < Rnmax OK!

Required Reinforcement Ratios : r 0.0031

Minimum Reinforcement Ratio : rmin    0.0012

Reinforcement Ratio Used : r 0.0031

Required Reinforcement Area : As 1051 mm2

Maximum Spacing of Flexure Reinforcement : Smax 191 mm

Spacing of Flexure Reinforcement Used : S 150 mm

Longitudinal Flexure Reinforcement Used : D16 - 150

3. Transverse Flexure Reinforcement

Diameter of Flexure Rebar : D 13 mm

Required Reinforcement Area : As' 525 mm2

Maximum Spacing of Flexure Reinforcement : S'max 253 mm

Spacing of Flexure Reinforcement Used : S' 150 mm

Longitudinal Flexure Reinforcement Used : D13 - 150

4. Shear Reinforcement

Diameter of Flexure Rebar : Dv 13 mm

Concrete Density Modification Factors : λ 1

Shear Reduction Factor : ϕv 0.75

Ultimate Shear Force : Vu 110.527 kN

Evaluated Over a 1-Meter Distance : b' = 1000 mm

Effective Thickness of the Wingwall : de 343.5 mm

Concrete Shear Strength : Vc = [ (1/6) √(f'c Mpa) de b ] 2351.78373 kN

Smallest Factored Shear Force : = [ 0.5 ϕv Vc ] 881.918899 kN

Check Concrete Shear Value :

:

Spasing of Shear Reinforcement Y Direction Used : Sy =  400 mm

Shear Reinforcement Strength : Vs =  [ (Vu / ϕv) - Vc ] -2204.4144 kN

Shear Reinforcement Area Required : Av1 -114598.38 mm2

Minimum Shear Reinforcement Area : Av_min = [ (0.083*λ*√(f'c Mpa)*b*b') / fy  ] 897.261586 mm2

Shear Reinforcement Area Used : Av = [  Max ( Av1, Av_min)  ] 897.261586 mm2

Maximum Spacing of Shear Reinforcement : Sx_max = [ (b*b'*(1/4)*π*D2) / (Av*Sy) ] 306.568243 mm

Spasing of Shear Reinforcement X Direction Used : Sx =  300 mm

Shear Reinforcement Used : D13 - 300/400

= [ ( Vs * b ) / (  fy * de )  ]

=

= [ r * b' * de]

= [ (1/4) * π * D2 * b' / As ]

=   [  Input  ]

= [ 50% * As]

= [ (1/4) * π * D2 * b / As ]

= [ Input  ]

= [ fc'  >  30 MPa ]

= [ Midas Civil Calculation ]

= [ SNI 2847-2019 ]

= [ SNI 2847-2019 ]

= [  Input  ]

= [  Input  ]

= 

= [ h - dc -0.5D ]

= [ b1* 0.85 * fc'/ fy * 600 / ( 600 + fy ) ]

= [ 0.75*rb*fy*(1–½*0.75*rb*fy/(0.85*fc') ]

= [ Mu / f ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

Reinforcement Calculation of Wingwall

Use Minimum Shear Reinforcement

= [ Initial Data ]

= [ h - dc - 0.5Dv ]

= [ Mn * 106 / ( b' * de2 ) ]

= [ 0.85*fc'/fy*(1-√[ 1 – 2 * Rn/( 0.85*fc' )) ]

= [ 0.5 / fy ]

= [ min (r , r min) ]

= [ Midas Civil Calculation ]

Vu < 0.5 ϕv Vc



1. General Data of Approch Slab

Height of Approch Slab : h 300 mm

Longitudinal Width of Approch Slab : bx 10000 mm

Transversal Width of Approch Slab : by 3700 mm

Concrete Grade : fc' 30 MPa

Yield Strength of  Rainforcement Steel (D ≥ 13) : fy 420 MPa

Yield Strength of  Rainforcement Steel (D < 13) : fy 240 MPa

Concrete Cover : dc 50 mm

2. Lingitudinal Flexure Reinforcement

Diameter of Flexure Rebar : D 16 mm

Flexure Reduction Factor : ϕf 0.9

Ultmate Moment : Mu 79.311 kN.m

Evaluated Over a 1-Meter Distance : b' 1000 mm

Effective Thickness of the Approch Slab : de 242 mm

Concrete Stress Distribution Shape Factor : b1       0.85

Reinforcement Ratio in Balance Condition : rb       0.03035714

Maximum Moment Resistance Factor : Rnmax 7.76953125 kN/m2

Nominal Moment (Planned Moment) : Mn 88.123 kN.m

Moment Resistance Factor : Rn 1.505 kN/m2

Rn < Rnmax OK!

Required Reinforcement Ratios : r 0.0037

Minimum Reinforcement Ratio : rmin    0.0033

Reinforcement Ratio Used : r 0.0037

Required Reinforcement Area : As 894 mm2

Maximum Spacing of Flexure Reinforcement : Smax 225 mm

Spacing of Flexure Reinforcement Used : S 200 mm

Longitudinal Flexure Reinforcement Used : D16 - 200

3. Transverse Flexure Reinforcement

Diameter of Flexure Rebar : D 13 mm

Required Reinforcement Area : As' 447 mm2

Maximum Spacing of Flexure Reinforcement : S'max 297 mm

Spacing of Flexure Reinforcement Used : S' 200 mm

Longitudinal Flexure Reinforcement Used : D13 - 200

4. Shear Reinforcement

Diameter of Flexure Rebar : Dv 13 mm

Concrete Density Modification Factors : λ 1

Shear Reduction Factor : ϕv 0.75

Ultimate Shear Force : Vu 61.36 kN

Evaluated Over a 1-Meter Distance : b' = 1000 mm

Effective Thickness of the Approch Slab : de 243.5 mm

Ultimate Shear Force : Vu 61.36 kN

Concrete Shear Strength : Vc = [ (1/6) √(f'c Mpa) de b ] 2222.84071 kN

Smallest Factored Shear Force : = [ 0.5 ϕv Vc ] 833.565267 kN

Check Concrete Shear Value :

:

Spasing of Shear Reinforcement Y Direction Used : Sy =  400 mm

Shear Reinforcement Strength : Vs =  [ (Vu / ϕv) - Vc ] -2141.0274 kN

Shear Reinforcement Area Required : Av1 -209350.48 mm2

Minimum Shear Reinforcement Area : Av_min = [ (0.083*λ*√(f'c Mpa)*b*b') / fy  ] 10824.041 mm2

Shear Reinforcement Area Used : Av = [  Max ( Av1, Av_min)  ] 10824.041 mm2

Maximum Spacing of Shear Reinforcement : Sx_max = [ (b*b'*(1/4)*π*D2) / (Av*Sy) ] 306.568243 mm

Spasing of Shear Reinforcement X Direction Used : Sx =  300 mm

Shear Reinforcement Used :

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Midas Civil Calculation ]

= 

= [  Input  ]

= [ Midas Civil Calculation ]

= [ SNI 2847-2019 ]

= [ SNI 2847-2019 ]

= [ Input ]

= [ Input ]

= [ h - dc -0.5D ]

= 

= [ b1* 0.85 * fc'/ fy * 600 / ( 600 + fy ) ]

Use Minimum Shear Reinforcement

= [ ( Vs * b ) / (  fy * de )  ]

D13 - 300/400

= [ Initial Data ]

= [ 0.75*rb*fy*(1–½*0.75*rb*fy/(0.85*fc') ]

= [ Mu / f ]

= [ Mn * 106 / ( b' * de2 ) ]

= [ 0.85*fc'/fy*(1-√( 1 – 2 * Rn/( 0.85*fc' )) ]

= [ 1.4 / fy ]

= [ min (r , r min) ]

= [ r * b' * de]

= [ (1/4) * π * D2 * b' / As ]

= [ 50% * As]

= [ (1/4) * π * D2 * b / As ]

= [  Input  ]

= [ h - dc - 0.5Dv ]

= [ Midas Civil Calculation ]

Vu < 0.5 ϕv Vc

Reinforcement Calculation of Approch Slab

= [ fc'  >  30 MPa ]



1. General Data of Pilecap

Height of Pilecap : h 1500 mm

Longitudinal Width of Pilecap : bx 10000 mm

Transversal Width of Pilecap : by 5000 mm

Concrete Grade : fc' 30 MPa

Yield Strength of  Rainforcement Steel (D ≥ 13) : fy 420 MPa

Yield Strength of  Rainforcement Steel (D < 13) : fy 240 MPa

Concrete Cover : dc 50 mm

2. Lingitudinal Flexure Reinforcement

Diameter of Flexure Rebar : D 25 mm

Flexure Reduction Factor : ϕf 0.9

Ultmate Moment : Mu 332.427 kN.m

Evaluated Over a 1-Meter Distance : b' 1000 mm

Effective Thickness of the Pilecap : de 1437.5 mm

Concrete Stress Distribution Shape Factor : b1       0.85

Reinforcement Ratio in Balance Condition : rb       0.03035714

Maximum Moment Resistance Factor : Rnmax 7.76953125 kN/m2

Nominal Moment (Planned Moment) : Mn 369.363 kN.m

Moment Resistance Factor : Rn 0.179 kN/m2

Rn < Rnmax OK!

Required Reinforcement Ratios : r 0.0004

Minimum Reinforcement Ratio : rmin    0.0012

Reinforcement Ratio Used : r 0.0012

Required Reinforcement Area : As 1711 mm2

Maximum Spacing of Flexure Reinforcement : Smax 287 mm

Spacing of Flexure Reinforcement Used : S =  150 mm

Longitudinal Flexure Reinforcement Used : D25 - 150

3. Transverse Flexure Reinforcement

Diameter of Flexure Rebar : D 19 mm

Required Reinforcement Area : As' 856 mm2

Maximum Spacing of Flexure Reinforcement : S'max 331 mm

Spacing of Flexure Reinforcement Used : S' =  150 mm

Longitudinal Flexure Reinforcement Used : D19 - 150

4. Shear Reinforcement

Diameter of Flexure Rebar : Dv 16 mm

Concrete Density Modification Factors : λ 1

Shear Reduction Factor : ϕv 0.75

Ultimate Shear Force : Vu 110.527 kN

Effective Thickness of the Pilecap : de 1442 mm

Evaluated Over a 1-Meter Distance : b'' = 1000 mm

Concrete Shear Strength : Vc = [ (1/6) √(f'c Mpa) b de ] 13163.5988 kN

Smallest Factored Shear Force : = [ 0.5 ϕv Vc ] 4936.34955 kN

Check Concrete Shear Value :

:

Spasing of Shear Reinforcement Y Direction Used : Sy =  600 mm

Shear Reinforcement Strength : Vs =  [ (Vu / ϕv) - Vc ] -13016.229 kN

Shear Reinforcement Area Required : Av1 -214916.94 mm2

Minimum Shear Reinforcement Area : Av_min = [ (0.083*λ*√(f'c Mpa)*b*b') / fy  ] 10824.041 mm2

Shear Reinforcement Area Used : Av = [  Max ( Av1, Av_min)  ] 10824.041 mm2

Maximum Spacing of Shear Reinforcement : Sx_max = [ (b*b'*(1/4)*π*D2) / (Av*Sy) ] 309.591599 mm

Spasing of Shear Reinforcement X Direction Used : Sx =  300 mm

Shear Reinforcement Used :

= [ min (r , r min) ]

= [ r * b' * de]

= [ (1/4) * π * D2 * b' / As ]

= [ 50% * As]

Vu < 0.5 ϕv Vc

Use Minimum Shear Reinforcement

= [ ( Vs * b ) / (  fy * de )  ]

= [ SNI 2847-2019 ]

D16 - 300/600

= [ Midas Civil Calculation ]

= 

= [ Mn * 106 / ( b' * de2 ) ]

= [ Input ]

Reinforcement Calculation of Pilecap

= [ 0.85*fc'/fy*(1-√[ 1 – 2 * Rn/( 0.85*fc' )) ]

= [ 0.5 / fy ]

= [ Input ]

= [ h - dc -0.5D ]

= [ b1* 0.85 * fc'/ fy * 600 / ( 600 + fy ) ]

= [ fc'  >  30 MPa ]

= [ 0.75*rb*fy*(1–½*0.75*rb*fy/(0.85*fc') ]

= [ Mu / f ]

=   [  Input  ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ Initial Data ]

= [ (1/4) * π * D2 * b / As ]

= [ h - dc - 0.5Dv ]

= [ Input ]

= [ Midas Civil Calculation ]

= [ SNI 2847-2019 ]



1. General Data of Pilecap

Diamater of Pile : D 800 mm

Concrete Grade : fc' 30 MPa

Yield Strength of  Rainforcement Steel (D ≥ 13) : fy 420 MPa

Yield Strength of  Rainforcement Steel (D < 13) : fy 240 MPa

Concrete Cover : dc 75 mm

2. Axial-Flexure Reinforcement

Diameter of Flexure Rebar : Db 25 mm

Ultimate Moment for X Direction : Mux 714.75 kN.m

Ultimate Moment for Y Direction : Muy 857.36 kN.m

Ultimate Axial Force Pu 1233.24

Number of Rebar : n 16

Reinforcement Area : As 7853.982 mm

Cross-Sectional Area : Ag 502654.825

Reinforcement Ratios : r   1.563

Minimum Reinforcement Ratio : rmin    0.500 %

Check Minimum Reinforcement Ratio rmin > r OK

Axial-Flexure  Reinforcement Used : 16D25

3. Shear Reinforcement

Diameter of Shear Rebar : Dv 16 mm

Shear Reduction Factor : ϕv 0.75

Ultimate Shear Force : Vu 574.68 kN

Shear Reduction Factor : ϕv 0.75

Spacing of Shear Reinforcement : b' 100 mm2

Effective Height : de 692

Shear Reinforcement Area : Av 201.062 mm

Concrete Shear Strength : Vc 425137.80 mm

Reinforcement Shear Required : Vs_req = [ (Vu / ϕv) - Vc ] 341102.20

Reinforcement Shear Used : Vs = [ (Av * fy * de) / b' ] 584366.39

Control : Vs > Vs_req OK

Smin

Shear Reinforcement Used

= [ Midas Civil Calculation ]

= [ Input ]

= [ Input ]

= [ Input ]

= [ n * (1/4) * π *Db2 ]

= [ (1/4) * π * D2 ]

= [ As/Ag ]

= 

Reinforcement Calculation of Pile

= [ Initial Data  ]

= [ Initial Data  ]

= [ Initial Data  ]

= [ Initial Data  ]

= [ Midas Civil Calculation ]

= [ Midas Civil Calculation ]

D16 - 100

= [ 2 * (1/4) * π * Dv2 ]

= [ 0.17*(1+Pu/(14*Ag))*(fc')0.5*D*de ]

= [  Input  ]

= [  Input  ]

= [  D - dc - Df - Dv/2  ]

= [ SNI 2847-2019 ]

= [ Calculation Result of Midas CIvil 2022 ]

= [ SNI 2847-2019 ]

Checked with SPColumn



1. PCI-Girder

Flexure Reinforcement of Edge PCI-Girder : 40D13

Flexure Reinforcement of Middle PCI-Girder : 26D13

Specing of Field Reinforcement : D13-200

Specing of Support Reinforcement : D13-100

2. Floor Slab

Longitudinal Flexure Reinforcement : D16 - 100

Transverse Flexure Reinforcement : D13 - 100

3. Diaphragm

Flexure Reinforcement : D13 - 200

Shear Reinforcement : D10 - 200

4. Deck Slab

Longitudinal Flexure Reinforcement : D10 - 200

Transverse Flexure Reinforcement : D10 - 300

1. Breast wall

Axial - Flexure Reinforcement : D25 - 150

Transversal  Reinforcement : D16 - 150

Shear Reinforcement : D16 - 300/600

2. Back wall

Longritudinal Flexure Reinforcement : D19 - 150

Transversal Flexure Reinforcement : D13 - 150

Shear Reinforcement : D13 - 300/400

3. Wing wall

Longitudinal Flexure Reinforcement : D16 - 150

Transversal Flexure Reinforcement : D13 - 150

Shear Reinforcement : D13 - 300/400

4. Approach Slab

Longitudinal Flexure Reinforcement : D16 - 200

Transversal Flexure Reinforcement : D13 - 200

Shear Reinforcement : D13 - 300/400

5. Pilecap

Longitudinal Flexure Reinforcement : D25 - 150

Transversal Flexure Reinforcement : D19 - 150

Shear Reinforcement : D16 - 300/600

6. Pile

Axial - Flexure Reinforcement : 16D25

Shear Reinforcement : D16 - 100

Recapitulation of Bridge Reinforcement 
Recapitulation of Superstructure Bridge Reinforcement 

Recapitulation of Substructure Bridge and Foundation Reinforcement 



3-D View of Bridge Superstructure 



Axial Force Diagram



Shear Force Diagram



Moment Diagram



Bridge Superstructure Deformation



Label of Beam Girder



Mode

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20

MASS(%) SUM(%) MASS(%) SUM(%) MASS(%) SUM(%) MASS(%) SUM(%) MASS(%) SUM(%) MASS(%) SUM(%)
1  81.42  81.42   0.00   0.00   0.05   0.05   0.00   0.00   1.43   1.43   0.00   0.00
2   0.00  81.42  79.14  79.14   0.00   0.05   1.88   1.88   0.00   1.43   0.00   0.00
3   0.00  81.42   0.00  79.14   0.00   0.05   0.00   1.88   0.00   1.43   8.70   8.70
4   0.00  81.42   0.00  79.14   0.00   0.05   0.00   1.88   0.00   1.43   8.70  17.40
5   0.00  81.42   0.00  79.14   0.00   0.05   0.00   1.88   0.00   1.43   8.70  26.10
6   0.00  81.42   0.00  79.14   0.00   0.05   0.00   1.88   0.00   1.43   8.70  34.80
7   0.00  81.42   0.00  79.14   0.00   0.05   0.00   1.88   0.00   1.43   8.70  43.50
8   0.00  81.42   0.00  79.14   0.00   0.05   0.00   1.88   0.00   1.43   8.70  52.20
9   0.00  81.42   0.00  79.14   0.00   0.05   0.00   1.88   0.00   1.43   8.70  60.90

10   0.00  81.42   0.00  79.14   0.00   0.05   0.00   1.88   0.00   1.43   8.70  69.60
11   0.00  81.42   0.00  79.14   0.00   0.05   0.00   1.88   0.00   1.43   8.70  78.30
12   0.00  81.42   0.00  79.14   0.00   0.05   0.00   1.88   0.00   1.43   8.71  87.00
13   0.00  81.42   0.14  79.28   0.00   0.05   0.06   1.95   0.00   1.43   1.31  88.32
14   0.09  81.51   0.00  79.28  99.74  99.79   0.00   1.95   0.00   1.43   0.00  88.32
15   0.00  81.51  11.38  90.66   0.00  99.79   4.39   6.34   0.00   1.43   0.00  88.32
16   9.08  90.58   0.00  90.66   0.10  99.89   0.00   6.34   0.70   2.12   0.00  88.32
17   0.00  90.58   0.00  90.66   0.00  99.89   3.01   9.35   0.00   2.12   0.01  88.33
18   0.07  90.66   0.00  90.66   0.01  99.90   0.00   9.35   0.01   2.13   0.00  88.33
19   0.00  90.66   0.00  90.67   0.00  99.90   0.08   9.43   0.00   2.13   0.01  88.33
20   0.00  90.66   0.00  90.67   0.00  99.90   0.00   9.43   0.19   2.32   0.00  88.33

MASS SUM MASS SUM MASS SUM MASS SUM MASS SUM MASS SUM
1 1208.77 1208.77   0.00   0.00   0.77   0.77   0.00   0.00   0.02   0.02   0.00   0.00
2   0.00 1208.77 1174.92 1174.92   0.00   0.77   0.07   0.07   0.00   0.02   0.00   0.00
3   0.00 1208.77   0.00 1174.92   0.00   0.77   0.00   0.07   0.00   0.02   1.51   1.51
4   0.00 1208.77   0.00 1174.92   0.00   0.77   0.00   0.07   0.00   0.02   1.51   3.01
5   0.00 1208.77   0.00 1174.92   0.00   0.77   0.00   0.07   0.00   0.02   1.51   4.52
6   0.00 1208.77   0.00 1174.92   0.00   0.77   0.00   0.07   0.00   0.02   1.51   6.03
7   0.00 1208.77   0.00 1174.92   0.00   0.77   0.00   0.07   0.00   0.02   1.51   7.54
8   0.00 1208.77   0.00 1174.92   0.00   0.77   0.00   0.07   0.00   0.02   1.51   9.04
9   0.00 1208.77   0.00 1174.92   0.00   0.77   0.00   0.07   0.00   0.02   1.51  10.55

10   0.00 1208.77   0.00 1174.92   0.00   0.77   0.00   0.07   0.00   0.02   1.51  12.06
11   0.00 1208.77   0.00 1174.92   0.00   0.77   0.00   0.07   0.00   0.02   1.51  13.56
12   0.00 1208.77   0.00 1174.92   0.00   0.77   0.00   0.07   0.00   0.02   1.51  15.07
13   0.00 1208.77   2.12 1177.03   0.00   0.77   0.00   0.07   0.00   0.02   0.23  15.30
14   1.34 1210.10   0.00 1177.03 1480.72 1481.49   0.00   0.07   0.00   0.02   0.00  15.30
15   0.00 1210.10 168.97 1346.00   0.00 1481.49   0.16   0.24   0.00   0.02   0.00  15.30
16 134.75 1344.85   0.00 1346.00   1.52 1483.01   0.00   0.24   0.01   0.03   0.00  15.30
17   0.00 1344.85   0.02 1346.02   0.00 1483.01   0.11   0.35   0.00   0.03   0.00  15.30
18   1.07 1345.92   0.00 1346.02   0.16 1483.17   0.00   0.35   0.00   0.03   0.00  15.30
19   0.00 1345.92   0.03 1346.05   0.00 1483.17   0.00   0.35   0.00   0.03   0.00  15.30
20   0.04 1345.96   0.00 1346.05   0.01 1483.17   0.00   0.35   0.00   0.03   0.00  15.30

 Mode
No

 Mode
No

 Mode
No

57.858331
46.854978
32.278175

E I G E N V A L U E     A N A L Y S I S
RZRYRXUZ

10.943496
10.943496
10.250491

6.225725
(rad/sec)

10.943497

UX

Frequency

UY

0.990855
(cycle/sec)

11.022165
11.022165
11.022165
11.022165
10.943497

17.057198
11.022165
11.022165

TRAN-X

TRAN-X

127.330468
126.752197
102.880248

99.749257

MODAL PARTICIPATION MASSES PRINTOUT

1.741712
1.741711
1.741711
1.631416

1.754232
1.754232
1.754232
1.754232
1.754232
1.741712

15.875587
9.208439
7.457201
5.137231
2.714737
1.754232

TRAN-Y

TRAN-Y

20.265273
20.173239

16.3739

(sec)
Period

0.574148
0.574148
0.574148
0.574148
0.612964
1.009229

0.57005
0.57005
0.57005
0.57005
0.57005
0.57005

0.061073
0.06299

0.108596
0.134099
0.194657

0.36836

TRAN-Z

TRAN-Z

0.049345
0.049571

0
0
0
0

Tolerance

0
0
0
0
0
0

0
0
0
0
0
0

ROTN-X

ROTN-X

0
0
0
0

ROTN-Y

ROTN-Y ROTN-Z

ROTN-Z

Eigenvalue Mode



At anch.
Away from 

anch.

G1 - T1 1030.710 1283.274 1057.535 1302 1376.4 1339.2

G1 - T2 1044.095 1286.072 1058.451 1302 1376.4 1339.2

G1 - T3 1062.237 1289.793 1061.038 1302 1376.4 1339.2

G2 - T1 1030.710 1283.274 1056.360 1302 1376.4 1339.2

G2 - T2 1044.095 1286.072 1057.117 1302 1376.4 1339.2

G2 - T3 1062.237 1289.793 1059.660 1302 1376.4 1339.2

G3 - T1 1030.710 1283.274 1056.010 1302 1376.4 1339.2

G3 - T2 1044.095 1286.072 1056.800 1302 1376.4 1339.2

G3 - T3 1062.237 1289.793 1059.234 1302 1376.4 1339.2

G4 - T1 1030.710 1283.274 1056.582 1302 1376.4 1339.2

G4 - T2 1044.095 1286.072 1057.487 1302 1376.4 1339.2

G4 - T3 1062.237 1289.793 1059.874 1302 1376.4 1339.2

G5 - T1 1030.710 1283.274 1057.982 1302 1376.4 1339.2

G5 - T2 1044.095 1286.072 1059.078 1302 1376.4 1339.2

G5 - T3 1062.237 1289.793 1061.564 1302 1376.4 1339.2

Tendon

Tendon Stress Limit Check

At service

Tendon Stress Limit
Immediately after anchor set

f_pe
(N/mm^2)

Tendon Stress

f_p2
(N/mm^2)

f_p1
(N/mm^2)



Elem Part Girder/Slab Comp./Tens.
 LCom

Name
Type CHK

FT
(kN/m^2)

FB
(kN/m^2)

FTL
(kN/m^2)

FBL
(kN/m^2)

FTR
(kN/m^2)

FBR
(kN/m^2)

FMAX
(kN/m^2)

ALW
(kN/m^2)

85 I[5] Girder(Composite) Compression Layan I-1 MZ-MAX OK 738.153 6243.881 636.521 6154.953 839.786 6332.809 6332.809 30000.000

85 I[5] Girder(Composite) Tension Layan III-1 MZ-MAX OK 739.143 6240.510 682.329 6190.798 795.958 6290.223 682.329 -3527.753

85 J[28] Girder(Composite) Compression Layan I-3 FZ-MAX OK 1628.110 4805.015 1652.042 4825.956 1604.177 4784.074 4825.956 30000.000

85 J[28] Girder(Composite) Tension Layan III-2 FZ-MAX OK 1619.213 4818.311 1621.332 4820.165 1617.094 4816.457 1617.094 -3527.753

86 I[28] Girder(Composite) Compression Layan I-4 MY-MIN OK 2398.675 7013.288 2422.923 7034.504 2374.408 6992.053 7034.504 30000.000

86 I[28] Girder(Composite) Tension Layan III-1 MY-MIN OK 2386.912 7026.721 2387.287 7027.048 2386.537 7026.393 2386.537 -3527.753

86 J[39] Girder(Composite) Compression Layan I-3 MY-MIN OK 3186.830 5547.174 3216.205 5572.875 3157.432 5521.450 5572.875 30000.000

86 J[39] Girder(Composite) Tension Layan III-2 MY-MIN OK 4321.570 3107.715 4323.662 3109.546 4319.476 3105.883 3105.883 -3527.753

87 I[39] Girder(Composite) Compression Layan I-4 MY-MIN OK 3195.932 5539.244 3215.982 5556.787 3175.866 5521.685 5556.787 30000.000

87 I[39] Girder(Composite) Tension Layan III-2 MY-MIN OK 4318.735 3107.080 4319.534 3107.779 4317.936 3106.380 3106.380 -3527.753

87 J[50] Girder(Composite) Compression Layan I-1 MY-MAX OK 5744.144 338.452 5771.402 362.301 5716.865 314.581 5771.402 30000.000

87 J[50] Girder(Composite) Tension Layan III-1 MY-MAX OK 5344.059 1182.027 5345.981 1183.708 5342.136 1180.344 1180.344 -3527.753

88 I[50] Girder(Composite) Compression Layan I-2 MY-MAX OK 5724.396 345.249 5741.131 359.892 5707.647 330.593 5741.131 30000.000

88 I[50] Girder(Composite) Tension Layan III-1 MY-MAX OK 5326.896 1186.873 5327.905 1187.756 5325.885 1185.989 1185.989 -3527.753

88 J[61] Girder(Composite) Compression Layan I-1 MY-MAX OK 6578.653 -1196.924 6603.332 -1175.331 6553.955 -1218.536 6603.332 30000.000

88 J[61] Girder(Composite) Tension Layan III-1 MY-MAX OK 6120.506 -233.941 6122.692 -232.028 6118.318 -235.855 -235.855 -3527.753

89 I[61] Girder(Composite) Compression Layan I-2 MY-MAX OK 6573.816 -1194.922 6588.826 -1181.788 6558.794 -1208.067 6588.826 30000.000

89 I[61] Girder(Composite) Tension Layan III-1 MY-MAX OK 6115.010 -233.025 6116.428 -231.784 6113.591 -234.267 -234.267 -3527.753

89 J[72] Girder(Composite) Compression Layan I-1 MY-MAX OK 7475.909 -2819.347 7497.689 -2800.291 7454.112 -2838.421 7497.689 30000.000

89 J[72] Girder(Composite) Tension Layan III-1 MY-MAX OK 6917.347 -1655.691 6918.563 -1654.627 6916.130 -1656.756 -1656.756 -3527.753

90 I[72] Girder(Composite) Compression Layan I-2 MY-MAX OK 7486.401 -2820.673 7497.688 -2810.797 7475.105 -2830.557 7497.688 30000.000

90 I[72] Girder(Composite) Tension Layan III-1 MY-MAX OK 6924.319 -1656.684 6925.885 -1655.314 6922.752 -1658.056 -1658.056 -3527.753

90 J[83] Girder(Composite) Compression Layan I-1 MY-MAX OK 8147.868 -3934.698 8167.668 -3917.374 8128.053 -3952.037 8167.668 30000.000

90 J[83] Girder(Composite) Tension Layan III-1 MY-MAX OK 7517.540 -2634.513 7519.285 -2632.986 7515.794 -2636.041 -2636.041 -3527.753

91 I[83] Girder(Composite) Compression Layan I-2 MY-MAX OK 8145.300 -3930.883 8153.367 -3923.824 8137.226 -3937.948 8153.367 30000.000

91 I[83] Girder(Composite) Tension Layan III-1 MY-MAX OK 7514.357 -2631.110 7516.175 -2629.520 7512.538 -2632.702 -2632.702 -3527.753

91 J[94] Girder(Composite) Compression Layan I-1 MY-MAX OK 8570.223 -4548.980 8588.099 -4533.340 8552.334 -4564.634 8588.099 30000.000

91 J[94] Girder(Composite) Tension Layan III-1 MY-MAX OK 7903.687 -3180.090 7906.370 -3177.742 7901.001 -3182.440 -3182.440 -3527.753

92 I[94] Girder(Composite) Compression Layan I-2 MY-MAX OK 8555.935 -4540.742 8561.657 -4535.735 8550.209 -4545.753 8561.657 30000.000

92 I[94] Girder(Composite) Tension Layan III-1 MY-MAX OK 7891.806 -3173.035 7894.538 -3170.645 7889.072 -3175.428 -3175.428 -3527.753

92 J[105] Girder(Composite) Compression Layan I-1 MY-MAX OK 8762.432 -4707.072 8779.479 -4692.156 8745.372 -4722.000 8779.479 30000.000

92 J[105] Girder(Composite) Tension Layan III-1 MY-MAX OK 8093.717 -3332.864 8098.574 -3328.614 8088.856 -3337.117 -3337.117 -3527.753

93 I[105] Girder(Composite) Compression Layan I-2 MY-MAX OK 8759.367 -4701.689 8765.795 -4696.065 8752.934 -4707.318 8765.795 30000.000

93 I[105] Girder(Composite) Tension Layan III-1 MY-MAX OK 8090.104 -3327.555 8096.452 -3322.001 8083.751 -3333.114 -3333.114 -3527.753

93 J[116] Girder(Composite) Compression Layan I-1 MY-MAX OK 9021.919 -4979.750 9032.965 -4970.085 9010.864 -4989.424 9032.965 30000.000

93 J[116] Girder(Composite) Tension Layan III-1 MY-MAX OK 8306.085 -3512.034 8307.771 -3510.559 8304.398 -3513.510 -3513.510 -3527.753

94 I[116] Girder(Composite) Compression Layan I-1 MY-MAX OK 9030.689 -4977.259 9039.131 -4969.873 9022.240 -4984.652 9039.131 30000.000

94 I[116] Girder(Composite) Tension Layan III-1 MY-MAX OK 8311.553 -3508.492 8316.743 -3503.952 8306.360 -3513.036 -3513.036 -3527.753

94 J[127] Girder(Composite) Compression Layan I-1 MY-MAX OK 9101.195 -4862.526 9110.063 -4854.767 9092.320 -4870.292 9110.063 30000.000

94 J[127] Girder(Composite) Tension Layan III-1 MY-MAX OK 8366.106 -3361.806 8368.555 -3359.662 8363.654 -3363.951 -3363.951 -3527.753

95 I[127] Girder(Composite) Compression Layan I-1 MY-MAX OK 9100.761 -4856.680 9111.844 -4846.983 9089.669 -4866.386 9111.844 30000.000

95 I[127] Girder(Composite) Tension Layan III-1 MY-MAX OK 8365.671 -3355.959 8370.336 -3351.878 8361.003 -3360.045 -3360.045 -3527.753

95 J[138] Girder(Composite) Compression Layan I-1 MY-MAX OK 8984.846 -4365.614 8992.160 -4359.214 8977.526 -4372.019 8992.160 30000.000

95 J[138] Girder(Composite) Tension Layan III-1 MY-MAX OK 8265.710 -2896.846 8269.771 -2893.293 8261.645 -2900.403 -2900.403 -3527.753

96 I[138] Girder(Composite) Compression Layan I-1 MY-MAX OK 8975.320 -4357.607 8989.306 -4345.369 8961.322 -4369.855 8989.306 30000.000

96 I[138] Girder(Composite) Tension Layan III-1 MY-MAX OK 8259.486 -2889.890 8264.112 -2885.843 8254.857 -2893.942 -2893.942 -3527.753

96 J[149] Girder(Composite) Compression Layan I-2 MY-MAX OK 8677.111 -3501.926 8683.719 -3496.144 8670.498 -3507.713 8683.719 30000.000

96 J[149] Girder(Composite) Tension Layan III-1 MY-MAX OK 8007.848 -2127.792 8014.376 -2122.080 8001.314 -2133.510 -2133.510 -3527.753

97 I[149] Girder(Composite) Compression Layan I-1 MY-MAX OK 8679.580 -3498.133 8699.590 -3480.626 8659.556 -3515.655 8699.590 30000.000

97 I[149] Girder(Composite) Tension Layan III-1 MY-MAX OK 8010.866 -2123.925 8018.685 -2117.083 8003.040 -2130.772 -2130.772 -3527.753

97 J[160] Girder(Composite) Compression Layan I-2 MY-MAX OK 8454.738 -2797.282 8461.335 -2791.511 8448.137 -2803.058 8461.335 30000.000

97 J[160] Girder(Composite) Tension Layan III-1 MY-MAX OK 7790.609 -1429.575 7794.215 -1426.420 7787.000 -1432.733 -1432.733 -3527.753

98 I[160] Girder(Composite) Compression Layan I-1 MY-MAX OK 8468.606 -2797.707 8489.677 -2779.271 8447.519 -2816.159 8489.677 30000.000

98 I[160] Girder(Composite) Tension Layan III-1 MY-MAX OK 7802.069 -1428.817 7807.948 -1423.674 7796.186 -1433.965 -1433.965 -3527.753

98 J[171] Girder(Composite) Compression Layan I-2 MY-MAX OK 8048.716 -1700.303 8058.871 -1691.418 8038.553 -1709.196 8058.871 30000.000

98 J[171] Girder(Composite) Tension Layan III-1 MY-MAX OK 7417.773 -400.531 7421.678 -397.114 7413.865 -403.951 -403.951 -3527.753

99 I[171] Girder(Composite) Compression Layan I-1 MY-MAX OK 8051.029 -1697.662 8074.768 -1676.891 8027.270 -1718.452 8074.768 30000.000

99 I[171] Girder(Composite) Tension Layan III-1 MY-MAX OK 7420.701 -397.477 7426.385 -392.504 7415.012 -402.456 -402.456 -3527.753

99 J[182] Girder(Composite) Compression Layan I-2 MY-MAX OK 7432.338 -490.238 7446.086 -478.209 7418.579 -502.277 7446.086 30000.000

99 J[182] Girder(Composite) Tension Layan III-1 MY-MAX OK 6870.256 673.751 6874.283 677.274 6866.227 670.225 670.225 -3527.753

100 I[182] Girder(Composite) Compression Layan I-1 MY-MAX OK 7421.739 -483.775 7445.397 -463.075 7398.062 -504.494 7445.397 30000.000

100 I[182] Girder(Composite) Tension Layan III-1 MY-MAX OK 6863.176 679.881 6866.271 682.589 6860.079 677.172 677.172 -3527.753

100 J[193] Girder(Composite) Compression Layan I-2 MY-MAX OK 6577.504 984.316 6596.152 1000.632 6558.841 967.985 6596.152 30000.000

100 J[193] Girder(Composite) Tension Layan III-1 MY-MAX OK 6118.698 1946.213 6123.754 1950.636 6113.638 1941.785 1941.785 -3527.753

101 I[193] Girder(Composite) Compression Layan I-1 MY-MAX OK 6582.431 986.175 6608.493 1008.979 6556.349 963.352 6608.493 30000.000

101 I[193] Girder(Composite) Tension Layan III-1 MY-MAX OK 6124.284 1949.159 6127.853 1952.281 6120.712 1946.033 1946.033 -3527.753

101 J[204] Girder(Composite) Compression Layan I-4 MY-MIN OK 3948.245 6302.538 3968.766 6320.494 3927.708 6284.567 6320.494 30000.000

101 J[204] Girder(Composite) Tension Layan III-1 MY-MAX OK 5392.729 3198.583 5397.473 3202.733 5387.982 3194.428 3194.428 -3527.753

102 I[204] Girder(Composite) Compression Layan I-3 MY-MIN OK 3954.447 6305.570 3982.320 6329.957 3926.553 6281.161 6329.957 30000.000

102 I[204] Girder(Composite) Tension Layan III-1 MY-MAX OK 5410.139 3196.404 5412.646 3198.598 5407.629 3194.208 3194.208 -3527.753

102 J[215] Girder(Composite) Compression Layan I-4 MY-MIN OK 3325.857 7372.296 3348.983 7392.530 3302.714 7352.044 7392.530 30000.000

102 J[215] Girder(Composite) Tension Layan III-2 MY-MIN OK 3305.761 7406.339 3309.665 7409.755 3301.855 7402.920 3301.855 -3527.753

103 I[215] Girder(Composite) Compression Layan I-3 MY-MIN OK 3316.991 7381.864 3346.061 7407.299 3287.898 7356.406 7407.299 30000.000

103 I[215] Girder(Composite) Tension Layan III-2 MY-MIN OK 3297.663 7415.996 3299.487 7417.591 3295.839 7414.400 3295.839 -3527.753

103 J[226] Girder(Composite) Compression Layan I-4 MY-MIN OK 2592.308 8661.406 2618.798 8684.584 2565.797 8638.207 8684.584 30000.000

103 J[226] Girder(Composite) Tension Layan III-1 MY-MIN OK 2580.545 8674.839 2583.162 8677.128 2577.926 8672.547 2577.926 -3527.753

Stress Check at service load



Elem Part Girder/Slab Comp./Tens.
 LCom

Name
Type CHK

FT
(kN/m^2)

FB
(kN/m^2)

FTL
(kN/m^2)

FBL
(kN/m^2)

FTR
(kN/m^2)

FBR
(kN/m^2)

FMAX
(kN/m^2)

ALW
(kN/m^2)

Stress Check at service load

104 I[226] Girder(Composite) Compression Layan I-3 FZ-MIN OK 1699.137 5993.123 1722.308 6013.398 1675.966 5972.849 6013.398 30000.000

104 I[226] Girder(Composite) Tension Layan III-2 FZ-MIN OK 1690.240 6006.420 1691.597 6007.607 1688.883 6005.232 1688.883 -3527.753

104 J[6] Girder(Composite) Compression Layan I-1 MZ-MAX OK 870.142 7287.427 769.895 7199.711 970.388 7375.142 7375.142 30000.000

104 J[6] Girder(Composite) Tension Layan III-1 MZ-MAX OK 871.132 7284.056 815.703 7235.556 926.560 7332.556 815.703 -3527.753



Elem Part
Positive/
Negative

LComName Type CHK
Muy

(kN*m)
Mcr

(kN*m)
Mny

(kN*m)
PhiMny
(kN*m)

Ratio
(Muy/PhiMny)

PhiMny/
min(1.33Muy,Mcr)

85 I[5] Negative Kuat I-1 MY-MIN OK -2673.138 5112.823 5897.118 5897.118 0.453 1.659

85 I[5] Positive Ekstrem I-3 FZ-MAX OK 0.000 9159.613 14550.826 14550.826 0.000 larger than 100

85 J[28] Negative Ekstrem II-2 FZ-MAX OK -1011.609 4539.804 4944.879 4800.824 0.211 3.568

85 J[28] Positive Kuat I-1 MY-MAX OK 1021.336 9815.010 15584.886 15584.886 0.066 11.473

86 I[28] Negative Ekstrem II-2 MY-MIN OK -1433.339 4880.191 4944.615 4804.965 0.298 2.521

86 I[28] Positive Kuat I-1 MY-MAX OK 578.917 9835.464 15584.886 15584.886 0.037 20.241

86 J[39] Negative Ekstrem II-2 MY-MIN OK -49.810 4321.713 4028.469 3629.375 0.014 54.785

86 J[39] Positive Kuat I-1 MY-MAX OK 3493.904 10513.326 16599.731 16599.731 0.211 3.572

87 I[39] Negative Ekstrem II-2 MY-MIN OK -43.538 4321.680 4028.469 3629.375 0.012 62.678

87 I[39] Positive Kuat I-1 MY-MAX OK 3487.779 10513.856 16599.731 16599.731 0.210 3.579

87 J[50] Negative Ekstrem II-2 MY-MIN OK 0.000 3770.084 3174.770 2639.420 0.000 larger than 100

87 J[50] Positive Kuat I-1 MY-MAX OK 5778.350 11183.247 17573.917 17573.917 0.329 2.287

88 I[50] Negative Ekstrem II-2 MY-MIN OK 0.000 3770.026 3174.770 2639.420 0.000 larger than 100

88 I[50] Positive Kuat I-1 MY-MAX OK 5770.376 11183.885 17573.917 17573.917 0.328 2.290

88 J[61] Negative Ekstrem II-2 MY-MIN OK 0.000 3236.774 2403.851 1842.161 0.000 larger than 100

88 J[61] Positive Kuat I-1 MY-MAX OK 7510.958 11834.544 18486.309 18486.309 0.406 1.851

89 I[61] Negative Ekstrem II-2 MY-MIN OK 0.000 3236.635 2403.851 1842.161 0.000 larger than 100

89 I[61] Positive Kuat I-1 MY-MAX OK 7512.302 11835.429 18486.309 18486.309 0.406 1.850

89 J[72] Negative Ekstrem II-2 MY-MIN OK 0.000 2736.995 1739.625 1304.719 0.000 larger than 100

89 J[72] Positive Kuat I-1 MY-MAX OK 9390.817 12444.953 19316.338 19316.338 0.486 1.552

90 I[72] Negative Ekstrem II-2 MY-MIN OK 0.000 2736.812 1739.625 1304.719 0.000 larger than 100

90 I[72] Positive Kuat I-1 MY-MAX OK 9400.702 12445.862 19316.338 19316.338 0.487 1.552

90 J[83] Negative Ekstrem II-2 MY-MIN OK 0.000 2284.731 1198.631 898.973 0.000 larger than 100

90 J[83] Positive Kuat I-1 MY-MAX OK 10773.464 13003.270 20041.960 20041.960 0.538 1.541

91 I[83] Negative Ekstrem II-2 MY-MIN OK 0.000 2284.466 1198.631 898.973 0.000 larger than 100

91 I[83] Positive Kuat I-1 MY-MAX OK 10774.220 13004.359 20041.960 20041.960 0.538 1.541

91 J[94] Negative Ekstrem II-2 MY-MIN OK 0.000 1895.786 793.487 595.115 0.000 larger than 100

91 J[94] Positive Kuat I-1 MY-MAX OK 11636.337 13492.734 20643.196 20643.196 0.564 1.530

92 I[94] Negative Ekstrem II-2 MY-MIN OK 0.000 1895.417 793.487 595.115 0.000 larger than 100

92 I[94] Positive Kuat I-1 MY-MAX OK 11628.005 13494.067 20643.196 20643.196 0.563 1.530

92 J[105] Negative Ekstrem II-2 MY-MIN OK 0.000 1586.495 522.572 391.929 0.000 larger than 100

92 J[105] Positive Kuat I-1 MY-MAX OK 12006.556 13896.580 21098.303 21098.303 0.569 1.518

93 I[105] Negative Ekstrem II-2 MY-MIN OK 0.000 1586.050 522.572 391.929 0.000 larger than 100

93 I[105] Positive Kuat I-1 MY-MAX OK 12005.155 13898.072 21098.303 21098.303 0.569 1.518

93 J[116] Negative Ekstrem II-2 MY-MIN OK 0.000 1378.299 375.482 281.612 0.000 larger than 100

93 J[116] Positive Kuat I-1 MY-MAX OK 12551.652 14183.066 21386.597 21386.597 0.587 1.508

94 I[116] Negative Ekstrem II-2 MY-MIN OK 0.000 1377.792 375.482 281.612 0.000 larger than 100

94 I[116] Positive Kuat I-1 MY-MAX OK 12557.429 14184.696 21386.597 21386.597 0.587 1.508

94 J[127] Negative Ekstrem II-2 MY-MIN OK 0.000 1282.862 329.469 247.102 0.000 larger than 100

94 J[127] Positive Kuat I-1 MY-MAX OK 12648.849 14351.701 21487.424 21487.424 0.589 1.497

95 I[127] Negative Ekstrem II-2 MY-MIN OK 0.000 1282.238 329.469 247.102 0.000 larger than 100

95 I[127] Positive Kuat I-1 MY-MAX OK 12646.241 14353.670 21487.424 21487.424 0.589 1.497

95 J[138] Negative Ekstrem II-2 MY-MIN OK 0.000 1312.239 375.482 281.612 0.000 larger than 100

95 J[138] Positive Kuat I-1 MY-MAX OK 12283.418 14390.459 21386.597 21386.597 0.574 1.486

96 I[138] Negative Ekstrem II-2 MY-MIN OK 0.000 1311.643 375.482 281.612 0.000 larger than 100

96 I[138] Positive Kuat I-1 MY-MAX OK 12272.972 14392.362 21386.597 21386.597 0.574 1.486

96 J[149] Negative Ekstrem II-2 MY-MIN OK 0.000 1461.718 522.572 391.929 0.000 larger than 100

96 J[149] Positive Kuat I-1 MY-MAX OK 11471.777 14302.681 21098.303 21098.303 0.544 1.475

97 I[149] Negative Ekstrem II-2 MY-MIN OK 0.000 1461.239 522.572 391.929 0.000 larger than 100

97 I[149] Positive Kuat I-1 MY-MAX OK 11469.130 14304.282 21098.303 21098.303 0.544 1.475

97 J[160] Negative Ekstrem II-2 MY-MIN OK 0.000 1724.795 793.487 595.115 0.000 larger than 100

97 J[160] Positive Kuat I-1 MY-MAX OK 10862.546 14085.048 20643.196 20643.196 0.526 1.466

98 I[160] Negative Ekstrem II-2 MY-MIN OK 0.000 1724.432 793.487 595.115 0.000 larger than 100

98 I[160] Positive Kuat I-1 MY-MAX OK 10867.475 14086.359 20643.196 20643.196 0.526 1.466

98 J[171] Negative Ekstrem II-2 MY-MIN OK 0.000 2084.631 1198.631 898.973 0.000 larger than 100

98 J[171] Positive Kuat I-1 MY-MAX OK 9811.691 13765.251 20041.960 20041.960 0.490 1.536

Flexure Strength Check 



Elem Part
Positive/
Negative

LComName Type CHK
Muy

(kN*m)
Mcr

(kN*m)
Mny

(kN*m)
PhiMny
(kN*m)

Ratio
(Muy/PhiMny)

PhiMny/
min(1.33Muy,Mcr)

Flexure Strength Check 

99 I[171] Negative Ekstrem II-2 MY-MIN OK 0.000 2084.360 1198.631 898.973 0.000 larger than 100

99 I[171] Positive Kuat I-1 MY-MAX OK 9808.164 13766.351 20041.960 20041.960 0.489 1.536

99 J[182] Negative Ekstrem II-2 MY-MIN OK 0.000 2552.981 1739.625 1304.719 0.000 larger than 100

99 J[182] Positive Kuat I-1 MY-MAX OK 8418.243 13255.181 19316.338 19316.338 0.436 1.725

100 I[182] Negative Ekstrem II-2 MY-MIN OK 0.000 2552.804 1739.625 1304.719 0.000 larger than 100

100 I[182] Positive Kuat I-1 MY-MAX OK 8406.195 13256.038 19316.338 19316.338 0.435 1.728

100 J[193] Negative Ekstrem II-2 MY-MIN OK 0.000 3094.401 2403.851 1842.161 0.000 larger than 100

100 J[193] Positive Kuat I-1 MY-MAX OK 6619.706 12611.844 18486.309 18486.309 0.358 2.100

101 I[193] Negative Ekstrem II-2 MY-MIN OK 0.000 3094.333 2403.851 1842.161 0.000 larger than 100

101 I[193] Positive Kuat I-1 MY-MAX OK 6616.831 12612.334 18486.309 18486.309 0.358 2.101

101 J[204] Negative Ekstrem II-2 MY-MIN OK 0.000 3675.303 3174.770 2639.420 0.000 larger than 100

101 J[204] Positive Kuat I-1 MY-MAX OK 4975.900 11919.675 17573.917 17573.917 0.283 2.656

102 I[204] Negative Ekstrem II-2 MY-MIN OK 0.000 3675.279 3174.770 2639.420 0.000 larger than 100

102 I[204] Positive Kuat I-1 MY-MAX OK 4982.923 11920.022 17573.917 17573.917 0.284 2.652

102 J[215] Negative Ekstrem II-2 MY-MIN OK -735.367 4279.148 4028.469 3629.375 0.203 3.711

102 J[215] Positive Kuat I-1 MY-MAX OK 2795.950 11202.723 16599.731 16599.731 0.168 4.464

103 I[215] Negative Ekstrem II-2 MY-MIN OK -742.216 4279.182 4028.469 3629.375 0.205 3.677

103 I[215] Positive Kuat I-1 MY-MAX OK 2801.498 11202.833 16599.731 16599.731 0.169 4.455

103 J[226] Negative Ekstrem II-2 MY-MIN OK -2021.048 4892.798 4944.615 4804.965 0.421 1.788

103 J[226] Positive Kuat I-1 MY-MAX OK 0.000 10477.063 15584.886 15584.886 0.000 larger than 100

104 I[226] Negative Ekstrem II-2 FZ-MIN OK -1525.317 4500.478 4944.879 4800.824 0.318 2.367

104 I[226] Positive Kuat I-1 MY-MAX OK 507.626 10375.249 15584.886 15584.886 0.033 23.084

104 J[6] Negative Kuat I-1 MY-MIN OK -3094.337 5129.744 5897.118 5897.118 0.525 1.433

104 J[6] Positive Ekstrem I-3 FZ-MIN OK 0.000 9664.788 14550.826 14550.826 0.000 larger than 100



Elem Part Max/Min
 LCom

Name
Type CHK

Vu
(kN)

Mu
(kN*m)

Vn
(kN)

Phi
Vc

(kN)
Vs

(kN)
Vp

(kN)
PhiVn
(kN)

85 I[5] Max Ekstrem I-3 FZ-MAX OK -793.709 -1542.627 3805.506 0.900 2859.068 6517.427 254.286 8668.495

85 I[5] Min Kuat I-1 MY-MIN OK -1834.219 -2673.138 3805.506 0.900 2859.068 6517.427 254.286 8668.495

85 J[28] Max Ekstrem I-3 FZ-MAX OK -684.569 -105.531 3806.385 0.900 2859.068 6517.427 255.166 8668.495

85 J[28] Min Kuat I-1 MY-MAX OK -1810.102 1021.336 9631.661 0.900 2859.068 6517.427 255.166 8668.495

86 I[28] Max Ekstrem I-3 FZ-MAX OK -659.764 -162.455 1224.142 0.900 1186.513 1629.357 250.565 2756.576

86 I[28] Min Kuat I-1 FZ-MIN NG -1376.531 -314.385 1224.142 0.900 1186.513 1629.357 250.565 2756.576

86 J[39] Max Ekstrem I-3 FZ-MAX OK -584.741 1026.457 3062.863 0.900 1186.513 1629.357 246.993 2756.576

86 J[39] Min Kuat I-1 MY-MAX OK -1534.674 3493.904 3062.863 0.900 1186.513 1629.357 246.993 2756.576

87 I[39] Max Ekstrem I-3 FZ-MAX OK -551.190 1504.263 3062.882 0.900 1186.513 1629.357 247.012 2756.593

87 I[39] Min Kuat I-1 FZ-MIN OK -1199.027 1853.515 3062.882 0.900 1186.513 1629.357 247.012 2756.593

87 J[50] Max Ekstrem I-3 FZ-MAX OK -481.363 2470.775 3138.817 0.900 1222.288 1678.484 238.046 2824.936

87 J[50] Min Kuat I-1 MY-MAX OK -1277.173 5778.350 3138.817 0.900 1222.288 1678.484 238.046 2824.936

88 I[50] Max Ekstrem I-3 FZ-MAX OK -362.300 3284.623 3138.841 0.900 1222.288 1678.484 238.069 2824.957

88 I[50] Min Kuat I-1 FZ-MIN OK -1061.820 4282.227 3138.841 0.900 1222.288 1678.484 238.069 2824.957

88 J[61] Max Ekstrem I-3 FZ-MAX OK -297.950 3867.971 3269.275 0.900 1283.417 1762.428 223.431 2942.348

88 J[61] Min Kuat I-1 MY-MAX OK -1034.762 7510.958 3269.275 0.900 1283.417 1762.428 223.431 2942.348

89 I[61] Max Ekstrem I-3 FZ-MAX OK -321.202 3624.560 3269.303 0.900 1283.417 1762.428 223.459 2942.373

89 I[61] Min Kuat I-2 FZ-MIN OK -1043.595 5089.175 3269.303 0.900 1283.417 1762.428 223.459 2942.373

89 J[72] Max Ekstrem I-3 FZ-MAX OK -262.633 4120.435 3380.370 0.900 1338.981 1838.730 202.658 3042.333

89 J[72] Min Kuat I-1 MY-MAX OK -1091.622 9390.817 3380.370 0.900 1338.981 1838.730 202.658 3042.333

90 I[72] Max Ekstrem I-3 FZ-MAX OK -184.713 6272.660 3380.395 0.900 1338.981 1838.730 202.683 3042.355

90 I[72] Min Kuat I-2 FZ-MIN OK -869.162 6473.982 3380.395 0.900 1338.981 1838.730 202.683 3042.355

90 J[83] Max Ekstrem I-3 FZ-MAX OK -132.252 6490.599 3468.892 0.900 1387.699 1905.632 175.561 3122.003

90 J[83] Min Kuat I-1 MY-MAX OK -858.965 10773.464 3468.892 0.900 1387.699 1905.632 175.561 3122.003

91 I[83] Max Ekstrem I-3 FZ-MAX OK -34.351 7455.532 3468.916 0.900 1387.699 1905.632 175.586 3122.025

91 I[83] Min Kuat I-2 FZ-MIN OK -715.901 7419.673 3468.916 0.900 1387.699 1905.632 175.586 3122.025

91 J[94] Max Ekstrem I-3 FZ-MAX OK 11.654 7368.497 3247.058 0.900 1427.994 1960.965 141.901 2922.352

91 J[94] Min Kuat I-2 FZ-MIN OK -669.897 8695.740 3530.861 0.900 1427.994 1960.965 141.901 3177.775

92 I[94] Max Ekstrem I-3 FZ-MAX OK 127.028 8256.471 3247.036 0.900 1427.994 1960.965 141.924 2922.332

92 I[94] Min Kuat I-2 FZ-MIN OK -579.882 8007.990 3530.883 0.900 1427.994 1960.965 141.924 3177.795

92 J[105] Max Ekstrem I-3 FZ-MAX OK 166.204 7843.474 3359.999 0.900 1458.560 2002.939 101.500 3023.999

92 J[105] Min Kuat I-2 FZ-MIN OK -540.706 9008.812 3562.999 0.900 1458.560 2002.939 101.500 3206.699

93 I[105] Max Kuat I-2 FZ-MAX OK 137.721 8632.853 3359.982 0.900 1458.560 2002.939 101.517 3023.984

93 I[105] Min Kuat I-2 FZ-MIN OK -565.760 8372.902 3563.016 0.900 1458.560 2002.939 101.517 3206.714

93 J[116] Max Kuat I-2 FZ-MAX OK 169.675 8196.697 3453.353 0.900 1477.946 2029.561 54.154 3108.018

93 J[116] Min Kuat I-2 FZ-MIN OK -533.806 9343.707 3561.661 0.900 1477.946 2029.561 54.154 3205.495

94 I[116] Max Kuat I-2 FZ-MAX OK 259.075 9040.582 3453.343 0.900 1477.946 2029.561 54.164 3108.009

94 I[116] Min Kuat I-2 FZ-MIN OK -414.340 8601.744 3561.671 0.900 1477.946 2029.561 54.164 3205.504

94 J[127] Max Kuat I-2 FZ-MAX OK 283.406 8361.791 3523.553 0.900 1484.707 2038.846 0.000 3171.198

94 J[127] Min Kuat I-2 FZ-MIN OK -390.009 9269.783 3523.553 0.900 1484.707 2038.846 0.000 3171.198

95 I[127] Max Kuat I-2 FZ-MAX OK 384.799 9162.719 3523.553 0.900 1484.707 2038.846 0.000 3171.198

95 I[127] Min Kuat I-2 FZ-MIN OK -287.463 8442.611 3523.553 0.900 1484.707 2038.846 0.000 3171.198

95 J[138] Max Kuat I-2 FZ-MAX OK 407.018 8233.266 3452.293 0.900 1477.946 2029.561 -55.214 3107.064

95 J[138] Min Kuat I-2 FZ-MIN OK -265.244 8857.682 3562.721 0.900 1477.946 2029.561 -55.214 3206.449

96 I[138] Max Kuat I-2 FZ-MAX OK 524.844 8951.184 3452.282 0.900 1477.946 2029.561 -55.225 3107.054

96 I[138] Min Kuat I-2 FZ-MIN OK -174.772 7985.367 3562.732 0.900 1477.946 2029.561 -55.225 3206.459

96 J[149] Max Kuat I-2 FZ-MAX OK 550.993 7738.863 3356.007 0.900 1458.560 2002.939 -105.492 3020.406

96 J[149] Min Kuat I-2 FZ-MIN OK -148.624 8172.280 3566.991 0.900 1458.560 2002.939 -105.492 3210.292

97 I[149] Max Kuat I-2 FZ-MAX OK 525.326 8354.174 3355.988 0.900 1458.560 2002.939 -105.511 3020.389

97 I[149] Min Kuat I-2 FZ-MIN OK -177.161 7353.688 3567.009 0.900 1458.560 2002.939 -105.511 3210.309

97 J[160] Max Kuat I-2 FZ-MAX OK 555.772 7139.527 3238.597 0.900 1427.994 1960.965 -150.362 2914.738

97 J[160] Min Kuat I-2 FZ-MIN OK -146.714 7544.015 3539.321 0.900 1427.994 1960.965 -150.362 3185.389

98 I[160] Max Kuat I-2 FZ-MAX OK 644.500 7808.988 3238.575 0.900 1427.994 1960.965 -150.384 2914.718

98 I[160] Min Kuat I-2 FZ-MIN OK -29.932 6625.112 3539.343 0.900 1427.994 1960.965 -150.384 3185.409

98 J[171] Max Kuat I-2 FZ-MAX OK 679.594 6355.847 3103.627 0.900 1387.699 1905.632 -189.704 2793.264

Shear Strength Check 
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Shear Strength Check 

98 J[171] Min Ekstrem II-2 FZ-MIN OK 5.162 6520.835 3103.627 0.900 1387.699 1905.632 -189.704 2793.264

99 I[171] Max Kuat I-1 MY-MAX OK 830.846 9808.164 3103.603 0.900 1387.699 1905.632 -189.728 2793.243

99 I[171] Min Ekstrem II-2 FZ-MIN OK 104.133 5525.299 3103.603 0.900 1387.699 1905.632 -189.728 2793.243

99 J[182] Max Kuat I-2 FZ-MAX OK 823.678 5397.144 2956.439 0.900 1338.981 1838.730 -221.273 2660.795

99 J[182] Min Ekstrem II-2 FZ-MIN OK 148.713 5290.201 2956.439 0.900 1338.981 1838.730 -221.273 2660.795

100 I[182] Max Kuat I-1 MY-MAX OK 1055.502 8406.195 2956.416 0.900 1338.981 1838.730 -221.296 2660.774

100 I[182] Min Ekstrem II-2 FZ-MIN OK 233.452 4316.569 2956.416 0.900 1338.981 1838.730 -221.296 2660.774

100 J[193] Max Kuat I-2 FZ-MAX OK 992.833 4114.015 2801.266 0.900 1283.417 1762.428 -244.579 2521.139

100 J[193] Min Ekstrem II-2 FZ-MIN OK 288.458 3898.868 2801.266 0.900 1283.417 1762.428 -244.579 2521.139

101 I[193] Max Kuat I-1 MY-MAX OK 994.624 6616.831 2801.249 0.900 1283.417 1762.428 -244.596 2521.124

101 I[193] Min Ekstrem II-2 FZ-MIN OK 257.812 2973.844 2801.249 0.900 1283.417 1762.428 -244.596 2521.124

101 J[204] Max Kuat I-1 FZ-MAX OK 1019.300 3487.751 2639.570 0.900 1222.288 1678.484 -261.202 2375.613

101 J[204] Min Ekstrem II-2 FZ-MIN OK 319.780 2490.147 2639.570 0.900 1222.288 1678.484 -261.202 2375.613

102 I[204] Max Kuat I-1 MY-MAX OK 1234.549 4982.923 2639.556 0.900 1222.288 1678.484 -261.216 2375.601

102 I[204] Min Ekstrem II-2 FZ-MIN OK 438.739 1675.347 2639.556 0.900 1222.288 1678.484 -261.216 2375.601

102 J[215] Max Kuat I-1 FZ-MAX OK 1142.720 1113.141 2544.243 0.900 1186.513 1629.357 -271.627 2289.818

102 J[215] Min Ekstrem II-2 FZ-MIN OK 507.326 812.434 2544.243 0.900 1186.513 1629.357 -271.627 2289.818

103 I[215] Max Kuat I-1 MY-MAX OK 1490.720 2801.498 2544.234 0.900 1186.513 1629.357 -271.636 2289.810

103 I[215] Min Ekstrem II-2 FZ-MIN OK 592.609 112.771 2544.234 0.900 1186.513 1629.357 -271.636 2289.810

103 J[226] Max Kuat I-1 FZ-MAX NG 1319.051 -927.733 697.324 0.900 1186.513 1629.357 -276.253 2289.810

103 J[226] Min Ekstrem II-2 FZ-MIN OK 667.479 -1075.055 697.324 0.900 1186.513 1629.357 -276.253 2289.810

104 I[226] Max Kuat I-1 MY-MAX OK 1770.314 507.626 9095.716 0.900 2859.068 6517.427 -280.779 8186.144

104 I[226] Min Ekstrem II-2 FZ-MIN OK 718.099 -1525.317 3270.441 0.900 2859.068 6517.427 -280.779 8186.144

104 J[6] Max Kuat I-1 MY-MIN OK 1795.292 -3094.337 3271.033 0.900 2859.068 6517.427 -280.187 8186.144

104 J[6] Min Ekstrem II-2 FZ-MIN OK 828.101 -3016.513 3271.033 0.900 2859.068 6517.427 -280.187 8186.144



Design Condition

■ Section Properties

- Gross section - Transformed section

■ Materials
- Concrete

* β1 : 0.85 if f'c is lower than 4ksi, the others are 0.85-0.05(f'c-4.0)≥0.65

- Prestressing steel information

* dp : Distance from extreme compression fiber to centroid of prestressing tendon.

- Longitudinal non prestressed steel reinforcement information

* ds || d's : Distance from extreme compression fiber to centroid of non prestressing reinforcement.

- Transverse non prestressed steel reinforcement information

* α : Angle between longitudinal and stirrup.

Design Code Element Section Section

AASHTO-LRFD2017 95 I Composite

Before After Before After

H (mm) 2100.00 2350.00 H (mm) 2100.00 2350.00

B (mm) 800.00 2000.00 B (mm) 800.00 2000.00
Czp (mm) 1065.84 664.73 Czp (mm) 1094.93 692.92
Czm (mm) 1034.16 1435.27 Czm (mm) 1005.07 1407.08
Czps (mm) 914.73 Czps (mm) 942.92
Czms (mm) 664.73 Czms (mm) 692.92
Ag (mm²) 8.353.E+05 1.260.E+06 Ag (mm²) 8.632.E+05 1.287.E+06
Iy (mm⁴) 4.397.E+11 8.409.E+11 Iy (mm⁴) 4.617.E+11 8.872.E+11
St (mm³) 4.125.E+08 6.615.E+08 St (mm³) 4.216.E+08 6.663.E+08
Sb (mm³) 4.252.E+08 3.064.E+08 Sb (mm³) 4.593.E+08 3.281.E+08
Sts (mm³) 9.193.E+08 Sts (mm³) 8.918.E+08
Sbs (mm³) 1.265.E+09 Sbs (mm³) 1.214.E+09

f'c Ec fr=0.20√f'c
β1 

(MPa) (MPa) (MPa)

Girder 50.000 4786.2 4.456 0.687

Slab 30.000 4061.1 3.452 0.832

No. Tendon Bond Type
dp Aps Strength (MPa) Ep

(mm) (mm²) fpy fpu (MPa)

1674.000 1860.000 196500.644

1 S_G3 - T1 Bond 2150.000 1875.490 1674.000

2250.000 1875.490 1674.000

1860.000 196500.644

2 S_G3 - T2 Bond 2250.000 1875.490

1860.000 196500.644

Girder Slab Bottom for Flexure Top for Flexure Torsion

3 S_G3 - T3 Bond

Es fy Es fy ds As ds As Al

(MPa) (MPa) (MPa) (MPa) (mm) (mm²) (mm) (mm²) (mm²)

199948.0 413.69 199948.0 413.69 0.00 0.00 0.00 0.00 0.00

Es fy α
(deg.)

Shear Torsion

Av s At st

(MPa) (MPa) (mm²) (mm) (mm²) (mm)

199948.0 413.686 90.000 258.064 200.000 0.000 0.000



■ Sectional forces/stresses due to effective prestress

* ep : Distance from centroid of section to centroid of tendon

2.Flexure design for a section
■ Moment Direction Positive
- Method of Calculation :

- The maximum strength limit load combination :

- The maximum factored moment

 1) Depth of neutral axis to compression face (c). (See 5.6.3.1)

= f'cAc

* fps = fpu(1-k c/dp) k = 2(1.04-fpy /fpu)

No. Tendon Name Bond Type
ep Apsfe(z-dir) Apsfe(x-dir) Apsfe(x-dir)ep

(mm) (kN) (kN) (kN·m)

2309.271

2514.872

1 S_G3 - T1 Bond -1207.078 0.000 1913.108

S_G3 - T3 Bond -1307.078 0.000 1934.843

Bond -1307.078 0.000 1924.041

Axial force in concrete (compressive zone):

Cc(c-ac)

2528.991

2 S_G3 - T2

Σ 0.000 5771.992 7353.134

3

10157.080 1418.603

ac Cc 0.85

Code

Kuat I-1

(Mu) : 12646.240 (kN·m)

c a=β1c Ac

Axial force in reinforcement steels

tensile zone compressive zone

239.246 199.158 398316.880 99.579

Ts=Asfs ΣAsfs(ds-c) Cs=A'sf's ΣA'sf's(c-d's)

0.000 0.000 0.000 0.000

No.
Axial force in tendons(Bond) by Code

Tendon Name k fps Tps=Apsfps Apsfps(dp-c)

1 S_G3 - T1 0.280 1802.047 3379.721 6457.817

2 S_G3 - T2 0.280 1804.623 3384.552 6805.502

3 S_G3 - T3 0.280 1804.623 3384.552 6805.502

Σ 10148.824 20068.821

c (mm)
Compression Force (kN) Tensile Force (kN) Tolerance

Cc Cs Ts Tps (C/T)

239.246 10157.080 0.000 0.000 10148.824 1.00081



 2) Flexural resistance

▪ Nominal resistance (Mn). (See 5.6.3.2)

Mn = ΣAsfs(ds-c)+ΣApsfps(dp-c)+Cc(c-ac)+ΣA'sf's(c-d's) =

▪ Resistance factor (Φ).

dt = (mm)

εt = 0.003(dt/c-1) = : Net tensile strain in the extreme tension steel

∴ Φ = : Tension Controlled Range, 0.005 ≤εt

▪ Factored resistance (Mr = ΦMn)

Mr = ≥ Mu =

 3) Minimum reinforcement

▪ IDS_CVL_RPT_US_133MU : 미등록 문자열 (See 5.6.3.3)

Mr = ≥ 1.33Mu =

▪ Cracking moment (Mcr) (Eq. 5.7.3.3.2-1)

Mcr = =

Where, = : Non-Composite dead load moment

= : Composite Section Modulus for extreme fiber

= : Non-Composite Section Modulus for extreme fiber

= : Flexural cracking variability factor

= : Prestress variability factor

= :

fcpe = Compressive stress in concrete due to effective prestress only

= ΣAps·fe(x-dir) / Ag + ΣAps·fe(x-dir)·ep / Sb =

▪ Checking minimum reinforcement

Mr = ≥ Mcr =

3.Shear design for a section
■ Maximum Shear

- Section type : Segmental-Solid

- The Strength Limit Load Combination : Kuat I-2

- Factored shear force : Vu = (including Vp)
- Factored moment : Mu =

- Factored axial force : Nu =

- Resistance factor for shear : Φ =

-

Vp = ΣAps·fe(z-dir) = (kN)

21487.42 (kN·m)

2250.000

0.0252

1.00

21487.424 (kN·m) 12646.24 (kN·m) OK

21487.424 (kN·m) 16819.50 (kN·m)

  γ3 [ (γ1·fr + γ2·fcpe)Sc - Mdnc(Sc/Snc-1) ] 11918.13 (kN·m)

Mdnc 6.444.E+03 (kN·m)

Sc 5.859.E+08 (mm³)

Snc 4.252.E+08 (mm³)

γ1 1.200

γ2 1.100

γ3 1.000 Ratio of yield strength to ultimate tensile strength of the 
reinforcement

17.41 (kN)

21487.42 (kN·m) 11918.13 (kN·m) OK

384.80 (kN)

9162.72 (kN·m)

-5790.57 (kN)

0.90

Component of prestressing force in 
direction of the shear force 0.00



 1) Effective depth

bv = (mm) Effective web width

= , , ]

=

 2) Maximum Spacing for transverse reinforcement (smax)

▪ Shear stress on concrete (vu).

(Eq. 5.7.2.8-1)

▪ Maximum Spacing for transverse reinforcement (smax)

vu   = < 0.125·f'c =

∴ = Min[0.8dv, 24.0(in.)] = (Eq. 5.7.2.6-1)

∴ = ≤

 3) Minimum required transverse reinforcement (Av,min)

▪ Need Not Check

 4) Longitudinal Strain (εs)

∴ εs =

where, = Max [ Mu ,  |Vu-Vp|dv  ] = , ]

=

= =

249.00

de =
Apsfpsdp+Asfsds

= 2216.698 (mm) Effective depth for bending
Apsfps+Asfs

dv = Max [
Mn

, 0.9de , 0.72h ] Effective depth for shear
Apsfps+Asfs

Max [ 2117.233 1995.029 1692.000

2117.233 (mm)

vu =
| Vu  - ΦVp |

= 0.811 (MPa)
Φbvdv

0.811 (MPa) 6.250 (MPa)

smax 609.600 (mm)

s 200.000 (mm) smax OK

εs =
(|Mu|/dv + 0.5Nu + |Vu-Vp|-Apsfpo)

= -0.0050 ,  0.0 ≤ εs ≤ 0.006 (Eq. 5.7.3.4.2-4)
EsAs+EpAps

0.0000

|Mu| Max [ 9162.719 814.709

9162.719 (kN·m)

fpo 0.7fpu 1302.000 (MPa)



 5) Component of shear resisted by tensile stresses in concrete (Vc)

▪ Factor indicating diagonally cracked concrete to transmit tension (β).

(Eq. 5.7.3.4.2-1)

▪ Nominal shear resistance provide by concrete

Vc = β √f'c bvdv = (Eq. 5.7.3.3-3)

 6) Component of shear resisted by transverse reinforcement (Vs)

▪ Area of transverse reinforcement required (See 5.8.2.4)

 Vu < 0.5Φ(Vc+Vp) ∴ No Shear reinforcing

▪ Component of shear resisted by transverse reinforcement (Vs)

(Eq. 5.7.3.3-4)

Where, θ = = (Eq. 5.7.3.4.2-3)

α = (deg.)

 7) Shear resistance

▪ Nominal shear strength (Eq. 5.7.3.3-1)

= ≤

∴ Vn = =

▪ Factored shear resistance (Vr).

∴ Vr = = ≥ Vu =

■ Minimum Shear
- Section type : Segmental-Solid

- The Strength Limit Load Combination : Kuat I-2

- Factored shear force : Vu = (including Vp)
- Factored moment : Mu =

- Factored axial force : Nu =

- Resistance factor for shear : Φ =

-

Vp = ΣAps·fe(z-dir) = (kN)

 1) Effective depth

β =
4.8

= 4.800 ∵ Av ≥ Av,min
(1+750εs)

0.0316 1484.707 (kN)

0.5Φ(Vc+Vp) Φ(Vc+Vp) Vu

668.12 (kN) 1336.24 (kN) 384.80 (kN)

Vs =
Av·fy·dv(cotθ+cotα)sinα

= 2038.846 (kN)
s

29+3500εs 29.000 (deg.)

90.000

Vc +Vs +Vp 3523.553 (kN) 0.25·f'cbvdv + Vp = 6589.887 (kN)

Vc+Vs+Vp 3523.553 (kN)

ΦVn 3171.198 (kN) 384.799 (kN) OK

-287.46 (kN)

8442.61 (kN·m)

-5788.88 (kN)

0.90

Component of prestressing force in 
direction of the shear force 0.00



bv = (mm) Effective web width

= , , ]

=

 2) Maximum Spacing for transverse reinforcement (smax)

▪ Shear stress on concrete (vu).

(Eq. 5.7.2.8-1)

▪ Maximum Spacing for transverse reinforcement (smax)

vu   = < 0.125·f'c =

∴ = Min[0.8dv, 24.0(in.)] = (Eq. 5.7.2.6-1)

∴ = ≤

 3) Minimum required transverse reinforcement (Av,min)

▪ Need Not Check

 4) Longitudinal Strain (εs)

∴ εs =

where, = Max [ Mu ,  |Vu-Vp|dv  ] = , ]

=

= =

 5) Component of shear resisted by tensile stresses in concrete (Vc)

▪ Factor indicating diagonally cracked concrete to transmit tension (β).

(Eq. 5.7.3.4.2-1)

▪ Nominal shear resistance provide by concrete

Vc = β √f'c bvdv = (Eq. 5.7.3.3-3)

249.00

de =
Apsfpsdp+Asfsds

= 2216.698 (mm) Effective depth for bending
Apsfps+Asfs

dv = Max [
Mn

, 0.9de , 0.72h ] Effective depth for shear
Apsfps+Asfs

Max [ 2117.233 1995.029 1692.000

2117.233 (mm)

vu =
| Vu  - ΦVp |

= 0.606 (MPa)
Φbvdv

0.606 (MPa) 6.250 (MPa)

smax 609.600 (mm)

s 200.000 (mm) smax OK

εs =
(|Mu|/dv + 0.5Nu + |Vu-Vp|-Apsfpo)

= -0.0054 ,  0.0 ≤ εs ≤ 0.006 (Eq. 5.7.3.4.2-4)
EsAs+EpAps

0.0000

|Mu| Max [ 8442.611 608.627

8442.611 (kN·m)

fpo 0.7fpu 1302.000 (MPa)

β =
4.8

= 4.800 ∵ Av ≥ Av,min
(1+750εs)

0.0316 1484.707 (kN)



 6) Component of shear resisted by transverse reinforcement (Vs)

▪ Area of transverse reinforcement required (See 5.8.2.4)

 Vu < 0.5Φ(Vc+Vp) ∴ No Shear reinforcing

▪ Component of shear resisted by transverse reinforcement (Vs)

(Eq. 5.7.3.3-4)

Where, θ = = (Eq. 5.7.3.4.2-3)

α = (deg.)

 7) Shear resistance

▪ Nominal shear strength (Eq. 5.7.3.3-1)

= ≤

∴ Vn = =

▪ Factored shear resistance (Vr).

∴ Vr = = ≥ Vu =

0.5Φ(Vc+Vp) Φ(Vc+Vp) Vu

668.12 (kN) 1336.24 (kN) 287.46 (kN)

Vs =
Av·fy·dv(cotθ+cotα)sinα

= 2038.846 (kN)
s

(kN)

29+3500εs 29.000 (deg.)

90.000

Vc +Vs +Vp 3523.553 (kN) 0.25·f'cbvdv + Vp =

OK

6589.887 (kN)

Vc+Vs+Vp 3523.553 (kN)

ΦVn 3171.198 (kN) -287.463



3D-View of Bridge Substructure and Foundation 



Bridge Substructure and Foundation Deformation



Mode

1
2
3
4
5
6
7
8
9

10
11
12

MASS(%) SUM(%) MASS(%) SUM(%) MASS(%) SUM(%) MASS(%) SUM(%) MASS(%) SUM(%) MASS(%) SUM(%)
1   0.00   0.00  99.98  99.98   0.00   0.00   0.01   0.01   0.00   0.00   0.00   0.00
2 100.00 100.00   0.00  99.98   0.00   0.00   0.00   0.01   0.00   0.00   0.00   0.00
3   0.00 100.00   0.00  99.98   0.00   0.00   0.00   0.01   0.00   0.00  99.99  99.99
4   0.00 100.00   0.00  99.98  77.60  77.60   0.00   0.01   0.00   0.00   0.00  99.99
5   0.00 100.00   0.01  99.99   0.00  77.60  77.76  77.77   0.00   0.00   0.00  99.99
6   0.00 100.00   0.00  99.99   0.00  77.60   0.00  77.77  55.69  55.69   0.00  99.99
7   0.00 100.00   0.00  99.99   0.00  77.60   0.00  77.77   0.00  55.69   0.00 100.00
8   0.00 100.00   0.01 100.00   0.00  77.60   0.06  77.83   0.00  55.69   0.00 100.00
9   0.00 100.00   0.00 100.00   0.00  77.60   0.00  77.83   0.00  55.69   0.00 100.00

10   0.00 100.00   0.00 100.00  10.09  87.69   0.00  77.83   0.00  55.69   0.00 100.00
11   0.00 100.00   0.00 100.00   0.00  87.69  10.16  87.99   0.00  55.69   0.00 100.00
12   0.00 100.00   0.00 100.00   0.00  87.69   0.00  87.99   0.00  55.69   0.00 100.00

MASS SUM MASS SUM MASS SUM MASS SUM MASS SUM MASS SUM
1 0 0 731.91 731.91 0 0 0.48 0.48 0 0 0 0
2 732.08 732.08 0 731.91 0 0 0 0.48 0.81 0.81 0 0
3 0 732.08 0 731.91 0 0 0 0.48 0 0.81 111633.32 111633.32
4 0 732.08 0 731.91 568.06 568.06 0 0.48 0 0.81 0 111633.32
5 0 732.08 0.07 731.98 0 568.06 4491.71 4492.19 0 0.81 0 111633.32
6 0.01 732.08 0 731.98 0 568.06 0 4492.19 58949.99 58950.8 0 111633.32
7 0 732.08 0 731.98 0 568.06 0 4492.19 0.01 58950.81 1.87 111635.19
8 0 732.08 0.1 732.08 0 568.06 3.71 4495.9 0 58950.81 0 111635.19
9 0 732.08 0 732.08 0 568.06 0 4495.9 0 58950.81 3.15 111638.34

10 0 732.08 0 732.08 73.88 641.94 0 4495.9 0 58950.81 0 111638.34
11 0 732.08 0 732.08 0 641.94 586.7 5082.6 0 58950.81 0 111638.34
12 0 732.08 0 732.08 0 641.94 0 5082.6 0 58950.81 0 111638.34

 Mode
No

 Mode
No

 Mode
No

Eigenvalue Mode

66.01087
21.48306
17.40531
11.78808
7.24231
7.15268

166.04755
142.29818
137.94103
131.72099
80.71461
70.48417

TRAN-X

TRAN-X

Frequency

UY

(rad/sec)

UX

3.41914
2.77014
1.87613
1.15265
1.13838

(cycle/sec)

22.64746
21.95400
20.96405
12.84613
11.21790
10.50596

TRAN-Y

TRAN-Y

26.42729

(sec)
Period

UZ

0.09518
0.29247
0.36099
0.53301
0.86757
0.87844

0.03784
0.04416
0.04555
0.04770
0.07784
0.08914

TRAN-Z

TRAN-Z

0.000E+00
0.000E+00

Tolerance

RX

0.000E+00
0.000E+00
0.000E+00
0.000E+00
0.000E+00
0.000E+00

ROTN-X

ROTN-X

ROTN-Y

ROTN-Y

RY

MODAL PARTICIPATION MASSES PRINTOUT

E I G E N V A L U E     A N A L Y S I S

2.430E-50
8.658E-60
2.072E-61
1.626E-65

RZ

ROTN-Z

ROTN-Z



Fxx
(kN/m)

Fyy
(kN/m)

Fxy
(kN/m)

Mxx
(kN*m/m)

Myy
(kN*m/m)

Mxy
(kN*m/m)

Vxx
(kN/m)

Vyy
(kN/m)

MAX 428.043 580.777 816.057 192.998 699.099 148.108 316.681 261.468
MIN -325.934 -1595.589 -253.993 -332.053 -191.004 -74.736 -307.689 -108.269

MAX 589.822 194.898 137.829 64.752 360.989 55.647 63.321 241.336
MIN -453.462 -258.169 -89.232 -82.288 -174.796 -55.647 3.157 -241.336

MAX 258.827 546.766 416.995 70.98 132.427 94.541 82.301 61.36
MIN -260.178 -992.014 -378.991 -123.109 -69.643 -94.541 -72.723 -110.527

MAX 68.784 248.69 60.632 26.461 60.807 49.305 82.301 61.36
MIN -46.254 -214.945 -49.788 -70.227 -79.311 -49.305 -72.723 -110.527

MAX 248.285 389.812 353.046 70.98 332.427 94.541 82.301 61.36
MIN -471.7 -307.822 -148.539 -133.109 -69.643 -94.541 -72.723 -110.527

Axial
(kN)

Shear-x
(kN)

Shear-y
(kN)

Torsion
(kN*m)

Moment-x
(kN*m)

Moment-y
(kN*m)

MAX 1233.24 574.68 198.79 0 714.75 857.36
MIN -1886.38 -15.32 -113.94 0 -364.46 -63.22

INTERNAL FORCE OF PILE FOUNDATION

Pile 

INTERNAL FORCE PER UNIT LENGTH OF SUBSTRUCTURE 

Breast wall

Back Wall

Wing Wall

Approch Slab

Pile Cap
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